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 INTRODUCTION 
 
 Congratulations on acquiring UltiMusE (tm), the advanced music 
editor and MIDI player for Coco-III OS-9L2 or MM/1 OSK. It lets 
you spread up to 16 musical voices over as many as eight staves, 
viewed in Hi-Res 640 x 192 graphics. Standard musical notations 
for repeats, multiple endings, and DaCapos make entering sheet 
music easy. Initial timing grids of rests help you place notes in 
time. "Overstrike" note editing automatically re-notates time 
fragments of notes. All voices can be instantly edited with the 
mouse at any time. Seven different styles of Clef allow Pitches to 
range from 4 octaves below Middle C to over 3 above. A Percussion 
Clef easily handles all synths. Search commands can find anything 
in your score. Staves, clefs, and parts can be added and re-
assigned any time. 
 
 
 SHAREWARE and COPYRIGHT NOTICE 
 
 UltiMusE-III (Coco3/OS-9L2) and UltiMusE-K (MM/1) are now 
Shareware! Please feel free to give copies to others, upload to 
bulletin boards and Web sites, and include in collections of free 
software. 
  
 However, both versions of UltiMusE and this manual are Copyright 
(c) 1989, 1997 by Michael J. Knudsen, and in giving you permission 
to copy and pass around the software and files, I ask you to 
follow these rules: 
  
 (1) When giving out or uploading copies, be sure to include the 
ENTIRE package -- the program itself, the manual files, and the 
.IMG files. The Coco program comprises NINE files -- Umuse3, Fran, 
and seven files named "Um3" plus one letter. If you let someone 
get an incomplete package, they will be frustrated and give Umuse 
a bad reputation. If you got Umuse as a complete .AR or .LHA 
archive, pass that on as-is. 
  
 (2) Earlier, buy-ware versions must not be given away or 
uploaded. They have no up-to-date Manual files and no shareware 
money-begging startup screen (see No. (4)). 



  
 (3) Be very careful not to mix up files from different versions 
of Umuse, especially the Coco set. Save yourself and others some 
amazing crashes. 
  
 (4) If you really use Umuse, and haven't purchased it in the 
past, I'd appreciate a donation in the mail -- how about $25 for 
the Coco and $30 for the MM/1 version. In return for this 
"registration fee" I will send you one really major upgrade on 
disk when it comes ripe. It should be newer and better than 
anything floating around the Internet or bull boards. Send 
donation to 
 
Mike Knudsen 
1411 E. Wakeman Ave 
Wheaton, IL 60187. 
You can contact the author by EMail at: 
mknudsen@lucent.com 
or via the Coco mailing list at coco@pucc.princeton.edu. 
(all above addresses now invalid) 
 
 DISCLAIMER 
 
 Neither the author nor the vendor can be held responsible for any 
damages, direct or consequential, arising through use or misuse of 
this program or its documentation, including lost sleep, divorce, 
missed deadlines or blown gigs. The user is cautioned that MIDI 
music hacking can be even more addictive than either computers or 
music alone. 
  
 This program and documentation are believed to be reasonably free 
of bugs, errors, and omissions. Questions and bug reports, 
complaints, and praise should be electronic-mailed to: 
  
 Michael J. Knudsen 
 mknudsen@lucent.com 
(all above addresses now invalid) 
 
 
 SYSTEM REQUIREMENTS 
  
 To run UltiMusE-III you need a 512K (or more) Color Computer III 
and OS9 Level Two. A monochrome composite monitor is fine, though 
an 80-column RGB lets you customize your color scheme. Next best 
is a black & white TV set. If you must use a composite color 
monitor or color TV, use "MONTYPE M" (monochrome) mode. 
  



 Umuse3 now works fine with unpatched ShellPlus. For 6309 users, 
NitrOS9 really speeds up the menus, but the Nitro vendor should 
tell you the latest one-byte patch for our Um3P module to make it 
work with the serial port. 
  
 You need a mouse or joystick; they are the same to the CoCo but 
the mouse is much easier to use. You don't need the second button. 
The little Hi-Res Mouse Adaptor is highly recommended. 
  
 You can write and edit music with the above, but to hear them 
played you need a MIDI-equipped synthesizer and a way to connect 
the CoCo to it. This manual tells how to make a simple cable to 
feed CoCo's serial printer port to the synth. You may get better 
playing from a true hardware MIDI interface Pak in your Multi-Pak 
Interface, hooked to your synth with a standard MIDI cable. This 
Pak may be had from the Glenside Color Computer Club or bought 
used. Non-standard home-hacked units can be used if you have a 
matching OS9 device driver and descriptor. 
  
 Your synth must have a MIDI-In jack, but needn't have keys. Home 
keyboards with MIDI sell for under $300, and "tone modules" 
without keyboards for under $200. Try to get one with "General 
MIDI" instrumentation. 
  
 A 9-pin Tandy, Epson or IBM compatible dot matrix printer will 
dump graphics screens to hard copy and print whole scores. 
 
 
 INSTALLATION 
  NEW USER? SINGLE DRIVE? IN A HURRY? -- READ THIS FIRST! 
 
 If you're in a hurry to try UltiMusE-III or don't know much about 
OS9, just boot up OS-9. Type LOAD PWD. 
  
 Now FORMAT a scratch disk and BACKUP our UltiMusE-III disk to it. 
Plug mouse or joystick directly into the Left rear socket, or via 
the Hi-Res adapter into the Right one. Remove the OS-9 boot disk 
from Drive 0 and insert the UltiMusE-III backup copy. Now type: 
 
 chx /d0/cmds 
 chd /d0/scores 
 umuse3 
 
 and follow the prompts. See the "Troubleshooting" section if 
errors happen. You may pull out the Umuse3 disk and insert another 
for score files if you LOAD every module in our CMDS dir, but be 
sure to use the Files Menu to CHD to /D0 after each disk change. 



  
 
 INSTALLATION 
 
 Installation is very simple, just copying some files and making 
sure your boot configuration has what's needed. You don't need to 
modify or add anything to your Boot file. But your boot must 
include GrfInt or WindInt, /W, and other window descriptors 
supplied on your Level 2 disk (and included in the original Tandy 
OS9Boot). Umuse3 no longer needs the old 32x16 VDG screen, but can 
still be started up from one. 
  
 Your boot must also include a /DD descriptor for one of your 
disks. The original Tandy bootfile satisfies all our requirements. 
  
 
 DISK CONTENTS: ( MAKE A BACKUP COPY FIRST! ) 
 
 Your Umuse3 disk is organized into CMDS, SYS, and SCORES 
directories. CMDS holds these executable binary programs: 
 Umuse3 Fran PlayMI plus seven Um3X, where X = one letter. 
  
 Except for PlayMI, these must all be in your "Current Execution 
Directory" when running Umuse3. Never execute directly any of 
these except Umuse3!  
  
 SYS carries two files -- "chars.img" of character fonts, and 
"AllUm3.img" of cursors, notes, and other graphic symbols. These 
must be accessible under /DD/SYS whenever you start up Umuse3. 
  
 SCORES holds sample pieces of music plus some instrument patch 
files. Put these wherever you like, and CHD to wherever before 
running Umuse3. 
  
 
 TWO WAYS TO INSTALL AND USE ULTIMUSE-III 
 
 Depending on your Coco-III disk system, one of these two ways 
will be better for you. 
  
 (1) Add Umuse3 files to your existing file systems. If you have 
lots of room on your /DD drive and in your CMDS directory, just 
copy all of Umuse3's CMDS files into your CMDS directory, and 
everything in SYS to your /DD/SYS. You'll want to make one or more 
directories for our SCORES files plus the scores you'll create or 
get from other users, maybe on a separate drive. 
  



 (2) But if your CMDS or /DD space is tight, make a separate CMDS 
and SYS disk for UltiMusE work. Start by backing up your original 
Umuse3 disk. Then add to the backup's CMDS any other commands 
you'll be using. You must have DIR, TMODE, and PWD. You don't need 
any commands already booted into memory along with the Shell; do 
an MDIR to see what those are. 
  
 Keep the SYS/*.img files on this disk, or put them on another 
one, depending on whether you want the CMDS to be in your /DD 
drive. A disk with the SYS must be in /DD when you start up 
Umuse3, though you may pull it out once Umuse3 is running. 
"/DD/SYS/*.img" is the only hard-coded path in Umuse3. 
  
 
 IF YOU HAVE TWO SINGLE-SIDED FLOPPIES ONLY 
 
 You'll need to keep your score files on separate disks from the 
UltiMusE programs and images, which take up most of a 35 track SS 
diskette. Make a Commands Disk with our CMDS files plus the PWD 
command. Also copy our SYS directory to it. Format another Data 
disk; in fact, make several. Put the Commands disk in Drive 1, 
Data disk in Drive 0, and type 
 
 chx /d1/cmds 
 chd /d0 
 
 and go to work. Note that whenever you change diskettes in the 
Data drive you must use the File Menu's 'H' command to change 
directories to the new disk, even if its directory has the same 
name as the previous diskette. 
 
 
 RUNNING UltiMusE 
  
 You can start Umuse3 from any size or type of window, including 
the 32x16 VDG screen -- Umuse3 creates its own window. Make sure 
you're in lower-case mode. If not, type TMODE -UPC and hit CTRL-0. 
Umuse3 can't understand upper-case letters for most commands. 
  
 It's easier if before starting Umuse3 you CHD to where your 
scores are kept. Make sure your current exec directory includes 
the supplied program modules, and just type: 
 
 umuse3 
 or 
 umuse3& 
 



 where the & lets you keep using the original launch window after 
Umuse3 goes to its own. Don't add "#32K" -- Umuse3 already grabs 
all needed memory.  
  
 Or pick and choose from the full-blown command line: 
 umuse3 -OPTIONS infile outfile 
  
 where the option flags include (note the "poor man's" defaults): 
 -h Using the High-Res mouse adaptor 
 -l Low-Res, not using the adaptor (default) 
 -p Enable MIDI plug-in pack instead of Coco rear serial port 
 -r File will be edited in Read-Only mode (writes must be 
confirmed) 
  
 Infile and Outfile are also optional, but if only one name is 
given it's taken as Infile. Giving at least Infile skips some 
startup prompts and takes you straight to the score display of the 
Infile music file. 
 
 If Outfile is given, Umuse3's remembered "filename" is set to 
Outfile instead of Infile, so the first Save command you give will 
write to Outfile instead of Infile. This helps prevent you from 
mucking up the original of a score when you really wanted to edit 
a new copy of it.  
  
 Use -r when just looking or playing scores. This read_only mode 
doesn't prevent you from writing, but makes sure you want to (see 
"Files Menu"). 
  
 Anything these options can do, you can do later inside Umuse3 -- 
they just save prompts, time and mistakes. Umuse3 also reads a 
special "init" file to set your favorite modes.  
 
  
WHAT HAPPENS 
 
 Suppose you typed just "umuse3" to start the program. After 
plenty of disk thrashing the title and copyright screen appear; 
then a few seconds later a yes/no dialogue window asks whether 
you're using the Hi-Res mouse adaptor (unless you gave the -l or -
h command line flag). Just type 'y' or 'n'. 
  
 Since you have nothing in memory yet, your Startup Menu options 
are limited to reading in an existing .UME music score file, 
reading a .INS instruments patch file, changing directories, or 
creating a new score from scratch. 
  



 Reading scores and instruments is straightforward and covered 
under "Files Menu." Practice at first by reading in one of the 
supplied score files; this will take you straight to the Score 
Screen, where you can play the music and practice editing with the 
mouse. 
  
 To create your own scores, read the chapters on "Parts and 
Staves," "Setup Prompts," and "Setup and Layout Screens." 
  
 Once you reach the Score Screen, you have the upper Menu Bar at 
your service. You may pull down the Options Menu to change the 
screen colors, set or change other modes -- and most important, 
save to a file these colors and the Joystick and MIDI port modes 
you gave on startup. 
  
 NOTE (CoCo only): As you try different menus and functions, 
Umuse3 will load one of its Um3x program routines from disk before 
proceeding. But once loaded, that function stays in memory (until 
you quit Umuse3) and you won't suffer that delay from the same 
function again. 
  
 
 SCREEN COLORS 
 
 You can change the Fore- and BackGround colors to anything the 
Coco-3 can generate. From the Options Menu, punch 's' and follow 
the prompts.  
  
 Inside the CoCo-III, each palette assigns each of the three 
primary colors an internal value of 0 thru 3. In the Options Menu, 
these values are given by typing the letters "RGBrgb." A small 
letter is worth 1 point and a capital letter counts 2 points 
towards that color's palette value. 'b' means dark Navy blue, 'B' 
medium blue, and "Bb" or "bB" bright blue. Same for the other 
primary colors R and G. Or click the mouse over the menu "buttons" 
to flip the color letters. Be careful not to give the same value 
for both fore and background! The colors don't "stick" unless you 
punch or type "OK, Keep" before exiting the menu with an ENTER or 
click outside the menu. You may save your favorite color scheme in 
the Init file. 
 
  
PREFERENCES INIT FILE 
 
 Umuse3 starts up in your personal preferred modes as given in the 
file /DD/SYS/UM3.Init. This controls the screen colors, Hi-Res 
mouse adaptor, serial port and MIDI Pak enables, File Read_Only 



mode, cursor snap, and some other modes. If this file exists, 
Umuse3 will skip the previous section's questions (whew!). 
  
 Your disk has no UM3.Init file supplied. To make one your way, 
start up Umuse3 as usual, answering the Hi-Res prompt to match 
your system. Use the MIDI Menu to enable your choice of MIDI 
ports, use the Options Menu to play with the screen colors, and 
Files Menu to set or clear Read_Only safety mode. Once you like 
the setup, type 'f' to the Options Menu to store away your 
preferences; Umuse3 will create the UM3.Init file. A disk with a 
SYS directory must be in /DD whenever you save or restore from 
UM3.Init. 
  
 You can change the settings any time, and rewrite the file as 
above, or type 'r' to restore your favorites from the file.  
 
 
 DEFINITIONS and GENERAL RULES 
  
 SOME MUSICAL TERMS 
 A "part" (or "voice") is one series in time of musical notes and 
rests. A part can sound only one note at a time. Keyboard players 
aren't restricted by this notion so it may take some getting used 
to. Think in terms of one-note instruments -- saxes, trumpets, 
bass, lead vocal, soprano, or early monophonic synthesizers; there 
is a sax part, 1st and 2nd trumpet parts, etc. You need to think 
in band or choir terms to use poly-timbral synths like the MT32 or 
FB01. And to write music in UltiMusE. 
  
 A "staff" is a group of five lines with four spaces in between 
them. These "slots" of lines and spaces represent musical pitches, 
or white keys on a keyboard, in order. A "clef" is a large sign at 
the beginning of a staff that tells what white key corresponds to 
the staff's bottom line, and thus defines the rest of the lines' 
and spaces' pitches.  
  
 A "note" is an image on a staff that represents a musical pitch, 
of a certain time length or "duration." This length is determined 
by the note's "size" (whole, half, quarter, etc.) and also maybe 
by "duration modifiers" (durmods) such as dot, double-dot, and 
triplet. Every note has a "body;" half-notes and smaller have a 
"stem," and 8th notes down to 64ths have "flags" or tails on their 
stems. Stems may point up or down but this does not affect 
playing. Vertical body position on the staff determines the note's 
playing "pitch" (frequency, MIDI note number). 
  
 A "rest" is like a note but represents the "sound of silence." 



Rests have no pitch, so are always shown at a few standard lines 
of the staff. They have no stems or flags, but can take durmods, 
but not artics.  
  
 Time flows horizontally and is broken up into digestible chunks 
called "measures" or "bars," separated by vertical "barlines." The 
time duration per bar is given by a "time signature" written N/S, 
where N is the number of 
 
 "beats" (taps of your foot) and S is the size of the note that 
takes up one beat. 
  
 A note's pitch is given by its slot-height on the staff, and also 
by optional prefixed "accidentals" -- the familiar "sharp," 
"flat," "natural," and "double sharp or flat." A sharp raises a 
note's pitch by a semitone (one MIDI note number), and a flat 
lowers it by one. Double flats or sharps shift it by two 
semitones. An accidental keeps its effect thru the remainder of 
the measure until the next bar line, or until cancelled by another 
accidental. A "key signature" is a set of default sharps or flats 
that apply to all notes of certain names (letters A thru G) 
throughout all bars. These can be cancelled by naturals or 
overridden by sharps or flats.  
 
  
 SOME ULTIMUSE-III TERMS 
 
 A "screen" covers the entire monitor/TV screen. 
  
 A "menu" is a list of choices of things you can do at the moment. 
It may be a sub-part of a screen. 
  
 A "text" menu is simply printed in words and characters, and you 
make a choice by typing one or more keys. All but a few key 
commands (G, L, R) require lower case, and commands without 
arguments never need an ENTER. Most text menus let you select with 
the mouse; the line item under the cursor is blackened or inverted 
video.  
  
 A "graphics" menu draws pictures as well as text on the screen, 
and you can make choices or do more complex actions with the 
mouse. Some actions can still be triggered with keys. 
  
 The "score" is the music data file you're working on, or the part 
of it that's visible on the screen. UltiMusE-III is a "score 
processor" just as there are "word processors." (Except that word 
processors don't given dramatic poetry readings, but UltiMusE can 



also play the musical score.) We'll use "score" to mean the music 
itself, the data in memory, or its visual representation on the 
screen. 
  
 An "image" is any single visible graphic item. 
  
 The "cursor" is a special image that moves around with the mouse 
position and shows what the mouse will operate on if the mouse 
"fire" button is pressed. Sometimes we say "the mouse" when we 
really mean "the cursor," since they move locked together. 
  
 "Background" or "scenery" is any part of a screen that is always 
the same and does nothing with the mouse, but helps guide your 
eyes to sort out and find more useful images. 
  
 An "indicator" is an image that changes to show you information, 
but is usually read-only. 
  
 An "object" is any image that's part of the score -- a note, 
clef, bar line, staff, etc. These can be added, deleted, moved, or 
changed, usually with the mouse. Objects are also used in menus. 
 
 An "icon" is any image that's part of a graphics menu. It may be 
an object, a tool, or a button. 
  
 A "menu object" is something that can be picked up with the mouse 
and inserted into the score at the cursor. 
  
 A menu "tool" is an icon that, when picked up on the mouse 
cursor, is used to change or delete score objects, but is not 
itself an object that can be inserted into the score. A tool lets 
you work on objects.  
  
 The "brush" refers to the cursor as a carrier of whatever tool or 
object is currently on it. A "dry" or "clear" brush is a cursor 
with no object or tool active (usually shown as an arrow or 
paintbrush cursor). 
  
 A "button" icon (not the mouse button) is like a tool but it acts 
instantly when selected by the mouse, instead of just arming the 
cursor with its action. Usually the action affects the whole score 
globally, or one object already selected. All text-menu choices 
act as buttons. 
  
 A "button menu" or "button box" is a graphics menu, or sub-part 
of one, consisting only of button icons. 
  



 SQUEAKING OF MOUSE BUTTONS -- 
 
 "Clicking" the mouse means pressing the button and releasing it. 
  
 "Clicking on" some image means clicking while the cursor is over 
it. 
  
 "Quick-clicks" and "Long clicks" are used when it matters how 
long the button is held down. 
  
 "Double clicking" means two short clicks in rapid succession. 
MM/1 users must do a "medium click" instead. 
  
 "Dragging" means putting the mouse (cursor) over an image and 
holding the button down while moving the mouse, thus moving that 
image like a cursor. 
 
 
 PARTS and STAVES, UltiMusE STYLE 
  
 UltiMusE lets you spread the voice parts over as many staves as 
you need, each staff positioned where you want it. To create a 
piece from scratch or just modify an existing score file, you need 
to know how UltiMusE handles a staff and its parts. 
  
 A musical score (piece) consists of one or more staves, each with 
one or more parts (voices) of notes and rests on it. Each staff is 
marked with a clef, which defines the pitch-range of notes on that 
staff. A staff has a grid of five horizontal lines; these and the 
spaces between them measure the pitch of notes, which must fit 
centered on a line or in a space.  
  
 You already know the Treble and Bass clefs, used on almost all 
sheet music. Middle C is on the next line below a Treble staff, 
and on the next line above a Bass staff. (These extra lines, drawn 
only as needed for notes outside the staff, are called "Ledger 
Lines.") Our "Guitenor" (for Guitar or Choir Tenor) clef is just a 
Treble clef with an 8 at the bottom to show that its notes are 
played an octave lower than written. Use the Guitenor for voices 
whose notes hang too low below a Treble staff or fly too high 
above a Bass. The Double_Bass clef is a Bass clef with the same 
idea; use it for deep bass lines and Organ pedal parts. The "Beta" 
clefs (Alto and Tenor) need not be used unless used in the sheet 
music you're mousing in, or you're writing viola or high trombone 
parts. The Percussion clef (two vertical lines) is explained 
later. 
  



 A Umuse3 note can be placed up to 16 notches (lines and spaces) 
above the center of its staff, and 15 below, for a total of 31 
possible "diatonic" (white key) pitches, or 4.5 octaves. Our clefs 
extend that to over 7. An "octave" is from one note to the next 
with the same name, or seven white keys or seven lines and spaces 
on a staff. 
  
 An UltiMusE staff has three positions for a part's notes and 
rests: Upper, Middle, and Lower. These positions do not affect the 
note or pitch range of a part, but only some details of how it is 
displayed. The different positions are easiest to see when a staff 
is first initialized with rests. A Middle part's rests will be 
centered in the staff as in printed sheet music. An Upper part's 
rests will be centered on the staff's top line, and a Lower part's 
on the bottom line.  
  
 Since the two or three parts' rests do not overlap, when laying 
notes over them you can easily pick which part to edit with the 
mouse, and write two or three independent parts per staff. This is 
a major advantage of UltiMusE, as long as you don't put more than 
three parts on a staff. For chords, use the "Clone Parts" features 
described later.  
  
 As you put notes in, the stems or tails of an Upper part's notes 
always point upwards, and a Lower part's stems always aim 
downwards. A Middle note's stem points either up or down towards 
the center of the staff, just as in printed music, automatically.  
  
 When following the Prompts, if you put just one part on a staff, 
it will be a Middle part. Two parts will be one Upper and one 
Lower. Three will laid out Upper, Middle, and Lower. 
  
 Middle part notes are less likely to take up vertical space 
outside their staff and tresspass on another staff's space. For 
fewer than six parts, making each part a Middle on its own private 
staff may use less space than packing parts on fewer staves. 
  
 A staff with just two parts, one each Upper and Lower, takes up 
lots of vertical space. However, since each part's notes' stems 
always point a consistent direction, you always know what part a 
note belongs to when editing later on. Middle-part notes 
masquerade as one of the other parts, so more than two parts per 
staff (not counting Clones, later) can get messy. 
  
 When starting a new piece, get an idea of how many parts you'll 
need and how you want to group them on staves. Solo lead parts 
should have a staff of their own; chords should share a single 



staff, and a bass line should have its own Pedal-clef staff. Piano 
music comes written on two staves, but you should probably use 
more, at least while inputting and editing. 
 
 Don't try too hard to get it all right the first time, since you 
can change everything (really!) later in the Layout Menu. 
 
 
 The SCORE DISPLAY SCREEN 
  
 After setting up a new score or pulling in an existing music 
file, you reach the Score Screen, which you'll spend most of your 
Umuse3 time looking at. Most of the screen displays your staves 
and the notes and rests of a few bars (measures) of the piece. You 
can move this "view port" anywhere in the score.  
  
 The music display shares the screen with several important 
indicators and mouse target icons. The top border is the Main Menu 
Bar. Clicking any of its words pops up a menu, or takes an 
immediate action. See "The Main Menu Bar" for more details.  
  
 The bottom border is the Scroll Bar indicator, whose blacked-in 
portion shows where your current view screen fits into the entire 
score. At each end of the Scroll Bar is a horizontal arrow; 
clicking these icons shifts your view screen in that direction by 
an entire screenful. Trying to shift right off the end of the 
score adds some more rest-filled measures to extend the score. 
  
 
 TOOLBOX 
 
 Just above the scroll bar is the "Floating Toolbox" containing 
the major Palettes and indicators, boxed off by vertical lines. 
The left half is the Note/Rest palette, initially of notes ranging 
from Breve (double whole note) down to 64th. Hidden behind it is a 
corresponding palette of Rests. To its right is a quarter-rest 
icon; clicking it flips the Notes palette under the Rests, so the 
Rests are visible to you and the mouse. Then the single rest icon 
turns into a quarter note to represent the now-hidden Notes 
palette; click this again to get the Notes back, and the icon once 
again shows a Rest for the hidden palette. 
  
 To the right of this is the Duration Modifiers (DurMod) palette, 
ordered Nothing (written - ), Dot, Double Dot, and Triplet (3). 
Clicking these adds that DurMod to whatever note/rest value you 
have currently chosen. Choosing Triplet also adds triplet notation 
to the note/rest palettes. 



  
 Under the Durmods is the Artics (articulation) palette, where you 
pick up cursors that can be applied to any note to control how 
much "breath" or silence that note leaves before the next note or 
rest. The leftmost Artic icon is Legato, and makes the note sound 
its full value and glide smoothly into the next note. Next is the 
"void" artic, shown as a tiny circle; it means "no Artic" and will 
turn off any already showing on a note. Thrid is Marcato, shown as 
a dash; it makes the note leave about a 32nd note's worth of 
breath before the next note. Last is Staccato, which cuts the note 
off after sounding for half its full value.  
  
 Notes without artic markings continue to use the most recent 
artic played in that Part. Artics are very important in making a 
piece sound like real music and not a clunky, nerdy computer.  
  
 Unlike the DurMods in the palette above theirs, Artics are not 
part of the current Brush note. Instead, you apply them to notes 
already in the score. Pick one up, say Marcato, and click over a 
note with no artic. That note will now show the dash over or under 
its body. Clicking again on that note will toggle the artic back 
off. Clicking on a ntote with an artic already will replace the 
old artic with the cursor's one.  
  
 Beyond the DurMod palette is the double-decker Marker and 
Specials Palette, with the Left and Right Marker brackets [ and ], 
the Insert Marker |, the Delete X, the Expression Tool single-
arrow ^, the Tie that looks like an eyebrow, and a lower row of 
"power tools." Some of these are objects to insert into the score; 
others are tools to make changes in the score. More about these 
later. 
  
 At the far right is the "Current Brush Representative" or "Rep", 
which shows your present selection. Click around on the four 
palettes just described and watch how this Rep changes. It always 
shows what you would put in the Score if you clicked on a rest or 
note there. Also see how the Cursor changes to match Special 
items, including Artics.  
 
  
 SUMMARY SO FAR: 
 
 The Brush Rep shows what is on your "brush." Hit the lone rest to 
get Rests menu; lone item turns to note. Hit that to flip back to 
Notes palette and so on. 
  
 Click on any palette note/rest body to get that item on your 



brush. Optionally click the "-" palette to modify the note's 
duration. The '-' means just plain note, no dots or triplets. 
  
 
 MOVING and REMOVING the TOOL-BOX 
 
 Since the Toolbox covers valuable space, you can move it up or 
down on the score screen or get rid of it entirely. To move it, 
put the cursor (any brush) over the Brush Rep and hold down the 
mouse button while dragging the Toolbox up and down the screen. To 
remove the Toolbox and Rep, just quick-click on the Rep.  
  
 To get the Toolbox and Rep back on the screen, put any cursor in 
any blank area not inside a staff and double-click (medium click 
on MM/1). Also, clicking the TOOLS on Top Menu Bar or typing 't' 
toggles the Toolbox/Rep on/off.  
  
 Usually you concentrate on one or two staves at a time. Keep the 
Toolbox over a staff you're not working on, or invisible if you're 
doing "pick-up" editing of notes (next section). 
 
 
 WRITING and EDITING NOTES 
  
 To write a note or rest into the score, you must first get it 
onto the Brush cursor as shown by the Brush Rep. When the Brush 
carries a note or rest, the cursor is a small artist's paintbrush 
(or a '+' sign, see Advanced Topics). You next click on a 
note/rest already in the score. 
  
 To get a note from the Toolbox palette, first click over the 
desired note-size body, then click on the Duration Mod if needed. 
Dots and double-dot Mods are cleared whenever you click a note 
body, so if you have a dotted quarter on the brush and want a 
dotted 8th, you must still click the 8th-note body and then the 
Dot Mod. Triplets "stick to the brush" until you click another Mod 
or "pick up" a non-triplet note from the score (see below), so you 
can work with different sized triplet note/rests without clicking 
the Triplet Mod each time. 
 
  
 OVERLAYING (INSERTING) NOTES and RESTS 
 
 Now that your current Brush is a note or rest, how do you put it 
into the score? A fundamental rule of UltiMusE editing is that 
notes and rests can only be added at the left edge (starting time) 
of existing ones. More important, the new note/rest "overlays" the 



previous one and takes over its place in time -- it is not 
"inserted". Notes downstream of this are not shifted in time. In 
word-processor terms, UltiMusE is always in "overstrike" mode 
rather than "insert/delete." You can't insert or delete TIME, or 
else the voice being edited would get out of sync with the other 
parts. This is why a score's new bars are always pre-filled with 
rests.  
  
 These initial rests serve as grids or guides to note placement in 
time and allow you to start anywhere. If you need a four-bar intro 
but don't want to write it now, start entering music at the 5th 
bar and do the intro later. 
  
 Your new note will have the same starting time and (unless you 
drag it) the same virtical position and pitch as the item it 
overwrote. (We'll say "note" but often mean "note or rest.")  
  
 
 CHIPPING 
 
 If the new note is shorter in time than the old one, it "takes a 
chip" out of the front of the old, but the remainder of the old 
note will still exist to the right of the new one. Maybe two or 
more notes will be needed to represent the remaining time; if so, 
they are "tied" together. Example: Lay a dotted eighth note over a 
quarter, and you get your dotted eighth followed by a 16th, which 
is what's left of the quarter. Umuse3 does all this automatically.  
  
 The remainder note or notes keep the same pitch as the original, 
no matter what you drag the new note to. 
  
 
 BOMBING 
 
 If the new note is longer, than it will overwrite ("bomb") as 
many old notes as needed to use up its duration; if the last note 
overlaid is not completely used up in time, the remaining time 
takes a chip out of the last note, and its remainder will pop up 
to the right as already described. A half note will bomb out 2 
quarters, 4 8ths, or whatever adds up to a half note. The old 
notes are gone forever, so do take care (see ABORT below).  
  
 A new note will overwrite only notes in the same Part as the 
first note/rest that you clicked the mouse on. Other parts are not 
affected.  
  
 You can probably figure all this out quicker by trying it than by 



reading. It's pretty simple, unlike our software that figures it 
out for you. (Yes, you can chip a triplet 32nd out of a dotted 
half and we figure out what it takes to fill out the beat). This 
feature lets you go back and modify early parts of a score without 
all the later notes hopping around whenever you insert or delete 
something. 
 
 
 USING THE MOUSE 
 
 To write the note/rest on your brush to the screen score, 
position the cursor right over an existing note/rest and push down 
the mouse button and KEEP IT DOWN till you see the object change. 
The slight delay is deliberate, to override the Pickup mode 
described below. If you're writing a rest, release the button and 
it stays. If a note, you can drag it up or down the staff quite a 
ways. It wraps around once if you go too far. If your mouse runs 
out of travel before you've pushed the note as far above/below the 
staff as you want, push the opposite direction until the note 
wraps around to the other extreme, then position it. 
  
 See that "ledger lines" are added if you push the note outside 
the staff lines. Also if this note is a "middle" voice (see "Parts 
and Staves"), its stem or tail will automatically flip into the 
staff's center. 
  
 If you lay a note over an existing note, the vertical pitch 
"stays put" till you move it, which makes it easier to change a 
note's pitch slightly. Likewise for its accidental marking if any. 
  
 Accidental marks (sharps, flats, natural) are added or changed by 
left-right mouse motion while dragging the note. This also wraps 
around several times for convenience. Notice the double flat and 
the double sharp that looks like a small 'x'. 
  
 Once you have the note adjusted right in both axes, let go the 
mouse button. If your new note/rest bombs or chips the old one(s), 
the screen refreshes (redraws). If the old and new duration are 
the same there is no refresh, which is quicker but may leave a few 
"holes" in the staff lines or nearby notes. Hit 's' to redraw if 
it bothers you, but your next bomb/chip or window move will 
refresh the screen anyway. 
  
 
 
 



 ABORTING NOTE/REST SELECTION 
 
 If you start to write a note/rest but realize you have the wrong 
duration on the brush or the mouse picked the wrong part, you can 
bail out, IF you are still holding the button. Drag the mouse all 
the way down and left, ignoring the note display. A text window 
will pop up to say "Release to Abort." Let go the button now and 
your graphics display comes back unchanged. Now try again. 
  
 If you were really dragging a note downwards and triggered the 
ABORT prompt accidentally, just keep holding your button and push 
the mouse back towards the center. You will still be dragging the 
note -- the abort is aborted. There is no UNDO for score 
overwriting -- once you let go the button while the score is 
showing, what's done is done! 
 
  
 NOTE PICKUP -- REVERSING THE BRUSH 
 
 To change the type of note/rest on your brush, you normally go 
down to the palette. But if you're making lots of little changes 
to a score, it's quicker to pick up (copy) an existing note onto 
the brush. Just put the cursor over an existing note/rest and 
Quick-Click the mouse ("staccato" for us musicians). The Brush Rep 
will briefly pop up and flash over the cursor, and the Toolbox's 
Rep will change to the type and duration of note/rest you picked 
up. So will the note/rest palette if need be. This is the reverse 
of the usual score-writing operation. Handy for moving an existing 
note's vertical pitch or changing its accidental -- first pick it 
up with a quick click, then without moving the mouse, use a firm 
press-and-hold to drag the note to where you want it. 
  
 Pickup works only when the Brush is already a note or rest, with 
the cursor showing as the small artist's brush. 
  
 
 OVERLAPPING NOTES/RESTS -- SHIFT and CTRL Keys 
 
 All notes, rests, and other items are always accessible to the 
mouse, no matter what part/voice they're in (unless you're using 
the Pick Filter, under Advanced Topics). This usually makes for 
fast editing convenience. Whenever two or more notes or rests 
overlap on one staff, the mouse normally picks the item belonging 
to the lowest-numbered part.  
  
 But, if you press and hold the SHIFT key before clicking the 
mouse, Umuse3 will skip the first item and instead take its 



"second choice." So given two overlapping notes, use SHIFT to get 
the higher-numbered part's note. 
  
 The CTRL key works the same but makes the mouse take its "third 
choice." Holding both SHIFT and CTRL takes the fourth. So you can 
handle notes/rests piled up four deep. If you key in a higher-
numbered choice than is there, no problem; Umuse3 will always take 
the last available choice. For example, if there are just two 
overlapping notes, holding either or both keys will force the 
second choice. 
  
 (The MM/1 does this differently. Instead of adding to the pick-
depth by holding keys, pre-set the depth by holding the ESCape key 
while hitting a digit from 1 thru 4. A momentary window will flash 
with the new and old pick depth. Now use the mouse on your note 
pileup, without holding any other keys.) 
  
 This feature applies to both writing notes and picking them up. 
If the overlapping items have different time durations and you 
just want to change one of the notes' pitch, remember to "pick up" 
first with a staccato click. This also gives you a chance to check 
which one you got. You don't need to keep holding the keys while 
dragging a note with the mouse.  
 
  
 MOVING YOUR VIEW THRU THE SCORE & ADDING NEW BARS 
 
 Click inside the score area, hard against either screen edge but 
not inside any staff, to shift your view 1/2 screen width left or 
right. Click on the arrows at either side of the scroll bar to 
move a whole screen width (with a one-note overlap).  
  
 When the end of the piece is visible, trying to move a full 
screen to the right will add a few more new measures. These will 
be filled with Rests according to the last Time Signature in the 
score. 
 
 
 SPECIAL PALETTE TOOLS 
  
 Finally let's explain the Tools Palette on the right side of the 
Toolbox. The first three are the Markers: the LeftMark '[', the 
RightMark ']', and the ToMark '|' that shows as a rounded-off I-
beam in graphics. '[' and ']' are used to bracket off a "block" of 
score for copying, moving, deleting, playing, or otherwise 
processing just the block. The '|' marks the destination for Block 
Moves and Copies and can be turned into a new Barline.  



  
 Markers are inserted by clicking the desired marker type from the 
palette onto the Cursor, and then clicking it over any object in 
the score. Left marker and | will insert to the left of what you 
hit, but right marker goes to its right. 
  
 Markers may not "slice" any notes (unless you give permission) -- 
they must fit in where all voices have stopped and are about to 
play new notes. Otherwise the score may get confused when you 
move, copy, or delete using markers that slice a note. There can 
be only one of each of [|] at a time; inserting another 
automatically deletes the old one. To get rid of markers you 
suspect are somewhere in the score, just (re-)insert them anywhere 
and then delete with the 'X'. Or find them with a 'g' search. 
  
 Markers left in a score will be saved to files and read back in 
just like notes and barlines.  
 
  
 MORE SPECIAL TOOLS 
 
 Select the X to delete almost any score object with a mouse 
click; the cursor shows as an X to remind you what you're doing. 
The only things X will not delete are clefs and staves (use the 
Layout Menu) and non-Clone Rests. Non-clone notes aren't deleted, 
but are changed to the corresponding rest. If you X-out the wrong 
object, type 'u' or pull down the Random Menu to undo it. Only the 
most recent deletion can be undone, and inserting or changing any 
score objects also "breaks the spell." 
  
 Choosing the Tie lets you tie a note to the next note in that 
part; these will play as one long note, if the second note is the 
same chromatic pitch as the first. As in real musical notation, 
ties across barlines carry accidentals over into the next measure. 
Several notes in a row can be tied together. UltiMusE puts the Tie 
on the first note of a pair, not the second. A Tie replaces any 
Artic on a note, and vice-versa. 
  
 Clicking an already tied note unties it; then you can tie it 
again, etc. See how the tie always goes on the opposite side of 
the note body from the stem. You can't "pick up" a note/rest while 
the Cursor is a Tie or any other Special Palette item.  
  
 
 EXPRESSION INSERT-MARKER (^) Sub-Menu 
 



 The Palette tool '^' (up-arrow) inserts objects from the 
Expression Menu that make your music sound less like a machine. 
Clicking the ^ cursor over certain kinds of score objects brings 
up this menu; after you type or mouse a choice and its argument, 
the menu disappears and the expression object is inserted to the 
left of the object you clicked on. 
  
 You can insert a Tempo anywhere by clicking on anything in the 
score; to the Expression Menu type 't' followed by a number 
between about 40 and 255 and ENTER. Tempos are exact "MM" 
metronome beats per minute as used in sheet music. Beats are in 
terms of the bottom of the Time Signature, or in triples of it if 
6/8, 9/8, etc. If your piece has new time sigs in it, the tempo 
will adapt to each new one as the piece plays. All tempos are 
scaled up or down in speed by the global "seconds per minute" 
value set under the MIDI Menu. Tempos display at the top of the 
score and affect all parts equally. 
  
 Accelarando and Ritard will gradually change to the new tempo you 
specify, over a period of so many beats that you also give. 
"Accel" and "rit" are often seen in sheet music, but it's usually 
up to you to judge what tempo number to use. Experiment -- these 
make your music sound really "human." 
  
 Volumes (or Levels) are private to each part (voice) and can be 
inserted only on notes or rests, except that inserting one over an 
existing volume will overwrite the old one. You can type 'v' 
followed by one digit 0 thru 7 (no ENTER), but the score display 
will show the traditional ppp - p - mp - mf - f - fff notations. 
If you just click on Volume, a little pop-up menu lets you choose 
a level without ever letting go the mouse for the keyboard. 
  
 When playing, a volume remains in force for its part until 
changed by another volume. Parts start out with a default volume 
of mf = 4. 
  
 Instruments are inserted and operate just like Volumes, except 
you type 'i' and a number 0 thru 15 and ENTER (yes). The number is 
not sent to the synth during play, but indexes one of 16 entries 
in your Instrument Table that is. See the "Instrument Menu" 
chapter. If you just click Instrument, up pops a read-only copy of 
your current Instrument Table for tyou to choose from.  
  
 Clicking "MIDI chan hop" lets you type a new MIDI channel for 
this part to hop/jump to when playing gets here. This overrides 
the starting value MIDI Menu's Channel table.  
 



  
 MIDI "Events" are an Advanced Topic. 
  
 General volumes ("Genvols") are ppp-fff just like the per-part 
ones, but affect all parts of the score equally. Often you can do 
all your "expression" with Genvols and use the per-part levels 
just to balance the parts. 
  
 Crescendo and Diminuendo are Genvols that gradually increase or 
decrease to the level you specify, over a period of so many beats 
that you also give. They always start from whatever general volume 
was already in force, and creep to the level you give. Sheet music 
often shows "cresc" and "dim," but you should use these almost any 
time you change general volume -- hardly anything makes your music 
more natural and professional than these. 
  
 Accent and Layoff are special Genvols that temporarily make only 
the very next note (or chord of notes) louder or softer by about 
two levels of volume (adjustable in the MIDI Modes Menu). Accents 
can really give a piece "rhythm" and syncopation -- is it live or 
a computer? Layoffs should be used on the last note of a phrase, 
the way you'd sing it. On guitar chords, down-strums should be 
accented and up-strums laid off. 
 
 Next to last on the upper tool row is the '+' Plus-Brush (or the 
regular artist's Note-Brush if the cursor is currently a Plus). 
This is for inserting "Clone" chord notes and is covered under 
Advanced Topics. But, try playing with it, answering "Yes" to 
questions, but first turn on Note Carryover mode (Options Menu) 
for some real fun. 
  
 The plain Brush or Plus cursor (Note or Rest) acts as a Special 
Tool if you click it on a Barline or one of the Go_To's or 
Signature objects that hang around Barlines. This click gets you 
the Barline Menu (see its chapter) for inserting or changing such 
items. The 'X' tool deletes them. 
  
 The bottom row contains Power Tools under Advanced Topics. For 
now, the double-bar tool inserts Barlines anywhere, the Question-
mark gives information about any score object clicked on, and the 
piece of window screen brings up the Finder Filter Menu. The 
square is Part Copy, a real powerhouse, but be careful! 
 
 
 MENUS and COMMANDS -- INTRODUCTION 
  
 TEXT MENUS 



 Some of the menus are text lists of command options, and you 
click on a line or type a character to make a selection. Each text 
line begins with its selection character. Most characters must be 
in LOWER CASE or UltiMusE won't understand your commands, though 
the Menus use capital letters to show the "hot" character. Some 
commands take an "argument" of one or more characters that you 
type right after the command character, with no BLANK or ENTER 
between. 
  
 I hate typing ENTERs. When only single keys are needed for a 
command, answer, or argument, the action is instant; you need not 
hit ENTER. Only when arguments (numbers, file names, etc.) of more 
than one digit or letter are needed must you use ENTER to 
terminate the line, since UltiMusE can't guess where it ends. 
  
 GRAPHICS MENUS 
 Most menus are graphic -- you select by clicking the mouse over 
your choice. The Main Menu Bar over the Score is always "live" and 
can be clicked with whatever cursor you have on the brush. Other 
pop-up (or drop-down) graphic menus (Setup, Layout, Random, and 
Options) are "PushButton" menus that switch to a solid diamond 
cursor when in effect. 
  
 Even graphic menus handle "keyboard accelerators," which is sales 
hype for single characters that you can type instead of using the 
mouse. The character for each selection is either the first 
capital letter or the first non-letter in the selection label (as 
in 'f' for "reFill"), but you must type a small letter. Exception: 
for any "Finished" or "Done" selection, hit ENTER. 
  
 DIALOGUE BOXES 
 Two standard "menus" worth mentioning are graphics boxes that can 
pop up at any time. Both temporarily turn the cursor to a solid 
diamond. One is the Alert Box, a horizontal window that prints a 
message and waits for you to either hit ENTER or click the mouse 
anywhere. 
  
 The other is the Yes/No box, which prints a message asking a 
question and then waits for you to type 'y' or 'n', or click 
either its YES or NO! buttons. Until you answer, you can do 
nothing else except hit BREAK and quit Umuse3 (via yet another 
Yes/No box). 
  
 For your convenience both pop up over your present cursor 
position. 
  
 NAVIGATION 



 You are "in" whatever menu is listed on the screen. Some commands 
will descend into another menu; these show "..." after their 
letter on the menu. Others get you into question/answer sessions. 
If a number value is asked for, there may be a "default value" in 
[square brackets]; if you hit just ENTER it's as if you typed that 
value. Yes/No questions must be answered 'y' or 'n'. 
  
 Any menu can be exited (back to graphics or the next higher menu 
that you came from) by typing just ENTER. When lost, keep hitting 
ENTERs till you see the score screen. 
  
 Some menus are reached only by clicking on certain score items 
(like bar lines) or by trying to insert certain special tools into 
the score. 
  
 Most commands are single characters. These need no ENTER but act 
instantly (so be careful, no chance to backspace) and exit their 
menu. 
  
 You can "type ahead" a command and argument to a menu even before 
it shows on the screen, once you're sure of the command. The 
Random Menu doesn't even show itself if one of its commands is 
typed while the score screen is showing, and the Main Menu bar 
(which officially handles such characters) funnels any character 
that doesn't match its selections down to Random, which displays 
only if it can't match the character either. So for example, to 
refresh the score display, you can just type 's' instead of typing 
'r' to get the Random, wait for it to display, then typing 's'. 
 
  
 LIST OF MENUS 
  
 MENU HOW REACHED (from Graphics) 
 Main Always showing above Score as top Bar 
 Random Click Main, or type 'r', SPACE, or any unused character 
 Instruments 'i' or click Main Bar 
 Percussion 'p' from Instruments 
 Part/Staff Layout 'l' or click Main 
 Options 'o' or click Main 
 Startup Start Umuse3 from OS9 without filename arguments 
 BarLines Click on any Barline while Brush is any note/rest 
 Expression Click on any note/rest while Brush is ^ (up-arrow) 
 Block Operations 'b' or click Main 
 MIDI Chans 'm' or click Main 
 MIDI Modes 'm' in MIDI Menu 
 MIDI Volume Levels 'l' in MIDI 
 Files I/O 'f' or click Main, or 'r' from Startup 



 Goto/Search 'g' or 'G' to Main; type "g?" for Menu 
  
 Note: In this manual, we notate a command involving submenus by 
joining the Main Menu command and the submenu command characters; 
so "fs" means "hit 'f' to get Files Menu, then hit 's' to save the 
score." 
 
 
 The MAIN MENU BAR 
  
 Main Menu commands are triggered by clicking on the Bar or typing 
the first letter of the selection name. Most selections just 
descend into another menu, except for Play, which plays the score 
from the beginning, and Tools, which toggles the Toolbox and Rep 
on and off.  
  
 For speed, the Main Menu also recognizes all the commands 
belonging to the Options and Random Menus, except 'r' for Restart, 
which just brings up the Random Menu. Type "rr" to restart Umuse3. 
  
 If score items mess up the menu bar, type 's' to refresh the 
screen. 
  
 'g' calls up the Goto/Search Menu. This menu doesn't list its 
choices unless your argument (with its required ENTER) is invalid, 
so experienced users can think of 'g' as a Main Menu command. Type 
"g? ENTER" to get the full menu listing.  
  
 'G' is one command that accepts a capital letter -- works like 
'g' but restricts the search to "Special" barlines. See the 
"Search Menu" chapter for details. 
  
 'L' is not shown, but typing capital 'L' will, for each Part, 
connect all notes of that part together with straight lines. Rests 
are ignored. To include Rests, type 'R' instead of 'L'. When 
finished looking, type 's' to redraw the screen. 
 
 
 The RANDOM Menu 
  
 The Random Menu is a graphic box of "pushbuttons" that you 
"punch" with the solid diamond cursor. Its commands can also be 
typed, even from the Score Screen's Main Menu Bar -- no other Menu 
allows this. 
  
 'p' plays the entire piece from the beginning to the end, or 
until you hit BREAK, CTRL-C, or SHIFT-BREAK.  



  
 'w' starts playing from the left edge of your current graphics 
view and goes to the end or until you hit one of the above stop 
keys. 
  
 's' refreshes the screen if it is messed up, as after inserting 
same-duration notes or note stems trashing the Main Menu Bar. 
  
 'n' re-numbers all the Barlines, starting at the beginning. It's 
smart enough to check for a short "pickup" measure at the 
beginning, which is numbered 0 instead of 1. The first full bar is 
numbered 1. Also, any two or more consecutive barlines without any 
time-occupying "meat" between them (meaning notes or rests) will 
all get the same number. 
  
 'u' undoes the most recent deletion made with the 'X' cursor on 
the Score Screen. It only remembers the last one. 
  
 CTRL-C or SHIFT-BREAK makes a hard-copy screen dump of whatever 
is showing on the screen to a 9-pin dot matrix printer. Hitting 
ENTER or BREAK during the printout should stop it.  
  
 'h' begins a hard-copy printout of the entire score, or the 
[marker-bracketed] portion. This will print as many "systems" or 
screens of staves per page as will fit, and automatically feed and 
print as many pages as needed. You'll be asked for two options -- 
first, whether to really print or just preview the print on the 
screen (this is fun to watch). Second, whether to vertically 
squeeze the staves as close together as the notes allow -- 
normally you want this, unless you need space between the staves 
to write lyrics or chord symbols. If really printing, be sure you 
have the correct printer selected in Options Menu, and the printer 
is on-line with the paper perforation right at the print head.  
  
 ':' or '9' brings up a 78-column text window to the OS-9 Shell, 
in Umuse's present working directory. Type as many OS-9 commands 
as you want, to rename files, etc. Exit back to Umuse with a blank 
ENTER in Coco, or ESCAPE in MM/1.  
  
 '?' or '/' pops up a text window that lists status info about 
your current score, including the number of score-memory cells 
used and remaining, plus the Title Info banner, the score version-
level, and the version of this copy of UltiMusE (tm).  
  
 'r' restarts UltiMusE-III clear back from the copyright message, 
after making sure you really want to. This clears out everything 
and reloads the graphics images, and is a last-gasp alternative to 



quitting and starting over from OS9. It's as if you had, with no 
command-line arguments. 
  
 'q' quits Umuse3 and returns to OS9, after asking you to confirm 
this and giving a chance to save the score. You can also quit at 
any time or place other than playing by hitting BREAK. 
  
 'f' brings up the Finder-Filter Menu, the same as clicking the 
Toolbox's screen-door icon. This controls what your mouse can or 
can't "see" in the score screen, and is covered under Advanced 
Topics. 
 
 
 The OPTIONS Menu 
  
 The Options Menu lets you set "modes" that control some of the 
ways Umuse3 handles certain situations. Every mode set here is 
part of your Um3.Init preferences file, along with some other 
items from the MIDI Modes Menu. 
  
 The 'c' button lets you set or clear Display-Compacting mode. 
Compacting displays all notes with the same spacing regardless of 
their time duration. Turning compacting off spaces them 
proportionally to their time length, which can be helpful in 
editing complex multi-part bars. Normally compact mode is better, 
and fits more stuff on the screen; it's the startup default mode. 
Future versions may have intermediate spacing modes as well. 
  
 Type 'd' to set or clear the Play-Debugging mode, which prints 
out barline numbers, tempos, and signature changes during play. 
This tracing does not slow down play timing (thanks to OS9's 
multi-tasking), but the printout may lag behind the play by a 
measure or two. Tracing is a lifesaver when debugging scores with 
repeats, 2nd endings, and DS al Coda (yes, "debugging" -- music 
notation is the world's oldest programming language!). 
  
 'w' toggles "Watch Play" mode (MM/1 only). Each time the music 
being played goes off the screen, the screen is redrawn to follow 
the play, so the part of the score being played is always visible. 
Play halts for a moment while the screen refreshes, so don't use 
this mode except for debugging or demos. "Watch" and "Debug" modes 
should not be used together. 
  
 The Screen Colors and Preference File-save/Restore buttons are so 
useful that they were described in earlier sections. You can 
change the colors, update your Preferences file, or restore to its 
most recent mode and color settings at any time. 



  
 The '?' or '/' just duplicates the Random Menu's Show Status 
command.  
  
 'a' toggles Cursor Snap on/off. This mode causes any cursor in 
the Score Screen to sense when it is very close to a score object 
you could click on, and snap onto that object as if by magnetism, 
until you move the mouse more than a few pixels away from the 
object. Normally very handy, cursor-snap may be a nuisance when 
working with dense pileups of notes and rests. Also it eats up 
more CPU time, so may be turned off while downloading in another 
window. 
  
 'n' toggles Note Carryover mode. Without this mode, when you 
first place a note over a rest, the note starts out centered in 
the staff, until you move it up or down. But with Note Carryover 
on, the note will initialize to equal the last note to its left in 
the same Part. Really handy for repeated notes and parts that are 
far from the staff's center line. Especially valuable for 
"cloning" chords (see Advanced Topics). 
  
 'p' pops up the Printer Type submenu. You must choose a printer 
before doing any hard copy screen dumps or score prints, unless 
you've already done so and saved the Options. 
 
 
 The SETUP PROMPTS 
  
 There are three ways to get into creating a new score from 
scratch -- select "New Score" from the Startup Menu initially or 
from the Files Menu later, or do a Restart from the Random Menu. 
All ask whether you want to be led through some choices before 
being presented with the Graphics Setup. This Setup screen is very 
powerful in setting up a new piece, but while learning you should 
go the Prompts route. The Setup then shows what you've done so 
far, and you can change or add to it with point-and-click mouse 
operations.  
  
 The optional Prompts are a strictly text and keyboard sequence of 
questions, organized one staff at a time. For each staff you are 
asked to choose a clef, then how many voices to assign to that 
staff. You can put up to three per staff, and add more later. 
  
 Don't try too hard to get it all right the first time, since you 
can change everything later in the Setup or Layout Menus. 
  
 The prompts are self-explanatory and your responses are checked 



for safety. To exit with fewer than eight staves or 16 parts, just 
hit ENTER on the next "Clef" prompt. Using more than six staves 
causes messy overlapping of clef signs. Answering 'n' to the 
"Satisfied?" prompt makes you start all over. Better to say 'y' 
and change things later in the Setup Menu, which covers the screen 
as soon as you hit 'y'. 
 
 
 The SETUP and LAYOUT SCREENS 
  
 The Setup and Layout Screens are almost the same, except that 
Setup is used before any notes or other objects are put in the 
score, so many tools for working on Parts and their notes in the 
Layout Screen are not available in Setup. On the other hand, only 
Setup can define the initial Time and Key signatures. We'll 
describe them both together. 
  
 The screen is divided into two sections. The left two-thirds 
displays the current setup, and some of its objects can be dragged 
with the mouse. On the right is the Menu, with with a button sub-
menu and boxes of tool and object icons. Objects include seven 
styles of clefs and four types of parts. These part icons look 
like notes, but they aren't what they seem. Tools include the 
delete "X" in its own box, plus several buttons on the submenu. 
  
 The first few columns of the display side show the staves, their 
clefs, and time and key signatures exactly as they appear on the 
actual music score screen. The labeled top and bottom borders are 
the same thickness as on the score, and their labels show what 
goes in each column. 
  
 STAVES AND CLEFS 
 Clefs represent staves. To add a staff, pick up one of the seven 
clef signs by clicking inside the bottom box in the Menu. The 
cursor becomes the chosen clef sign. Move it over to the leftmost 
column in the display side, position its height where you want it 
(not on top of a clef already there) and click. Umuse will redraw 
the display with the new clef and staff added. 
  
 If you lay the clef right over an existing staff's clef (give or 
take some up/down tolerance), no new staff is added but instead 
the existing staff's clef is changed to the new clef type. If you 
miss, drag the staves apart and delete the unwanted new one. 
  
 [Layout only]: When you change a staff's clef type, all notes in 
all parts already on that staff are shifted up or down in the 
score as needed to keep their note pitch values in the new clef. 



For example, Middle C is the first line above the Bass clef, but 
if you changed its staff to Treble clef, the same note would now 
display on the first line below the staff. 
  
 Be careful not to change clefs radically when the score already 
has notes on that staff. Notes shifted too far are rewritten back 
one or more octaves towards the center of the staff. 
  
 [Both]: To shift a staff's position up or down, first make sure 
the brush is clear (arrow cursor). Clear the brush by clicking 
anywhere in the Menu that isn't over an icon, or anywhere in the 
Display beyond the last Part defined ("no man's land"). Then place 
the cleared cursor over the staff's clef, anywhere within the 
staff lines, and drag it up or down. Release at the desired 
position. You can do this directly on the Score Screen too. 
  
 To delete a staff, pick up the X-out tool and click it over the 
clef. Umuse3 will reject this if there are any parts still 
assigned to that staff; first delete or move the parts to other 
staves.  
  
 PARTS 
 Most of the display side covers the 16 columns for the Parts. 
Each part has its own column. Parts are numbered 1-9 and then A-G, 
or Hex extended by one extra letter. This single-character 
notation saves hitting ENTERs in some other menus. A thick gray 
vertical line marks off the right border of the highest-numbered 
part you can add, which is one higher than the highest-numbered 
part already defined. The remaining part-column area is called "no 
man's land" and is useless -- except for clearing the Brush.  
  
 Part numbers are strictly for your and Umuse3's reference, and 
have nothing to do with their pitch ranges. You don't need them in 
the mouse-driven Setup and Layout Menus, but you use them in the 
MIDI Menu.  
  
 Parts are added, moved, and deleted much like Staves and Clefs. 
Each part is represented by a Note object in its column on one 
staff (one only). That note's position on the staff shows whether 
the part is displayed as Upper, Middle, or Lower (see "Parts and 
Staves") and its stem points accordingly. Middle parts show stems 
both ways. 
  
 Delete a part by clicking the X cursor over its "note." In Layout 
you'll be destroying real notes and rests, so Umuse3 asks you to 
confirm. Both menus bubble down any higher-numbered parts, 
decreasing their numbers by 1, and adjust the MIDI Menu tables to 



keep up. 
  
 To move a part to a different position (one of 3) on its staff, 
or to any position on another staff, clear the Brush and drag its 
"note" up or down. Release it over the desired position on the 
desired staff. Again (Layout only), if the new staff has a 
different Clef than where the part came from, some of its notes 
may be shifted an octave up or down.  
  
 Changing a part's other characteristics requires picking up one 
of the four part "note" types from the Parts Palette. The note 
values (8th thru Whole) have nothing to do with the values of real 
Score notes in these parts, but have special meanings in the Setup 
and Layout screens.  
  
 Usually you'll stick with the leftmost type, the 8th note with a 
black body, stem, and flag tail -- this is a normal, regular part.  
  
 PERCUSSION: "Notes" with hollow bodies represent Percussion 
parts. Many synths assign one "note pitch" to the bass drum, 
another to the snare drum, etc. Real notes in parts designated as 
Percussion will not be shifted up or down in playing pitch by the 
MIDI Transposer (MIDI Menu), which normally adds an offset to each 
note's MIDI pitch number sent to the synth. Thus you can play your 
piece in different keys without your cymbal crashes turning into 
cowbells and your toms into bird tweets.  
  
 HOWEVER -- PLEASE use the newer Percussion Clef, the two vertical 
lines, for such parts. Not only does this clef protect all parts 
on its staff from transposition, but it is used with a special 
Instruments sub-menu to make it easy to transfer percussion parts 
between different makes and models of synths (see Advanced 
Topics). For example, on the Percussion Clef the bottom space is 
always Bass Drum on any synthesizer. The "hollow" notes are 
obsolete and kept in UltiMusE only to allow working with older 
scores.  
  
 CLONE NOTES (NO FLAGS): The palette includes "Clones" of both 
regular and percussion notes with and without stem flags. Leaving 
the flags off just controls how that part's notes are displayed in 
the Score screen. If a part is designated "no flags" (regular 
"quarter" icon, percussion "whole"), then all note values that 
should have flag tails (8th thru 64th) will show stems but no 
flags, and look like quarter notes in the score.  
  
 This is used to make chords of notes more readable on a staff. If 
you put two stem-up 8th notes on a staff, on two adjacent staff 



lines, the two flags' tails will combine to look like a 16th note. 
A three-note chord will look even worse. So, if you will have 2-4 
parts on one staff making up chords, where each part's notes are 
always the same duration as the others', make sure to give one 
part's notes all the highest pitches (or lowest, if stems down). 
There are new Umuse functions to help with this, explained later. 
Your chords will now look much more professional. You can still 
mouse on notes as usual. 
  
 Back to the Palette. You can pick up one of these four 
combinations of the two characteristics (Percussion and Flagless 
Clone) and lay it over an existing part's "note" to change its 
type. You can't add it anywhere else in an existing part's column. 
There is no danger of permanently messing up a part by changing 
its type; just change it back. 
  
 But when you change a part to/from a Clone (hiding/showing 
flags), you'll be asked whether to delete or restore all of that 
part's Rests. Modern Clone parts have no rests, just missing gaps 
in time between notes. When in doubt, say 'n'. Restoring rests to 
a de-cloned part is done by Refill (below) and Fixup (see Block 
Menu). 
 
  
 NEW PART: To add a new part, click one of those four "note" types 
in the empty column just left of the gray border, over the desired 
position on a staff. The gray border will move over one part 
unless all 16 are in use. 
  
 Unlike the Prompts, the Setup and Layout screens let you put more 
than three parts on a staff, and more than one in the same 
position of the same staff. Also the Prompts don't cover 
percussion and clones' hidden flags.  
  
 TOOLS and COMMANDS 
 The remaining tools and actions are on the pushbutton sub-menu in 
the top half of the menu side. You can punch buttons with any 
cursor on the Brush, but your aim is better with just the 
"cleared" little arrow.  
  
 [Setup Only]: The Setup button box is smaller, but it alone 
includes the Time and Key Signature buttons. Punching one of these 
with the mouse (or typing 't' or 'k') brings up a text dialogue 
window.  
  
 Enter your initial Time Signature as two integers, N/S. Top 
number N tells how many beats per measure (bar); bottom S is the 



size of note to be considered a beat. When you emerge from the 
Setup Menu, your score will be initialized to a few bars, each 
with N Sth-rests per part. 
  
 But if N is a multiple of 3 and greater than 3, you'll get N/3 
rests, where each rest is twice the size S plus a Dot. Each dotted 
rest is worth three S-rests. Example: 6/8 gives two dotted quarter 
rests. This is standard music notation and easier to read as a 
timing grid.  
  
 Optionally you may enter an initial Key Signature to go at the 
very beginning of the score. You can add these later anywhere in 
the score from the Barline Menu. Likewise with Time Signatures, 
but you must give one initially so Umuse3 can fill the first few 
bars with rests. The Setup Menu won't let you exit until you give 
one or settle for the "common time" default of 4/4. 
  
 [Both]: Both menus have a "Staves..." button, which lets you 
renumber the staves from top to bottom and/or spread them equally. 
Spreading repositions all staves for equal vertical spacing, and 
is handy after you've added or deleted staves, or just want to 
start over with fine-tuning the placements. 
  
 Initially, staves and parts are numbered in the order you created 
them, minus any deletions. Staff numbers are just to the left of 
their Clefs. If you've rearranged the staves' order by dragging, 
and want ot keep that order, be sure to renumber them, especially 
before Spreading, or else they'll go back into the old numerical 
order. 
  
  
 You can also renumber the Parts so that all parts on one staff 
have consecutive numbers, and the Layout Menu will look a lot 
neater. You'll be asked whether to segregate Clone parts -- just 
say No until you study Clone Parts in Advanced Topics. Both Menus 
have a "Ready" or "Back To Score" button (type ENTER) that exits 
and takes you to the Score Screen for some real music editing. 
From the Setup Menu you will see a few bars full of rests at the 
beginning; from the Layout you'll return to wherever you were in 
the score, with any changes made visible.  
  
 [Layout Only]: You visit the Layout Menu whenever you want once 
there are some notes or at least rests in the score. These tools 
all work on Parts.  
  
 Clear Part ('c') deletes from the score all notes, rests, volume 
levels, and instruments relating to that part number. But the now-



invisible part is still "open" in memory and can be re-filled. 
Clear usually operates only between bracket markers [], but will 
assume beginning and end of the score if either is missing, after 
asking you about this. 
  
 Remember the X-out tool deletes (forgets) a Part completely, and 
down- numbers any higher-numbered parts. Sometimes just Clearing a 
part is a handy alternative. 
  
 Tacetize Part ('t') makes tacet "measures-out" within the marker 
[] range. Less destructive than 'c', Tacetize modifies only whole 
measures (between barlines) where that part has no Notes, just 
Rests and expression objects. The rests are deleted, but any 
instruments or volumes remain (these may look funny "floating" 
inside empty measures). Unlike 'c', 't' can be used to clean up a 
finished score where some parts go for many measures without 
playing. This looks more professional, and reclaims precious 
memory! Good practice is not to tacetize the first bar of a piece, 
so all parts remain visible at the beginning.  
  
 ReFill Part ('f') is the opposite of 't' and refills with Rests 
any measures that contain nothing of the given part. The bars are 
refilled with as few rests as possible, meaning big ones. A 4/4 
bar would refill with one Whole rest, not the 4 Quarter rests 
initially supplied. If you don't want any blank parts in any bars 
of a finished score, it will look more professional if you 
Tacetize all parts anyway but then Refill them. This saves memory 
(as when one Whole rest replaces 4 quarters) but still lets you 
add notes in those bars later. 't' and 'r' work well together, 
along with the Block Menu's "Fixup". Refilling and fixing-up Clone 
parts should normally not be chosen when you are asked. 
  
 The Octave Transposers ('+' and '-') will move all the notes of a 
part (within the [markers]) up or down one octave (12 semitones). 
Unlike the MIDI-Menu's play-time transposing, these actions really 
do change that part's note in the score. Any notes that would be 
moved out of range are left unchanged. As long as no unchanged 
notes occur, '+' and '-' can "undo" each other. It's easy to move 
lead parts and bass lines up or down to find the best sound on 
different synth patches and bring out lead parts. 
  
 SUMMARY: Both the Setup and the Layout Menus let you add, delete, 
change, move and re-assign parts and staves. The Layout tools let 
you control memory usage without radical surgery and keep your 
score editable and professional looking. Consider using temporary 
layouts to input and edit a piece and finally converting to a 
better looking format. It's better to finish writing a new part on 



a less crowded staff and move it to its final staff when finished. 
 
 
 The BAR-LINE Menu 
  
 This menu is reached in an unusual way, by clicking on a score 
BarLine while the Brush is a note or rest (arrow cursor). Here you 
can either change the type of an existing barline, or insert 
certain items that only make sense next to a barline. 
  
 (To insert a new barline into the score, get the Toolbox icon 
that looks like a double bar, and click it on a note/rest that you 
want to insert the barline ahead of. Use the 'X' Brush to delete a 
barline.) 
  
 Most of the Barline items are standard musical "Go-To's" that 
change the usual left-right flow of play. Support for these 
standard symbols is a major advantage of UltiMusE for both the 
expert musician and the beginner just copying sheet music, and 
reduces wasteful duplication of sections. 
  
 Most Barline Menu commands can be typed without the SHIFT key. 
Just hit 8 and 9 for ( and ), 4 for $, etc. Or just mouse-click 
them. 
  
 The first group of menu options changes barlines to double bars, 
repeats, 1st, 2nd, ..., Nth endings, and FINEs. The ':' lets you 
convert a barline to back-to-back repeats.  
  
 Double barlines are mostly just visual landmarks for you and the 
'G' command, but one must be used to terminate the last ending 
after 1st, 2nd, ..., Nth endings. Double barlines can't be used 
inside such endings. Tradition says to use a double barline when 
changing time or key signatures, and to begin a new musical 
section or idea. 
  
 The second group inserts DC, DS, Sign ($) and Coda labels, 
Spaces, or Time and Key Signatures. Except for $ and Signatures, 
these inserts go to the left of the existing barline, which 
remains. 
  
 'Space' is just visual punctuation for you, like before a Coda 
section, and has no musical meaning or effect. 
  
 'K' for Key Signature should be followed (no blank) by the number 
of Sharps, or a minus sign and number of Flats, and then ENTER. 
  



 '/' prompts for a Time Signature exactly as in the Setup Menu. 
  
 Repeats can be nested. |: |: |: stuff :| :| :| will play "stuff" 
8 times. More than 6 deep will blow the internal stack. In accord 
with sloppy but standard sheet music practice, a Left Repeat |: at 
the beginning of a piece can be left out. Repeats can be used 
inside an Nth ending, and repeated sections can contain multiple 
endings. Just make sure that one nests entirely inside the other. 
  
 DC means "Da Capo" or back to the beginning. DS means "Dal Segno" 
or back to the Sign, which must occur earlier in the score. These 
ask whether you want SR ("Senza Repitizione", without repeats).  
 
 Coda jumps and FINEs are recognized only after doing a DC or DS. 
Only one Coda jump and one later Coda label will be recognized. A 
FINE is really needed only inside the piece (to keep a DS or DC 
from repeating the whole thing), but it never hurts to put one at 
the very end as a visual reminder to you. UltiMusE will always 
stop playing if it runs off the end of the score. Using a DS or DC 
with no FINE or Coda in the score is a good way to play a piece 
over and over forever. 
  
 "Go-To" items (most of the above) should be kept in meaningful 
order. For example, repeats must be balanced. None of this gets 
checked until you play the score. If you get stuck in an infinite 
loop, hit BREAK or CTRL-C to get back to the menu. Like a computer 
program, a music score can have "buggy" wrong notes and unbalanced 
structure. But do use musical "gotos" to avoid inputting and 
storing the same music twice.  
 
 
 The FILES Menu 
 
 When you exit UltiMusE or read in another score, any editing 
you've done is lost unless you save it to disk. All file reading, 
writing, and saving uses the point-n-click FILES menu that saves 
typing file names after creation. Four types of "side information" 
tables can be saved and loaded independently of main score files. 
 
  
 SCORE FILES -- READING and WRITING 
  
 READ ('r') in the Files Menu loads in a score file that replaces 
everything in memory, so when it prompts for filename, hit ENTER 
if you change your mind. 
  
 When you hit READ, Umuse3 will open a window just big enough to 



show all Score files in the current data directory -- that is, all 
files ending in ".ume" (any mix of upper/lower case letters is 
OK). ALL SCORE FILES MUST END IN ".UME". But the ".ume" extent 
doesn't show in the list, and you never type it in. 
  
 Moving the mouse over a name highlights it in inverse video. 
Click on that name to read it in. You can also type a name into 
the small box at the bottom -- useful for a pathname to a file in 
another directory. Omit the ".ume" extent; Umuse3 adds it for you. 
Your Backspace (<-) and Line-Erase (SHIFT <-) keys work normally. 
Hit ENTER or click "(Read File)" to load the file. Clicking 
"(CANCEL)" or anywhere outside the big window returns you to the 
Files Menu without reading anything. So does hitting ENTER when 
the little box is blank.  
  
 WRITE ('w') writes your current score to a new name. Same window 
and list, with a difference. Clicking a name copies it into the 
box, but does no more until you hit ENTER or click "(Write File)", 
or bail out as above. Instead of overwriting an existing file, 
you'll usually type a new name into the box, while seeing the 
names already in use. Take time to type a meaningful name like 
"Back_In_the_USSR" instead of "baknussr", since you won't need to 
type it again later to read or delete it. 
 
 Want a new name that's like an old name except for a different 
version number or letters on the end? Then click that old name 
into the box, delete any unwanted end caracters with Backspace, 
then and add new final characters. Now hit ENTER or click Write. 
If nothing else, seeing all existing names when Writing shows what 
names are already in use.  
  
 WRITE checks whether the file already exists and makes sure you 
want to overwrite it. After writing, you have the option to keep 
this name as the current filename. 
  
 SAVE ('s') writes your current score and side info to the current 
filename with no window and no questions (unless Read_Only Mode is 
on; then you must confirm overwrite). If the current filename is 
still blank, it prompts you. Save early, save often! Especially 
before block deletes and moves.  
  
 Each score file has a "level" depending on the version of Umuse 
that last edited it. The middle digit of the Umuse version is the 
level, so 6.10.3 writes Level 10 scores. All lower-level scores 
can be read and used with no problems (except a bogus error 
message on old shareware scores). Just write the score back out 
('s' command) to update it to Level 4, after adding a Title screen 



if you like. Higher level scores may or may not read, display, and 
play right. Don't overwrite them, but Write to a new name. 
  
 Note: hitting just ENTER to any command's "filename" prompt will 
safely abort that operation.  
  
 READ-ONLY ('o') toggles the safety mode on/off, which merely asks 
you to confirm each Save (not Write). Keep 'o' on when just 
browsing. 
  
 KILL ('k') deletes the selected file. Like Write, it waits until 
you click "Kill file" or hit ENTER. 
  
 DIR ('d') opens the window and lists only those files that DON'T 
have the ".ume" extent. Good for finding subdirectories, and all 
the side-info files at once. You can't read or write, just return 
when ready. Future version may let you click a directory to CHD to 
it. 
  
  
 INSTRS, ETC. ('i') -- SIDE-INFO FILES: 
 
 These are data tables in the Score that can also be saved and 
loaded separately to customize a score for different equipment 
setups or tastes. Umuse handles four types, given with their 
.extents: 
  
 .ume Full score file 
 .ins Instrument Menu names & patch numbers 
 .per Percussion slot MIDI notes numbers and Synth name 
 .mid MIDI Part --> Channel assignments 
 .lev Volume Levels MIDI velocities for ppp - fff 
  
 Use "Instrs etc." to get a new sub-menu with a slide selector for 
the four side-info types and three buttons for Read, Write, and 
Dir. From here, everything works just as for Score files, except 
the selected extension replaces ".ume". Instrument files will all 
end in ".ins".  
 
 The .ins and .per files can also be handled from their own menus, 
with the same handy window interface.  
 
 NEW SCORE ('n') clears score memory and starts you on a new 
score, deciding how many parts on what staff with which clef and 
so on. It does not affect the Instrument Table or MIDI Volume 
Levels. 
  



 FILE NAME ('f') reminds you what the filename is and lets you 
change it. Hit ENTER to keep it as is (just looking). Filenames 
must not exceed 28 characters. 
  
 TITLE ('t') lets you view and edit the Title Banner of 
information lines. For human consumption only, these are handy for 
the piece's title, band, composer, who moused it in, suggestions 
for playing, recommended synth setup, and Copyright notices. The 
Title submenu shows how many lines you can use and how wide they 
are. To replace a line, type its number and then retype the whole 
line. ENTER when finished.  
  
 PWD ('p') shows the present working dir, then flows to CHD below. 
Use CHD when you know the PWD, to save time. 
  
 CHD ('c' or 'h') lets you change the working directory. You can 
use full absolute or relative path names in filenames, but these 
are a pain to type and rapidly blow the 28-character limit. So use 
'c' to get into a directory where you'll be working. Note that 
using the OS9 shell escape (Random Menu '9') to "CHD" will not 
work. Give 'c' a pathname relative to Umuse3's present working 
directory, which is either where you started Umuse3 or the result 
of your previous 'c' command. Use absolute paths (starting with 
/d0, /dd or /h0, etc.) if you lose track. 
  
 APPEND ('a') is an Advanced command to splice a disk file score 
onto the end of the score currently in memory. 
 
 
 The MIDI Menu -- PLAYING MUSIC 
 
 PLAYING MUSIC 
 You can play either the whole piece from the beginning ('p'), or 
from the start of your viewscreen ('w'), or just the marked block 
between [ and ] from the Block Menu ('p'). These also work from 
the MIDI Menu. 
  
 While playing music, you can press the SHIFT key to "shift into" 
Fast Forward -- the music plays twice as fast until you release 
the key. Handy to skip thru parts you know are right and you're 
sick of; also helps you hear the overall form of a piece. 
  
 Press CTRL to "control yourself" for the opposite effect, slow-
motion playback. This is handy for finding bugs in your score, and 
you're ready to pounce on the 'C' key for CTRL-C to stop play when 
you hear the error. Note: SHIFT-BREAK is the same as CTRL-C. 
 



 To stop play before the end, hit BREAK to stop, or CTRL-C to stop 
and move the view screen to where the music stopped. Your synth 
should stop sounding notes after the current chord releases. 
  
 Hitting BREAK at any time other than playing gets you the QUIT 
prompt, just like typing 'q' to the Random or Files Menu. "Just 
Say No" to return to where you were. If you say 'y' you get one 
last chance to save your score file. UltiMusE is pretty well 
"break-proofed". 
  
 THE MIDI MENU 
 This menu lets you control aspects of actual synthesizer playing 
that are not covered in the score. Enter here to adjust parameters 
like speed, transposing pitch, output ports (hardware Pak or 
serial cable), MIDI channel assignments, and volume levels for pp, 
mf, etc. Channels are handled by the main MIDI Menu, the rest by 
two sub-menus -- Modes and Levels, but we'll cover the main MIDI 
first. 
  
 MIDI CHANNELS 
 The MIDI standard allows notes, patch changes, and other commands 
to be encoded into any of 16 logical channels. The upper half of 
the MIDI Menu shows the current assignment of UltiMusE parts to 
these channels. (It's just a coincidence that there are 16 of 
both, and also 16 patches.)  
  
 If you have just one, monotimbral synth (all notes play the same 
patch), these channels are of less use to you, and the startup 
default (all parts assigned to Channel 1) is fine. Just set your 
synth to receive channel 1 or put it in "Omni mode," where it 
"listens" to all 16 channels equally.  
  
 Polytimbral synths, which can play different patches or 
instruments on separate MIDI channels, open up a whole world of 
orchestration and arranging and are well worth the money for 
computer-driven synthesis. 
  
 ASSIGNING MIDI CHANNELS 
 There are several ways to set up Part-->MIDI Channel assignments. 
Most direct is to just type or click on a Part number, where Parts 
are "numbered" as in the Setup/Layout screen -- from 1 thru 9 and 
A thru G. The letters mean 10 thru 16, but our single-digit Hex 
notation means you needn't hit ENTER. Typing a number prompts you 
with a --> to type the channel number. These are written 1 thru 16 
and yes, you must hit ENTER.  
  
 To set a group of parts to the same channel (like all the rhythm 



guitar chord notes), type 'o' as in "Omni." Give the common 
channel number and hit ENTER. Then type the lowest and highest 
part numbers of the group; these and all in between get set to 
that channel. Hit ENTER for the lowest part to set all 16 parts to 
that channel.  
  
 The 'i' "Individual" option assigns each part to the channel with 
the same number. Great starting point for polytimbral. 
  
 You can make mistakes and mess this up. If so, type 'n' (Never 
Mind) to exit with no assignment changes. Or 'r' to restore them 
to whatever they were when you entered the MIDI Menu or last hit 
'u. 'u' means Update and lets you save your changes whenever 
you're sure of them so far. Hitting ENTER or 'k' for Keep makes 
your changes "stick" and leaves the MIDI Menu. 
 
 Channel assignments get saved and loaded to disk files along with 
the scores. Unlike Instrument tables, they can't be filed 
separately (yet). 
  
 Turning certain parts or channels on or off is useful for 
checking accompaniment parts or finding mistakes. To turn a 
certain part off, type or click its number as if assigning a new 
channel, but instead of a channel number, type '-'. To turn it 
back on, use '+'.  
  
 To turn a channel on or off, reverse the above -- type (or click) 
the '-' or '+' first, then the channel number. Watch the +/- signs 
change in the Menu table.  
  
 "Tutti" turns everything back on, and "Quiet" turns all off.  
  
 'p' and 'w' play just as from the Random Menu.  
 
 
 The MIDI MODES Sub-Menu 
  
 Most important is the choice of output ports: the Coco-MIDI plug-
in hardware pack ('m'), the Coco's own serial port out the back 
('r'), or a user- supplied /MIDI device driver ('/' or 'm'). Both 
Serial and the Pak may be on at once, but not the Pak and /MIDI. 
The same MIDI data come out of each port, but if you connect a 
different synth to each port you can turn them off and on 
separately. Use the Pak if you have one, with Serial turned off. 
CAUTION: enabling Pak mode without a Pak installed can hang 
Umuse3. 
  



 MIDI FILE ('f') turns off all outputs and directs the MIDI bytes 
to a disk file with extra timing bytes according to the Standard 
MIDI File Format. This file can be played on PCs, Macs, and other 
computers with MIDI player utilities. Its default name is your 
score name with extension .MID instead of .UME, but you can change 
it at the prompt. Please upload your .MID files to bulletin boards 
and Web sites, and not just Coco ones! 
  
 dxi speed factor 
 Type 's' to scale the overall speed of the piece. This time-
scale-factor is called "seconds per minute" and works backwards -- 
big numbers go slower. True tempo values in the score are still 
respected, but are scaled faster or slower in playback without 
changing the score. Although the scale factor does not appear on 
the score, it is saved and reloaded with the file.  
  
 To transpose the playing pitch, type 't' followed by a number of 
semitones; by +12 to play an octave higher, -12 an octave lower, 
or other values for different "keys." This affects only playing, 
not the score, but IS saved and reloaded with score files. 
Percussion parts (either type) are not transposed. 
  
 MIDI LEVELS SUB-MENU 
 Type 'l' to the MIDI Menu to enter this sub-menu and adjust the 
MIDI key-velocity values that correspond to the eight Expression 
Levels 'ppp' thru 'fff'. By setting 'ppp' to the softest part of 
your composition (even though it's really mp) and 'fff' to the 
loudest (though it's really just f), you can get the smoothest 
loudness changes out of the 8 levels. Some synths respond much 
more to changes in MIDI velocity than others, so use this feature 
to adapt others' scores to your equipment.  
  
 You can set each level separately, or save time with the 'e' 
command -- set ppp (Level 0) to the softest value you want, set 
fff (Level 7) to the loudest, then hit 'e'. Umuse3 will compute 
evenly spaced values for all levels 1 thru 6 (if you hit <ENTER> 
in answer to the next prompt) or for those levels between the two 
levels you type in answer to the prompt. 
  
 All values must be between 0 and 127, and will wrap around to 
stay in this range. Zero will not sound at all. You can even set 
the levels backwards -- if ppp is louder than fff, typing 'e' will 
fill in descending values! Use to check rhythm guitar or other 
background accompaniment parts. Your levels table is saved and 
read as part of the score file, or separately as a ".LEV" file 
from the Files Menu. 



 
 
 The INSTRUMENT Patches and PERCUSSION Menus 
  
 This Menu lets you edit the Instrument Table and the Percussion 
instruments in its sub-menu. To reach it from the score screen, 
click the Main Menu Bar or type 'i'. Instrument patch changes 
inserted in a part in the score (see "Special Palette Tools") will 
select a new synth sound-patch for that part. The score objects 
look like an "I" followed by a number from 0 to 15. These numbers 
are not sent via MIDI to the synth, but instead select a slot in 
the Instrument Table to get the patch-number value actually 
transmitted.  
  
 Each table entry lists its Patch Number to send, plus a 9-
character name. To edit an entry, highlight it with the mouse and 
click, or type its number -- if 0 or 1, you must also hit ENTER.  
  
 The patch numbers are either Decimal 1-128, or in Korg format, a 
funny Octal (base 8) notation where each digit can be 1 thru 8. 
You enter names in Korg format by starting the number with a 0 or 
small letter 'o'; otherwise you get normal decimal. Don't use 0 or 
9 in a Korg format number. 
  
 If your synth is not polytimbral, each change will affect all 
parts together. Even on a polytimbral machine, if two or more 
parts share one MIDI channel, any instrument change sent by one of 
these parts will affect the others. You can't program new patches 
from scores, just select among patches already in the synth. (But 
in OS9 you can run a patch librarian in another window and zap 
your synth!) 
  
 The Instrument Table is saved and loaded with each score file, 
and can also be saved/loaded independently from either the 
Instruments or Files Menus as a .INS file. Likewise for the 
Percussion Table, as a .PER file. 
  
 Your patch names are unrestricted and for human reference only, 
but if a name starts with a '+' (or '-') that patch will play an 
octave higher (or lower) than written in the score. This feature 
not only lets you equalize 16' and 4' patches across your 
synth(s), but also is an alternative to octave-transposing a voice 
up or down in the score (Layout Menu), especially if some notes 
would go out of range of their staff. A good substitute until we 
get +8va, -8va, and Loco score objects.  
 
 You can even play a part once thru a repeated section, then play 



it up or down an octave the second time thru. Just list the same 
patch under more than one table I-number, with and without the 
leading '+' or '-'.  
  
 Example: 
 0 17 FuzzBass 
 1 17 -FuzzBass 
 2 17 +FuzzBass 
 3 ..... (rest of table) 
 All are patch #17 on your synth, but I1 will play an octave below 
I0, and I2 an octave above. This works for each individual part 
whether or not the synth is polytimbral. 
 
 THE PERCUSSION CLEF and STAVES 
 A major innovation of UltiMusE is the Percussion Clef, which 
assigns each line and space of its staff to a known percussion 
instrument (snare drum, ride cymbal, etc.) regardless of what make 
or model synthesizer is used. Any synth model can be matched to 
the Perc Staff by a separate data table similar to the Instruments 
Patch Number table. Percussion Clef and table files do for 
percussion sounds what the Instrement Menu and files do for other 
instruments. Also Perc Clef notes can't get sharpened or flattened 
by melody parts on other staves during Play. 
  
 So when you download a score arranged for PSS-480 percussion, you 
don't have to change every percussion part's notes to match your 
MT-240 or MT-32 (although the Note Translator tool makes that 
feasible). Instead, if the score was created using Percussion 
Clefs, you simply load your MT32.per file instead of the 
PSS480.per data that came with the score. All UltiMousers are 
asked to please use Percussion Clefs for all new music files! 
  
 The Percussion Clef defines 17 slots in its staff -- 5 lines and 
4 spaces, plus two ledger lines and space on top and bottom. Each 
line and space should be used only to play its type of instrument. 
After much agonizing soul, jazz and rock searching, we have 
assigned the slots as follows: 
  
 LINE/SPACE SOUND 
  ------- Triangle Open 
          Triangle Muted 
  ------- Crash Cymbal 
          HiHat Open 
 |------- HiHat Closed 
 |        Ride Cymbal 
 |------- Rim Shot 
 |        Snare 



 |------- High Tom 
 |        Mid Tom 
 |------- Low Tom 
 |        Bass Drum 
 |------- Wood Block 
          Cow Bell 
  ------- Hand Clap 
          High Bongo 
  ------- Low Bongo 
 
 This covers the most important sounds and assigns them to the 
inner staff. Odd sounds are farther out on the ledger lines. You 
might re-assign some of those to other sounds for a certain piece, 
but please note that in the Title screen for your own sake and 
others'. Latin or Rap devotees may want to get together and work 
out an alternative standard. Just tell us what it is.  
  
 PERCUSSION TABLES 
 To set up a Percussion Table for your synth, enter the 
Instruments Menu and hit 'p'. You'll get a sub-menu like the list 
above, but with a MIDI note number (initially zero) before each 
sound name. To select a name to edit, you must use the mouse. Move 
the arrow cursor to blacken the selected name and click. Now enter 
its MIDI note number in Decimal, which you must get from your 
synth's manual or by counting keys from Middle C, which is 60. If 
you hit the wrong line, just type ENTER to leave it as is.  
  
 At the bottom is the synth make and model name. Click to retype 
it, or hit ENTER to leave it. It gets saved and reloaded along 
with the 17 MIDI note values. At any time you can save your table 
by clicking "Write to File" or typing 'w'. You can read an 
existing Perc file and replace your memory data, or just clear it 
to zeros. Perc tables can also be saved and loaded from the new 
integrated Files Menu. Either way, they always have ".per" 
extension.  
  
 Make a Perc table once for each of your synths, save it, and just 
reload it each time you create a new piece. The table and synth 
name are also saved and loaded as part of the score.  
  
 SCORING with PERCUSSION STAVES 
 The Layout Menu now includes Percussion as a 5th clef, shown as 
two vertical lines. Set up any number of staves with it just like 
any other Clef. One special rule: When you move a part from one 
staff to another, or change the clef on a staff, notes are 
automatically transposed to keep the pitches the same. But since a 
Perc Clef has no actual pitches, NO translation is done when 



moving into or out of a Perc-Clef staff. The lines and spaces just 
stay the same. So do accidentals, although these are IGNORED on a 
Perc Staff during Play. That includes "accidental" accidentals 
that "bleed thru" from other parts, a headache that stays away 
when you use the new Perc Clef. 
  
 There's no need to use the old Percussion part types (hollow 
notes in Layout Menu) on a Perc Staff. Their only function was to 
protect percussion MIDI pitches from the MIDI-Mode Transposer, 
which does not affect Perc Clefs either.  
 
 
 The BLOCK-MARKERS Menu 
  
 Reached from the Score Screen's Main Menu Bar, this menu performs 
edits and other operations on "blocks" of score between Marker 
brackets that you've inserted (see "Special Palette Tools"). If 
needed markers are missing, you get an error or are asked whether 
to assume beginning and end of the score, or maybe just what's on 
the screen. 
 
 Delete takes out absolutely everything (but clefs and staves) 
between the [ ] markers, including the markers themselves.  
  
 Move and Copy require [ ], plus a | to whose right side the 
bracketed block will be moved or copied. The | can't be inside the 
marked block. Copy leaves the [ ] where they were, but Move brings 
them along with the moved block.  
  
 Block-Playing changes nothing; it just plays the score, but you 
hear it only when the music is between the [ ] markers. Notes 
outside the markers are skipped in zero time. If the block is 
inside a repeated section, it plays as many times as it would in a 
full play. If the instruments or volume levels are supposed to be 
different on the 2nd or 3rd time thru, you can quickly audition 
the differences. 
  
 You can insert a plain BarLine or a Coda Jump at the |, no [] 
needed for this. The Coda Jump looks just like the Coda Label that 
occurs later in the score, but the Label can be inserted only at a 
Barline.  
  
 Barlines are much easier to add with the || tool. Then use the 
Brush cursor on the Score to get the Barline Menu and change the 
plain barline to a special barline, or add barline-related 
objects.  
  



 "Fixup" repairs, in the Part you specify, minor errors left over 
in older scores, like long notes straddling a barline or missing 
rests leaving "holes" in time. 
  
 "Transpose" rewrites all or the marked-off portion of the score 
to a new key. It's covered in the Advanced manual, but is simple 
to use. 
 
 
 The SEARCH-GOTO Menu 
  
 The Search-Goto Menu helps you find places in the score by 
locating certain kinds of score objects and moving the view screen 
to them. This "menu" is really just a list of reminders for a 
couple of commands' arguments, but they're so powerful they need 
their own chapter. 
  
 You may click the GOTO on the Main Menu Bar, but it's quickest to 
just type 'g' or 'G' followed by the search-target arguments and a 
required ENTER. A text window pops over part of the Score Screen 
so you can see your typing, but the whole menu of choices doesn't 
display unless you type "g?"; then you can enter the real 
arguments. 
  
 The simplest 'g' command just goes to a given Barline by number. 
"g14" (note NO spaces!) puts barline #14 at your left edge. 
Preceed the number by + or - to mean "relative to present bar on 
screen," so "g+5" means "move ahead 5 bars" and "g-10" means "go 
back 10 bars." "g0" gets you the beginning, and "g*" or any number 
greater than the number of bars in your score gets you the end.  
  
 If you've done a Block Copy and haven't renumbered yet, there may 
be two bars with the same number; 'g' always finds the first. If 
you Deleted a block or X'ed out the only bar so numbered, you'll 
get "None Found" and the view won't move. 
  
 Using 'G' (a rare capital-letter command in Umuse) restricts the 
search to "Special" Barlines (doubles, repeats, endings, and 
others on the first half of the Barline Menu). These landmarks are 
very handy in finding the next section of a piece. Unlike small 
'g', 'G' ignores the displayed bar numbers and counts the special 
bars (after all, if you knew the number you'd just use 'g'). So 
"G3" means "find the 3rd special barline from the beginning," and 
"G+1" means "find the next special." So does "G+" -- keep reading. 
  
 UNIVERSAL SEARCH COMMANDS 
 The 'g' command's arguments can be given to search for almost 



anything of interest. The general format is: 
  
 g SIGN NUMBER WHAT <ENTER> 
  
 where there are no spaces between the arguments and all arguments 
are optional in any combination. Omitting WHAT gives the barline 
finding commands, and using capital 'G' instead of 'g' finds only 
special barlines. SIGN is + or - meaning "count from current 
screen, forward or reverse." No sign gives an absolute search from 
the beginning of score. If NUMBER is omitted it defaults to 1, not 
0. So "G+" means "G+1" or "find next special barline" and "G-" 
means "preceding." 
  
 WHAT is a single character telling what to look for other than a 
barline, as follows. If the table shows two characters you can use 
either one (not both at once). Unlike some other UltiMusE menus, 
you must use the shift or CTRL key to get the actual character, 
since numerals would be taken as the NUMBER arg. 
  
 [( Left Marker (either '(' or '[' will do) 
 ]) Right Marker 
 |! To (Center) Marker 
 * End of score 
 . Return to scene of last 'g' command 
 space Repeat last 'g' command text 
 ? Just print the menu of possible commands 
  
 All the above ignore SIGN and NUMBER, but the rest can be used 
with any combination of SIGN and NUMBER: 
 lv Level or Volume (mf, pp, fff, etc) 
 i Instrument 
 t Tempo 
 x^' any expression (Level, Instrument, or Tempo) 
 k Key signature 
 / Time signature 
 en any Nth Ending 
 f Fine. 
 s$ Segno sign 
 o Coda sign 
  
 Two special formats are "g." and "g ". The first (dot) means to 
return to wherever you gave the last 'g' command. The second 
(space) means "repeat the last 'g' command as typed before." So 
you can type "g+x" once and then step thru the expression marks by 
typing just "g " over and over. 
  
 Some special cases: "g" gets Bar #1, which is the beginning IF 



the first bar is not a short "pickup" measure; "g0" guarantees the 
beginning, and "g*" the end. "g+0 WHAT" jams the leftmost 
currently visible WHAT against the left screen edge, and 
substituting '-' right-justifies the rightmost. Handy to view a 
whole long measure. 
  
 See the Advanced manual for finding exact Parts, Instruments, 
etc. 
  
 Relative (signed) searches read the screen intelligently. Saying 
"g+" to find the next bar means "the next barline NOT SHOWING ON 
THE SCREEN." So if barlines 3, 4, and 5 are visible when you type 
"g+", the new screen will show bar 6 at its left edge. Likewise 
"g-" there would put barline 2 near the right edge. This applies 
to anything else you search for, such as Instruments with "g+i", 
so be sure to look the screen over carefully for targets before 
repeating a relative 'g' command. And if a "g+i" fails to move the 
screen, it means there are no more Instruments beyond there. 
  
 Positioning: absolute (unsigned) and '+' searches reposition your 
view to show their target at the left screen edge. '-' searches 
show their result near the right edge. Markers [ and ] show near 
their edges and the | marker goes smack in the middle. 
 
 
 HINTS and HELPS 
  
 FREE REPEAT and BARLINE #0 
 To support a questionable but standard sheet music practice, 
Umuse3's player spots you a free Left_Repeat at the beginning of 
the score. You can't see it, but a right repeat will find it. You 
can convert the opening barline #0 (far left of screen) to other 
types of barlines, but it always displays as a plain single 
barline. If you insert your own "real" Barline #0, it will display 
as whatever you make it, and be easier to hit with the mouse. 
  
 MULTIPLE REPEATS 
 Pop music often calls for a section to be repeated 4X or some 
other factor besides 2. You can get any power of 2 repeats by 
nesting balanced repeats; 
 |: |: |: stuff :| :| :| 
 will play "stuff" 8 times. For odd values, try using 1st, 2nd, 
3rd endings where the endings contain no notes or rests; use | and 
"bb" to insert several adjacent barlines and convert them to the 
special ending barlines. 
  
 LEVELS and INSTRUMENTS in REPEATED SECTIONS 



 Sometimes you want a section to repeat with the same volume 
levels and instruments as the first time, even though they may 
have been changed partway thru the repeated section. If so, the 
levels and instruments objects at the start of that section should 
be "inside" it, to the RIGHT of the Left_Repeat barline. This is 
where "normal" Umuse3 usage will put them. 
  
 But suppose you want the section repeated on different 
instruments or levels. Then put the expression objects for the 
first time "outside" to the LEFT of the Left_Repeat barline, so 
when the section repeats they will be skipped. New levels and 
instruments for the second pass must be set up at the end of the 
section, just before the Right_Repeat or Second_Ending barline. 
Problem: what notes can you hook these on? Answer: on Rests at the 
end of the last measure. If a part has no rest, shorten its final 
note just a bit, say by a 16th or 32nd rest, and click the new 
level or instrument on that rest. Such rests usually make for 
cleaner music anyway. 
  
 Getting back to the beginning of the section, how can you control 
whether the expression signs go to left or right of the 
left_repeat barline? First just try and see where they go. If not 
what you want, use the Insert Marker '|' and turn it into a new 
barline ("bb" command) after getting it where you want, and X-out 
the original barline. Umuse3 has its own ideas of where to put 
things, but the Markers are the exception -- you can put them 
anywhere that does not slice notes or rests. 
  
 Try this: make a three-part staff, put a 3-note chord on it, and 
put level (say, ff) on each note. They'll display in a straight 
vertical column. Now get the | on the brush and try clicking the 
mouse on each of the ff's and each note. You'll find you can split 
the stack of ff's anywhere, with the | marker in between (works 
with [ and ] too). Now you can "bb" the | to a barline and use the 
Barline Menu to upgrade it to a Left_Repeat. 
  
 BLOCK-PLAY HINTS 
 To check or "practice" just a subsection of score, Block Play 
"bp" plays only the block between [ and ] markers. Nothing outside 
will play. But there is one exception -- if your ] is missing, or 
the last thing in the score, and the end repeats (repeat, DC, DS, 
etc.) to an earlier part of the score to the left of your block, 
the sound will keep playing. If not desired, put your ] to LEFT of 
the repeating object at the end, and the sound will turn back off 
until the score catches up with your block at the [. Once again, 
the exact ordering of special items is important! 
  



 FAKING OTHER MUSIC NOTATIONS 
 Umuse3 supports more notation items than the competition, but not 
everything. Tricks can be used to fake unsupported notations.  
  
 Breath marks or breaks, written as apostrophes, mean to cut off 
the preceding note early and finish its time with silence. Use our 
"marcato" (horizontal line) artic for this. Careful attention to 
articulation makes the difference between "studio sound" and "oh 
how cute, a computer playing music!" 
  
 For a fermata or hold over a chord, simply precede it with a very 
slow Tempo. After the chord, put the original tempo (or whatever 
you want). Experiment (using Window_Play and BREAK) with tempo 
values until you get the delay that sounds right to you. See score 
file SSB.UME.  
  
 +8va and -8va mean to play an octave higher or lower. If some 
part is so marked throughout the entire piece, use the Layout 
Menu's octave transpose tools. But if the part is octave-shifted 
only sometimes in the piece, use the trick given under 
"Instruments Menu." 
  
 ADDING BARS INSIDE A SCORE 
 To add bars inside a piece (like a new bridge between existing 
sections), go to the end of the piece with "g*" and click the 
Scroll Bar's arrow to add bars at the end as usual. Bracket the 
new measures with []. Now insert a | marker where you need the 
bars and use Block Move "bm." If the end of the song is in a 
different Time Signature from the section where you'll add the 
bars, then temporarily add the section's time signature to the end 
before creating the new bars. 
  
 MARKER HINTS 
 To get rid of any Markers []^ that may be lurking in the piece, 
just place new ones where you are and X them out. Remember there 
can be only one of each of the three kinds at a time, so adding 
the new ones removes the old. Since a 'g' command followed by '(', 
')', or '|' takes your viewport to a marker, use markers just to 
tag places you'll come back to later. 
  
 SCORING HINTS 
 When beginning a new score, don't just start off with the lead 
part without first taking a good overall look. Check for patterns 
of rhythm or bass lines that repeat over and over throughout the 
piece. If you find one, start by putting this pattern in once; 
then use Block-Copy and Part-Copy to "rubber stamp" it over and 
over to make the full length of the piece. Then adjust individual 



notes in each bar as needed. It's easier to tweak note pitches 
than than rhythms, and much easier than mousing in notes from 
scratch.  
  
 Some pieces have irregular time signatures -- a 4/4 bar here, 
next a 3/4, then a 6/4, etc. Don't put all these in except where 
the sheet music shows them. Just use the Barline_inserter || Tool 
to insert barlines and the X tool to delete them as needed.  
  
 TECHNICAL INFO 
 When playing several notes that start at the same time, UltiMusE 
sends the parts' MIDI commands in ascending order of part numbers. 
So higher numbers are more likely to be left unplayed by a synth, 
or "overflowed" by a Roland MT-32 to a downstream synth. "Running 
Status" is exploited to drop "note-on" bytes whenever a chord uses 
the same MIDI channel for all notes, another reason to use Clones. 
  
 UltiMusE quantizes notes internally to "ticks" scaled 2 to a 
triplet 64th note, 3 to a straight 64th, and 48 to a straight 
quarter.  
  
 I started working on UltiMusE in 1985. It is written entirely in 
MicroWare C, with just enough assembler for the serial port and 
some graphics. This manual was typeset with DynaStar, DynaForm, 
and DynaSpell. 
 
 
 COMPATIBILITY Among VERSIONS 
  
 Any version of UltiMusE-III will read, play, and edit score files 
made with any earlier version of ULtiMusE, including the ancient 
shareware copies. But really early versions will choke on pices 
with more than 4 or 5 staves.  
  
 Old versions may work on scores from newer versions -- the middle 
number is the key (4.6.4 means a Level 6 score) -- but will miss 
out on newer expressive features.  
  
 Never overwrite a score from a lower-level version of UltiMusE 
without first making a backup copy, or info in the newer score 
will be lost. 
 
 
 MAKING A SERIAL MIDI CABLE 
  
 If you don't have a hardware MIDI interface plug-in pack, you can 
make your own low-cost serial cable. You need two male connector 



"DIN" plugs. One has four prongs and will be used in your Coco's 
Serial I/O socket. Buy this connector at a Radio Shack store, or 
just hack a Coco printer/modem cable. 
  
 The other plug is similar but has 5 pins, and would fit the 
Coco's cassette port, though you'll plug it into your synth's 
"MIDI IN" jack. It is NOT the same as a joystick plug! These 
should be available at the Shack, as "stereo DIN Connectors". Best 
is to buy a complete official MIDI cable with these on each end at 
a music store, then cut off one end and replace it with the 4-pin 
Coco serial connector. 
  
 The cable should be as long as you need but no more. If you can't 
get a real MIDI cable, use microphone cable with two wires inside 
a shield. If you cut one end off an official MIDI cable, you 
already have good conductors. 
  
 Now, take the plugs apart and face their pins away from you so 
you're looking at their wiring sides. The pins are shown here as 
()'s. Wire them up like this: 
  
        5-pin Synth                                    4-pin CoCo 
           MIDI                                           SERIAL 
  (3)                 (1)                 /---------(4)            
(1) 
                            One wire     /        Transmit 
     (5)           (4)------------------/           Data 
      | 
      |     (2)     Other wire                       /--(3)     
(2) 
      \______________________________________________|  Ground 
         ____________________________________________/ 
      (DON'T connect Shield at Synth end)      Shield braid 
  
 The shield braid connects to the "Ground" pin 3 of the 4-pin plug 
along with one signal lead, but does not connect to anything at 
the 5-pin end.  
  
 WARNING: Using this Coco-III cable on a Coco 1 (or TDP-100 or 
Dragon) could damage your synth.  
 
 
 KNOWN BUGS and MISFEATURES 
  
 By reading this far, you've already spoiled half the adventure of 
a new program, so we might as well give away a few bugs too. 
 



 Accidentals stay in force thru the remainder of their measure 
until the next barline, as they're supposed to in sheet music. 
However, each should affect only its own staff. Currently, an 
accidental will also affect the same note pitch on all other 
staves as well, even if on a different line or space using a 
different clef. This can play some "blue" notes and confuse the 
obsolete "hollow" percussion parts. You can protect any afflicted 
notes by prefixing their own naturals or whatever is needed. We 
guarantee that any note with its own accidental will play as 
notated. 
  
 Sometimes OS9 doesn't set up the mouse hardware as specified in 
your Um3.Init file. So, type your way to Options and re-Read the 
options.  
  
 The "senza repitizione" option of Da Capo and Dal Segno 
suppresses ordinary repeats properly during the replay, but does 
not force multiple endings to take the last ending as it should. 
These will repeat just like the first time thru the section. 
  
 Notes that would display off the top or bottom of the score 
screen are not graphically clipped, but instead drawn complete 
just inside the screen. If the stems are pointing outward, a 
telltale track of ledger lines marching over the note's body may 
warn you that the note is not really where it appears to be. When 
in doubt, or when working on the top or bottom staff, pull that 
staff in enough to have some visual headroom for extreme notes. 
 
 
 TROUBLESHOOTING 
  
 We've tried to anticipate the most common problems, based on our 
own experience. Installation problems stay away once fixed. 
  
 On Startup: 
 Error #207 
 You need at least 128K free to load and run UltiMusE-III. 
 Error #216 
 Missing Play or Fran from present execution directory. 
 Error #214 
 Play and Fran's attributes 'p' and 'pe' must be set. 
 "xxx.img" errors 
 /DD/SYS non-existent or missing some .img files 
 Error #214 or #216 or "can't link" message 
 Missing some Um3x file from PXD, or "e pe" attributes not set. 
  
 Editing and Display: 



 No mouse response 
 Wrong Hi-Res adaptor mode; type "rr" to restart, 
 or "or" to restore Preferences from Um3.Init file. 
 Wrong joystick port. Hi-Res to Right, direct to Left. 
 Composite monitor picture is blurry 
 Do a MONTYPE M to OS-9 
 Only 4 sizes of notes available 
 You're still in the Setup/Layout Menu; hit ENTER. 
 Score is too thick, can't see straight 
 Move parts being edited to temporary working staff 
 Hide flags (Clone) of chord parts; Rearrange staves vertically. 
 Tacetize to get rid of unneeded rests 
 Notes too high or low, way off staff 
 Change clef 
 Use Layout's '+' or '-' to move them inward an octave, 
 then use prefix + or - to instrument names to transpose play. 
  
 Playing: 
 No sound 
 Wrong port enabled -- use MIDI Menu 
 Synth not manually switched to MIDI mode 
 Synth on wrong MIDI channel 
 Custom hardware MIDI pak -- use matching /MIDI driver 
 Music plays slowly or jerkily or locks up completely 
 MIDI Pak enabled (MIDI Modes Menu) but not installed 
 Shut down other OS9 tasks 
 Synth batteries or AC adapter weak 
 Poor quality or too long cable 
 BREAK or CTRL-C doesn't stop play 
 Wait for long chord to finish sounding. 
 Note tied to previous note plays anyway 
 Make sure Tie is on first note of pair 
 Music plays at "warp speed" 
 Add a proper Time Signature at very beginning 
 General: 
 Can't find score files 
 Use Files Menu 'd' and 'c' commands to get right directory. 
 Lost in menu tree 
 Hit ENTERs till you see the score screen. 
 Can't save or restore mode Preferences from Options Menu 
 A disk with a SYS directory must be in /DD drive 
 Out of score memory (all 32,767 items? I'm impressed!) 
 Tacetize parts to delete Rests 
 "Clone" parts to delete Rests 
 Join rests (e.g., quarter + eighth = dotted quarter) 
 Combine percussion parts -- let one "voice" play several sounds 
 Look for places to use Repeats, etc. 



  
 
 ADVANCED FEATURES 
  
 The rest of this manual covers UltiMusE capabilities that were 
developed after the original release. Many of the following 
sections belong with earlier menus, but we've kept them here so 
you could read the basic features of all menus without having to 
wade thru all the newer features.  
  
 You will understand and appreciate the advanced features more 
after understanding and working with the basics. But feel free to 
check these out as soon as possible, before inputting any major 
scores, since they'll save you lots of work.  
 
 >>>>> THE END <<<<< 
 
 
 Copyright (c) 1989, 1997 by Michael J Knudsen 
 



This extended portion of the docs gives a list of major new 
features and bug fixes by version, with dates when known. 
Last Update: by M.J.K. 97/4/17 
 
  For details, read these sections: 
Readme.Zer   Version 4.6.0 -- Major Improvements 
Readme.One   Installation and Versions 4.4.1 thru 4.7.2 
Readme.Two   Version 4.7.5 thru 4.9.0 
Readme.Tre   Versions 4.10.0 thru 4.10.0a and 10.10.1 
Readme.For   Versions 5.x.x and 11.x.x and above 
 
 
Bug & Feature History by Version: 
 
Version 10.11.4B (by Bill Pierce, 05/26/2014) 
(I put these here as the latest enhancements arenot list anywhere 
in the manual. I hope to write a new manual with all up to date 
info soon) 

• DriveWire4 MIDI Device Manager added. Only available when 
using the DriveWire4 File Server. Under “Midi”, hit ‘v’ and 
select your DW4 Midi device. 

• DriveWire4 MIDI Profile Manager. Only available with DW4. 
Select the keyboard emulation to match the score’s original 
synth. 

• DriveWire4 Internet Update. Only available with DW4. Update 
Ultimuse 3 from the internet update site straight from your 
Coco 3 and Ultimuse 3. DW4 server must have an active 
internet connection. 

• The external OS9 commands, Tmode & PWD, are no longerrequired 
for Ultimuse3. Umuse3 now has these routines internally to 
avoid “tmode bug” issues some people were having due to 
different versions od tmode with different sytax. 

• A new “Bell” sound has been added, replacing the annoying 
“OS9 tone” used before. Also, a “bell on/off” option has been 
added to the “Options” memu. This flag is saved with the 
“preferenced” and persists thereafter. 

• As the new “Caretaker” of Ultimuse 3, Mike’s masterpiece, I 
hope to be adding many more features in the future. Use the 
new DW4 internet updaterto keep a check for new versions :-) 

 
Version 4.4.1 (over 3.3.0 thru 3.4.1d) 

• 32,767 score objects (notes, etc.) 
• Menus mostly point and click 
• Instrument (Patch) Changes can be disabled from the MIDI Menu 

 
 
Version.450    December 03, 1989 



• General Volume Levels (Genvols)much 
• Ties now carry accidentals over barlines, as in written sheet 

music. 
• All Menus can be exited with a Mouse Click or ENTER. 
• MIDI "Volumaster" velocity level offset (master volume) 
• Menus are much more convenient with some New Items: 

o Slide Selectors choose one of several alternatives; 
o Check-Boxes that toggle and indicate on/off modes; 
o Fill-in-the-Blanks for variable quantities like 

Transpose. 
• MIDI "running status" reduces the data rate to your synths. 
• Umuse3 warns at startup if GrfDrv is not in memory or in 

CMDS. 
• Player handles /MIDI device as a Modes Option 
• Separate MIDI Modes options menu 

 
 
Version 4.6.0 -- MAJOR IMPROVEMENTS 
MAJOR: 

• Percussion Clefs to fit all Synthesizers 
• MIDI Clock for Drum Machines, etc. 
• Point-n-Shoot file load & store. 
• Separate Side-info files available. 
• Point-n-Click on some Text menus. 

General: 
• Parts can hop to different MIDI channels dynamically. 
• Notes no longer straddle Barlines. 
• Score cursors change to reflect current tool selected. 
• Brush cursor really looks like a brush for notes/rests. 
• Menu button shapes indicate function. 

Setup/Layout Menu: 
• Setup Prompts removed (restored in later versions!) 
• Rangefinder finds highest and lowest notes per Part. 

New Integrated Files Menu: 
• 5 file types -- Score, Instrs, Percussions, MIDI Chans, Vol 

Levels 
• Overwrite question gives file name 
• Point n shoot, with type & edit options. No .ext needed. 
• "fd" shows non-.ume files only 
• Also Save & Load directly from Instrument and Percussion 

Menus. 
Block-Edit Menu: 

• Fixup function cleans up barline overhangers & holes 
Score ToolBox: 

• Simplified toolbox on/off control -- menu bar, clicks. 
• Brush Rep can be viewed instantly under cursor. 

POWER TOOLS -- new lower deck: 



• Insert Barline 
• Chisel Smasher speeds up writing many notes 
• Part Copy stamps a pattern of notes anywhere 
• Join two adjacent note/rests into one 
• Squawker shows current instrument, volume, etc. 
• Note Translator, good for converting Percussion parts 

 
 
Version 4.6.2 

• Play handles "triplet" time signatures (6/8 etc.) right. 
• More Printer types supported: Gemini 10X and Epson 

compatibles. 
• Two big image files in /SYS replace /IMAGES's dozen .img 

files 
• Plug mouse or joystick into either port, with or without 

HiRes box. 
• Fast change-directory 
• Auto-sleeping of Umuse when in some other window 

 
 
Version 4.7.0 

• Note Articulations -- Stuccato, Marcato, Legato for crisper 
playing. 

• Continous Printing of Full Score 
• Automatic Crecendo and Diminuendo 
• MIDI Clock can be turned on and off within score anywhere 
• Improved Search Goto commands 
• Setup Prompts are back! 
• MIDI Transpose Value saved and read with score, used by 

Jukebox 
• Tied note before Tacetized or Cleared measure no longer keeps 

sounding 
 
 
Version 4.7.1 

• Can insert Barline that slicles notes/rests 
• Oil Spills bug gone for good! 
• Hardcopy dumps stopped by 'q', not BREAK. 

 
 
Version 4.7.2 

• Keys adjust note sizes and duration-mods 
 
 
Version 4.7.5      91/09/29 

• Transpose scores to new keys 
• Individual enable/disable of each Part and each MIDI Channel 



• User-set upper & lower limits on MIDI Note Numbers 
• Playing more accurate, never loses time 
• Tempos greater than 127 no longer show as Zero 
• Bell "beep" sounds correctly 
• No more Tied notes from nowhere 

 
 
Version 4.7.5B 

• Play no longer crashes 1-Meg systems. 
• Umuse3 now works with unmodified Shell+ 2.1. 
• Right edge of screen easier to click on with mouse 

 
 
Version 4.8.0:  (92/02/11) 

• Alto and Tenor Clefs added, for Viola, Cello and some 
Trombones WARNING: -- any Level 8 score (.ume) file using 
these clefs will not play properly on any earlier version of 
UltiMusE. YOU MUST UPDATE SYS/AllUm3.img file to use version 
4.8.0 and above. 

 
 
Version 4.9.0 and 10.9.0      93/4/29, from 9/92 

• MIDI Events -- send any desired byte sequence to your synths. 
• Hard Copy Printing added to MM/1 version (already in Coco) 
• All Menus now under Mouse Control -- less typing required. 
• New sub-menus for Expression volume levels, Instrs, etc. 
• < and > keys (Shifted) scroll Left & Right. 
• "Brush" note cursor calls up Barline or Expression menus 

 
 
Version 4.10.0 and 10.10.0 

• Append (Splice) two scores together -- at last! 
• Accents and Layoffs for easier volume expression 
• Letter Labels in Scores 
• Score Printing vertical squeezing can be turned off 
• Score Printing supports CGP-200 printer 
• Barline Menu gives mouse separate choices of Begin and End 

Repeats. 
• Cursor Snap (MM/1 only) 

 
 
Versions 4.10.0a (Coco) and 10.10.1 (MM/1) 

• Time Signature now defaults to 4/4 on startup instead of 0/0. 
• Draw lines to connect notes of each part (MM/1 only) 

 
 
Versions 4.10.2 and 10.10.2 



• Sort "chord" notes on a staff 
 
 
Versions 5.10.0 and 11.10.0   95/4/20 

• NEW VENDOR takes over from Kala Soft 
• Play can write output to Standard MIDI ( .MID) files! 
• Files Menu Improvements: 

o 3 columns show up to 78 files, vs 52 in 2 columns 
o Kill (delete) files from menu 
o File names are Sorted in menus 

 
 
Version 6.10.0      95/9/18 

• VDG Screen not needed anymore, even in Boot! 
 
 
Version 6.10.3 and 12.10.3      96/3/30 

• NEW VENDOR -- Glenside Coco Club 
• "Clone part" Chord Features: 

o + cursor pulls new notes out of old 
o Flagless notes now mean something in Layout Menu 
o MIDI channel assign by clone groups 
o part reorder 
o "Sort Notes" now "Parts", respects stems, clones 
o Note pitch carryover option 
o Part-copy transposes to fit target clef 
o L and R cmds to connect notes of same part 

• Smaller Toolbox with simpler mouse control 
• Finder-Filter for sorting out note/rest pileups 
• Cursor-snap option 
• Dialogue boxes pop where cursor is 
• Less drift of notes on redisplay 
• Fast -flash on note pickup 
• Bug fix re chip/bombing of notes 

 
 
Version 7.11.1 (same number 7 now used for MM/1 OSK) 97/2/25 

• SHAREWARE -- no Vendor 
• New "Basic" Manual doc, with "Advanced" planned 

o interim Advanced Manual is ReadMe.Zer thru ReadMe.For 
• Instruments (Patches) greatly improved: 

o 64 instruments, vs old 16 
o Names up to 15 characters, vs old 9 
o Menu tools to move and swap instrs around for quick 

changes 
o option for "sticky" tool cursors 
o Menus show which instrs are currently used in score 



o Menus scroll to show all 64 instruments 
• Titles Comment Box now up to 9 lines from old 4 
• Squawker "?" Tool shows Part affected by Partwise Expressors 
• MIDI Events don't waste memory on duplicate byte sequences No 
mouse-dirt on MM/1 startup screen 

 
 
Version 8.11.0  (Coco and MM/1)  97/4/12 

• BEAMS drawn to connect stems in groups 8th and smaller notes 
o adds another module, Um3B 

• Printer options for ForMfeeds and automatic forced margins 
• Leading Barline bug removed from Print 

 
 
At 7, OSK (MM/1) version numbers stopped adding 6 to corresponding 
CoCo version, and both went to 7.x.x. 
 
 
SUMMARY of SCORE LEVELS (Middle DIgit): 

• 8=Beta Clefs, 9=Events, 10=Accents, Labels; 
• 11==extra Instrs and Title lines 

 
MISC MINOR FEATURES & BUG FIXES 

• 4.9.1 for fixing 2 bugs and separate ( and ) 
• 4.10.1 for no ,Y opcodes 
• 4.10.2 for Partsort, Kill 
• 5.10.0 SMF .MID files, North eX 
• 5.10.1 1st attempt at soowee(); (unreleased) 
• 6.10.0 Non-VDG; better Play clock compensation 
• 6.10.0A = bug in soowee macros shut down score printing! 
• 6.10.0B = adding/killing Part updates partens[] 
• 6.10.1 R and L lines commands 
• 6.10.2 Plus-parts, filter, & other MM/1 catchup 
• 6.10.3 reOrder parts & staves 
• 6.10.3A = notesort does Rests right; Patience on clone rests 
• 6.10.3B = default Perc synth is "no synth named." and Random 

Menu's 'f' is one col wider. 
• 6.10.3C = Instr Menus show in-use with '+', but no Swaps yet 

 
 
 
 



The original booklet Manual covers Versions 4.4.0 (don't use that 
one!) and 4.4.1. The newer manual covers through 4.7.0, but is 
hard to get these days. 
 
 
This "ReadMe.Zer" doc covers improvements made from 4.4.0 thru 
4.6.0, regardless of when they were made, but most came in with 
4.6.0. For a version by version summary of major changes, see 
Features.Doc (above) and ReadMe.One (below). 
 
 
IMPROVEMENTS of Version 4.6.0 over 4.5.0: 
 
MAJOR: 

• Percussion Clefs to fit all Synthesizers 
• MIDI Clock for Drum Machines, etc. 
• Point-n-Shoot file load & store. 
• Separate Side-info files available. 
• Point-n-Click on some Text menus. 

General: 
• Parts can hop to different MIDI channels dynamically. 
• Notes no longer straddle Barlines. 
• Score cursors change to reflect current tool selected. 
• Brush cursor really looks like a brush for notes/rests. 
• Menu button shapes indicate function. 

Setup/Layout Menu: 
• Setup Prompts removed (restored in later versions!) 
• Rangefinder finds highest and lowest notes per Part. 
• LayGo file replaces Staves in CMDS. 

New Integrated Files Menu: 
• 5 file types -- Score, Instrs, Percussions, MIDI Chans, Vol 

Levels 
• Overwrite question gives file name 
• Point n shoot, with type & edit options. No .ext needed. 
• "fd" shows non-.ume files only 
• Also Save & Load directly from Instrument and Percussion 

Menus. 
Block-Edit Menu: 

• Fixup function cleans up barline overhangers & holes 
Score ToolBox: 

• Simplified toolbox on/off control -- menu bar, clicks. 
• Brush Rep can be viewed instantly under cursor. 
• POWER TOOLS -- new lower deck.  Ignore artics for now. 

o Insert Barline 
o Chisel Smasher speeds up writing many notes 
o Part Copy stamps a pattern of notes anywhere 
o Join two adjacent note/rests into one 



o Squawker shows current instrument, volume, etc. 
o Note Translator, good for converting Percussion parts 

 
 
PERCUSSION CLEF and STAVES 
A major innovation of UltiMusE-III 4.6.0 is the Percussion Clef, 
which assigns each line and space of its staff to a known 
percussion instrument (snare drum, ride cymbal, etc.) regardless 
of what make or model synthesizer is used. Any synth model can be 
matched to the Perc Staff by a separate data table similar to the 
well-known Instruments Patch Number table. Percussion Clef and 
table files do for percussion sounds what the Instrement Menu and 
files have done for other instruments. Also Perc Clef notes don't 
get sharped or flatted by melody parts on other staves during 
Play. 
 
So when you download a score arranged for PSS-480 percussion, you 
no longer have to change every percussion part's notes to match 
your MT-240 or MT-32 (although our new Note Translator tool makes 
that much easier). Instead, if the score was created using 
Percussion Clefs, you simply load your MT32.per file instead of 
the PSS480.per data that came with the score. All UltiMousers are 
requested to please start using Percussion Clefs for any new music 
files! 
 
The Percussion Clef defines 17 slots in its staff -- 5 lines and 4 
spaces, plus two ledger lines and space on top and bottom. Each 
line and space should be used only to play its type of instrument.  
After much agonizing soul, jazz and rock searching, we have 
assigned the slots as follows: 
 
LINE/SPACE    SOUND 
    ---- Triangle  Open 
         Triangle Muted 
    ---- Crash Cymbal 
         HiHat Open 
|------- HiHat Closed 
|        Ride Cymbal 
|------- Rim Shot 
|        Snare 
|------- High Tom 
|        Mid  Tom 
|------- Low  Tom 
|        Bass Drum 
|------- Wood Block 
         Cow Bell 
    ---- Hand Clap 



         High Bongo 
    ---- Low  Bongo 
 
This covers the most important sounds and assigns them to the 
inner staff, much like a PSS-480. Odd sounds are farther out on 
the ledger lines. You might re-assign some of those to other 
sounds for a certain piece, but please note that in the Title 
screen for your own sake and others'. Latin or Rap devotees may 
want to get together and work out an alternative standard.  Just 
tell us what it is. 
 
 
PERCUSSION TABLES 
To set up a Percussion Table for your synth, enter the Instruments 
Menu and type 'p'. You'll get a sub-menu like the list above, but 
with a MIDI note number (initially zero) before each sound name. 
Moving the arrow cursor over the names blackens the selected name. 
Click on a name to edit its MIDI note number, which you must get 
from your synth's manual. Not the pitch or staff line/space, but 
its numeric value sent by MIDI, in Decimal, not Hex. Middle C is 
60, the C just below the middle of a Bass staff is 48, and bass C 
is 36. But remember not to think of a Percussion Staff's 
lines/spaces as any note or pitch, just their percussion sounds. 
 
If you hit the wrong line, just type ENTER to leave it as is. At 
any time you can save your table by clicking "Write to File" or 
typing 'w'. You can read an existing table file and replace your 
memory data, or just clear it to zeros with the other text 
buttons. You can type 'w', 'r', or 'c', but percussion sounds must 
be selected with the mouse (a new first for Umuse3).  
 
At the bottom is the synth make and model name. Click to retype 
it, or hit ENTER to leave it. It gets saved and reloaded along 
with the 17 MIDI note values. Perc tables can also be saved and 
loaded from the new integrated Files Menu. Either way, they always 
have ".per" extension. 
 
Make a Perc table once for each of your synths, save it, and just 
reload it each time you create a new piece. The table and synth 
name are alsosaved and loaded as part of the score. 
 
 
SCORING with PERCUSSION STAVES 
The Layout Menu now includes Percussion as a 5th clef, shown as 
two vertical lines. Set up any number of staves with it just like 
any other Clef. One special rule: When you move a part from one 
staff to another, or change the clef on a staff, notes are usually 



transposed to keep the pitches the same. But since a Perc Clef has 
no actual pitches, NO translation is done when moving into or out 
of a Perc-Clef staff. The lines and spaces just stay the same. So 
do accidentals, although accidentals are IGNORED on a Perc Staff 
during Play. That includes "accidental" accidentals that "bleed 
thru" from other parts, a headache that stays away when you use 
the new Perc Clef. 
 
There's no need to use the old Percussion part types (hollow notes 
in Layout Menu) on a Perc Staff, but no harm either. Their only 
function was to protect percussion MIDI pitches from the MIDI-Mode 
Transposer, which does not affect Perc Clefs either.  
 
 
CONVERTING OLDER SCORES TO PERCUSSION CLEFS 
But those hollow Percussion parts are easy to spot in scores 
written before Perc Clefs, which makes conversion that much 
easier. An old score may have about three perc parts, each playing 
two or three sounds, hopefully no more. First we recommend adding 
to new staves -- one permanent Perc Clef, and one temporary of the 
same clef as the old part for working on one part at a time. Shove 
all the non-perc staves up to the top of the screen for now, and 
untangle them later when finished. 
 
Move one old perc part to the temporary staff; its line/space 
slots won't change. Use the Rangefinder to guess how many pitches 
it's hitting. Now for each separate pitch, find out what 
percussion sound it played on the synth this score was arranged 
for, and use the Note Translator (up-down arrow tool on Score 
Screen) to move that pitch to the slot that sound would use on a 
Perc Clef. Finding its sound can be tricky if you don't have a 
manual for the original synth. 
 
When all pitches have been converted, go to Layout and pull the 
part onto the permanent Perc Clef staff. Play the piece, and 
listen for the newly converted sounds on your synth. Go back and 
convert another part. When all are converted, delete the old staff 
(if no non-perc parts on it) and your temporary staff. Or change 
it to another Perc Clef if the one looks too messy. 
 
MIDI CLOCK for AUTOMATIC DRUMMERS 
By popular demand, we've added MIDI Clock mode to the Play 
routine. 
Along with the usual MIDI music stream, this mixes in a steady 
series of pulse bytes at the rate of 24 per quarter note. These 
can can synchronize or "slave" a Drum Machine to UltiMusE so that 



the automatic drum rhythms follow all changes in Tempo and even 
double or halve in speed when you hold the Shift or Control keys.  
 
Many home consumer keyboards like the Yamaha PSS-480 include 
sophisticated rhythm and bass/chord accompaniment sections that 
can now be controlled directly from UltiMusE. [PSS-480 users, 
check out Demo488 in SCORES. It selects different rhythm styles 
and even sets the chords -- be sure to use MIDI Mode 00, External 
Clock, and Fingered Chord settings.] 
 
Clock is controlled from the MIDI Modes Sub-Menu. To send clock, 
it must be both enabled by "Clock Enable" and requested by the 
score as "Use Clock." Click those lines so both boxes show an X.  
"Clock Enable" is an UltiMusE mode that is saved and restored in 
your Preferences Init file under the Options Menu. But "Use Clock" 
is a feature of the score and is saved and loaded with it. Note 
the title headers on the three sections of the MIDI Modes Menu. 
 
Technically, the MIDI Clock rate of 24 per quarter note is equal 
to a part filled solid with Triplet 64th notes, the fastest thing 
UltiMusE-III can play. So far, we notice no slowdown when CLock is 
on. UltiMusE sends Clock only when playing, and sends a standard 
MIDI "Start" signal at the beginning and a "Stop" when play ends 
or is interrupted by BREAK or CTRL-C. Would you like a score 
object to turn CLock on and off at certain parts of a piece?  Let 
us know. 
 
A slight bug -- if you use 'w' (Window Play) and the current 
screen display doesn't start right on a barline, the rhythm 
machine will be out of sync with the music. Interesting effects to 
check out till we fix this. 
 
NEW "POWER" TOOLS 
The right-hand side of the Toolbox now has twice as many tools, 
arranged in two rows. The older ones are in the top row, in their 
same old order. The new ones underneath are truly "Power Tools" 
that you shouldn't use without reading further.  Here they are, 
from left to right: 
 
BARLINE INSERTER: 
The first is pretty safe -- it just inserts a Barline anywhere, 
subject to the same note-splitting restrictions as Markers. It 
looks like a double barline but inserts plain singles. After 
insertion these can be promoted to other types by clicking with a 
note/rest brush. 
 
SMASHER: 



Next is the Smasher or Chisel icon. You know that inserting a 
series of 8th or 16th notes over a measure of four quarter rests 
is slow and distracting, since almost every new note causes a 
screen refresh. But when you click the Smasher on a rest, whatever 
size note or rest you had on the Brush Rep is overlaid repeatedly 
over the rest you click on, until the overwrites would run out of 
the measure or chip/bomb a Note. The Smasher only overwrites 
Rests, within its bar. 
 
You can put down rests or notes, and adjust their pitch later.  
Dots, double-dots, and triplets all work. This should save you 
lots of time. Just remember to first select the size and type of 
note/rest as usual before picking up the Chisel. The Chisel's 
center of action or "hot spot" is at its bottom tip. 
 
PART BLOCK COPY: 
The Square is the most powerful of the new tools -- Part Block 
Copy. Before selecting it, have a block of score set off with Left 
and Right Markers. When you pick up the Square, you'll be asked to 
select a Source part to copy from. Click any note/rest in your 
chosen Source part. The hollow square will turn solid, meaning you 
can now stamp out copies of the marked-off section. This solid 
square is a "super brush" that, when clicked over any note/rest in 
the score, will overwrite that note/rest and following note/rests 
in that Destination part, replacing them with the section of 
Source part between the Markers. This "urban renewal" blows away 
as much of the old Destination as needed to use up the Source 
between the Markers.  New notes are automatically broken up as 
needed to fit around barlines. 
 
Repeated percussion patterns and bass riffs can be written once 
and then stamped throughout the score. Even though the notes 
change, stamp the same rhythm and change the pitches afterwards.  
Rounds and canons, from "Three Blind Mice" to Pachelbel's "Canon 
in D" can be written out in just one part, and the other parts 
stamped out. You can duplicate a part at odd time offsets (like 
half a beat) from the original, for special effects. Or simply 
duplicate a whole part, to double it on another instrument or an 
octave off. 
 
The only restrictions are that the block must fit in the time from 
where you click to the end of the score, and you can't overlay any 
portion of the Source Part inside the marked block. Expression 
items are not copied, but the original ones remain. 
 
Also be aware that PartCopy works by staff lines and spaces, not 
note pitches, and doesn't translate if you copy to a part on a 



staff with a different Clef. To do that, create a temporary staff 
of the same Clef as the Source, with a temporary part on it; stamp 
the part block onto that staff, just after the Left Marker. Then 
change the temporary staff to the same Clef as the destination; 
this will translate the intermediate copy's notes. Now re-select 
Part Copy and copy from the temporary part. 
 
Part Copy can take a while to finish. And power is dangerous -- 
don't leave a Solid Square on your brush, but treat it like a 
loaded gun. 
 
NOTE JOINER: 
Its hot spot is the little center area common to both of the 
interlinked wedding rings. When clicked on a note/rest, the Joiner 
tries to make one note/rest of this one plus the next one of the 
same Part. The note pitch or "rest-ness" of the clicked one takes 
over.  Use Join to clean up unnecessary Ties and fragments of 
Rests -- like a dotted quarter out of an 8th and a quarter. Join 
cannot be undone (no Divorce icon), so don't keep it on the Brush 
when not in use. 
 
SQUAWKER: 
The Question Mark is the safest -- does absolutely nothing to the 
score -- but knowledge is power. Ever try inserting Volume or 
Instrument expressions in the middle of some long piece, only to 
wonder what level and instrument are already in force? Or even 
what part some note belongs to?  What channel?  Just click the 
Squawker over any score object (the hot spot is upper center, 
where the peg would be if it hung on the wall) and a window pops 
up with the Part, Index, Time, Instruments, MIDI Channel, and 
individual and General Volumes. If not a note/rest, many of 
these are omitted. 
 
You may see two Instruments, "says" and "plays." Remember, a MIDI 
synth can play only one instrument per channel for the same note 
range. When two or more parts share a channel, the most recent 
Instrument patch change sent on that channel will cause all parts 
on the channel to "play" that instrument, regardless of what those 
parts "say" most recently. We show both, but the Play is what 
counts. [Any octave-shifting effects of instrument names 
begtinning with '+' or '-' will remain though, even on the new 
instrument -- a source of useful tricks!] 
 
The '?' is great for browsing thru downloaded scores, and not just 
for its safety! 
 
NOTE TRANSLATOR: 



The hot spot is the upper tip of this double-ended arrow.  Use 
this to find and change all notes in a given part of a certain 
pitch to another pitch. Optionally only those notes within a 
marked block will be changed, but if either marker is missing 
you'll be asked whether to go from the beginning and/or to the 
end. Once you pick up this tool, grab any note (not rest) of the 
pitch you want to change, by holding the mouse down and dragging 
the note to the new pitch. Move left and right to adjust the 
accidental (sharp, flat, natural, nothing, etc.). When you let go, 
all notes of that part and pitch within the block will change. 
 
If the note you grabbed is not inside the block, it won't change. 
If no notes were affected, you'll see a message to that effect.  
To be changed, notes must match the pitch exactly -- staff 
position and accidentals. "Nothing" and "Natural" are not the same 
here. However, size and duration don't matter. 
 
This is useful mostly for converting older percussion parts to 
work with a different synth's percussion, preferably on the new 
Percussion Staff. 
Be careful not to convert a pitch to another pitch that already 
includes some notes yet to be converted. It's best to convert one 
part at a time using a temporary staff, checking the part's note 
content on the Layout Menu's Rangefinder. Take care while the Note 
Changer is on the brush. 
 
 
INTEGRATED FILE SYSTEM and SIDE INFO FILES 
 
All file reading, writing, and saving now uses a standard menu 
that replaces most file-name typing with point-and-clicking. Four 
types of "side information" tables can be saved and loaded 
independently of main score files. 
 
SCORE FILES 
Pull down the Files Menu. If you click READ, Umuse3 will open a 
window ust big enough to show all Score files in the current data 
directory. That is, all files ending in ".ume" (any mix of 
upper/lower case letters is OK). YES, ALL SCORE FILES MUST END IN 
.UME for Version 4.6.0 to read or even find them! Time to use 
"rename" on your stuff?  But the ".ume" extent doesn't show in the 
list. 
 
Moving the mouse over the names will highlight a name in inverse 
video. If you click over that name, it will be read in.  You can 
also type a name into the small box at the bottom -- useful for a 



pathname to a file in another directory. Omit the ".ume" extent; 
Umuse3 adds it for you. 
  
Your Backspace (<-) and Line-Erase (SHIFT <-) keys work normally. 
Hit ENTER or click "(Read File)" to load the file. 
Clicking "(CANCEL)" or anywhere outside the big window returns you 
to the Files Menu without reading anything. So does hitting ENTER 
when there's no file name in the little box.  
 
Now try Files Menu WRITE, formerly known as "Save As." Same window 
and list, with a difference. Clicking a displayed name copies it 
into the box, but does no more until you hit ENTER or click 
"(Write File)", or bail out as above. Instead of overwriting an 
existing file, you'll usually type a new name into the box. But 
what if you want a new name that's like an old name except for a 
different version number or letters on the end? Then click that 
old name into the box and add characters to it, using the 
Backspace key as needed.  Now hit ENTER or click Write. If nothing 
else, seeing all existing names when Writing shows what names are 
already in use. 
 
SAVE works as before -- it always writes to the current file name, 
and bypasses the file-list window. 
 
DIR now opens the window and lists only those files that DON'T 
have the ".ume" extent. Good for finding subdirectories, and all 
the side-info files at once. You can't read or write, just return 
when ready. 
 
APPEND isn't working yet. 
 
TITLE EDIT and FILENAME? havn't changed. 
 
 
SIDE-INFO FILES: 
These are data tables in the Score that can also be saved and 
loaded separately to customize a score for different equipment 
setups or tastes. 
Instrument names and their patch numbers are the familiar example, 
but we now handle four types, given with their .extents: 

• .ins - Instrument Menu names & patch numbers (same as before) 
• .per - Percussion slot MIDI notes numbers and Synth name 
• .mid - MIDI Part --> Channel assignments 
• .lev - Volume Levels MIDI velocities for ppp - fff 

 
Only the .per table is new, but the MIDI channels and volumes 
could not be filed separately before 4.6.0. 



 
Use "Instrs etc." to get a new sub-menu with a slide selector for 
the four side-info types and three buttons for Read, Write, and 
Dir. From here, everything works just as for Score files, except 
the selected extension replaces ".ume". Of course your Instrument 
files must all end in ".ins" now. 
 
The .ins and .per files can also be handled from their own menus, 
with the same powerful look-point-click-type interface. 
 
 
NEW EXPRESSION ITEMS 
Two new features let you add more interest to your music with less 
work and memory consumption. You'll find them on the Expressions 
Menu that pops up whenever you click a score item with the 
Expression Inserter (up-arrow) tool. 
 
MIDI CHANNEL HOPS 
Choose 'c' and a MIDI channel from 1 to 16 to insert a Channel 
Hop, which will dynamically switch its Part to the given channel 
when Play gets to it. This is needed to have a voice switch 
between two different synths, or the normal and percussion 
channels of one synth. Suppose your lead voice is to play sax in 
the verses and guitar in the choruses. Your one synth has great 
sax and lousy guitar; the other synth is the reverse. Now you can 
have it both ways without using two separate parts. As with 
Instrument and Volume changes, careful placement around Repeat 
barlines can get you a different channel on the 2nd time thru, 
etc. 
 
GENERAL DYNAMICS VOLUME LEVELS 
Tired of entering an "mp" or "fff" in front of all eight parts' 
notes every place that you want a change in volume (MIDI 
velocity)? This wastes memory and your time, and makes changes 
much harder. 
 
Now we have General Volumes (Genvols) to make this easy. Like 
Tempos, they apply to all voices at once. They also display at the 
top of the score like Tempos, showing the same ppp-fff as partwise 
volumes. Enter them the same way -- get the up-arrow cursor, click 
on a note or rest to bring up the Expression Menu, and type 'g' 
followed by a digit 0 thru 7 or by ENTER to get a refresher menu. 
If you click on a Genvol and enter a new one, it will replace the 
old. You can 'X' out a Genvol and 'u' (undo) it back. 
 
Genvols work off the same MIDI Volume Levels Table as the 
individual parts' dynamics. Each genvol raises or lowers the 



overall level by the difference between its table entry and the 
average of the "mp" and "mf" levels. Example: using "even spacing" 
the mp and mf (slots 3 and 4) MIDI levels are 55 and 73. Their 
average is 64. Somewhere in the piece you put a general "ff". Its 
table entry is 109, so until the next genvol every note's MIDI 
velocity is increased by 109-64 = 45. If a "pp" genvol is played 
every note is softened by a difference of 19-64 = -45. And so 
on. All velocities are limited to 1 thru 127, after being further 
adjusted by the Master Volume, another new feature. 
 
See "OCanada.ume" under your Program Disk's SCORES for a simple 
example of genvols. Of course not all synths respond to dynamics. 
 
You can also think of a genvol as shifting the reference point of 
all individual volumes. If you begin a piece with a genvol "p", 
then every individual "mf" means "a little louder than p" and 
every "mp" is "a little softer than p" and so on. 
 
Use the old individual part volumes to accent one voice over 
another and to set and change the balance between lead solo parts 
and 'comp backgrounds. But usually when the solo voices swell and 
fade, the background can go up and down with them, so Genvols are 
effective. 
 
MASTER VOLUME 
This is not a Score Item, but a performance setting on the MIDI 
Modes Sub-Menu. It isn't even saved along with the score, but is 
best described here with General Volumes. MIDI "Volumaster" 
velocity level offset (master volume) is like a Transpose but for 
loudness. Its value (-127 to 127) is added to whatever MIDI note-
on velocity each note would naturally have, and the result limited 
to 1 thru 127. Use this to boost or cut the overall loudness of a 
piece. Note that setting 127 will make every note play at full 
volume regardless of expression, and -127 at minimum volume. Like 
the Transpose, Volumaster is NOT saved with a score file nor the 
Um3.Init options file. 
 
 



MENU IMPROVEMENTS 
 
In general the menus are much easier to use than in the Manual. 
All menus can be exited with a Mouse Click or an ENTER. New 
convenience features include: 

• Slide Selectors choose one of several alternatives; 
• Check-Boxes that toggle and indicate on/off modes; 
• Fill-in-the-Blanks for numeric quantities like Transpose. 

 
SCREEN-COLORS SUBMENU 
A Slide selector lets you edit Fore or Background. Check-boxes 
toggle the RGB and rgb primary colors. Unlike most other Umuse3 
menus, this one does not update the colors unless you explicitly 
punch the "OK, Keep" button. This lets you "panic" out of this 
menu by hitting ENTER or clicking outside it, either of which you 
can easily do "blind" if you somehow set Foreground = Background! 
 
MIDI MODES SUB-MENU and /MIDI DRIVERS 
The built-in Play routine now supports any /MIDI device driver 
directly, without loading any special alternate Play routine.  
Control of this and other MIDI "modes" (other than channel 
assignments) has been moved to a Modes Sub-Menu with three 
sections. 
 
The first section lets you toggle the three output ports -- Coco 
serial, MIDI-Pak, or /MIDI custom device driver. Any combination 
is legal, except MIDI-Pak and /MIDI can't both be on at once. 
 
Section 2 controls several Enable switches plus performance 
parameters that aren't saved with the Score, such as Transpose. 
The enables determine whether certain info in the score is sent 
to the synth. 
 
The third section is like the second but its quantities and 
enables are part of the Score file. Both sections control the new 
MIDI CLock. 
 
 
MISCELLANEOUS IMPROVEMENTS 
 
PREFERENCES INIT FILE 
As of Version 4.6.0, the /DD/IMAGES/Um3.Init file initializes your 
custom settings of screen colors, Hi-Res Mouse adapter usage, 
three MIDI output ports, File Read-Only mode, printer type, 
Instrument-Change enable, and MIDI Clock Enable. 
 
SETUP LAYOUT PROMPTS 



The old text-only questions that nursed you thru setting up a new 
score's parts and staves have been deleted to save memory space. 
The graphics Setup/Layout Screen is easy to use, especially if you 
read the now-obsolete Manual section on the Prompts as a guide to 
making decisions when using the Screen. 
 
NO MORE BARLINE STRADDLERS; FIXUP 
Umuse3 no longer lets notes or rests stretch in time over the 
barline into the next measure. Instead, any attempt to insert 
these (by you directly, or by Part Copy) is automatically broken 
into the right amount of note/rests on both sides of the bar, all 
Tied together. 
 
Older scores with straddlers can be fixed with the new "Fixup" 
button on the Blocks Menu. If in doubt, run it from beginning to 
end on each part in the score. 
 
SCORE SCREEN -- TOOLBOX and CURSORS 
The mouse cursor now changes to show exactly what tool is on your 
Brush. An artist's paintbrush means any Note/Rest; quick-click on 
nothing to briefly flash the full Brush Rep and see the note/rest 
type. The old arrow cursor is no longer used in the Score Screen. 
 
Toolbox control is simpler. 
It and the Brush Rep can be toggled on/off from the top Menu Bar.  
All the "positive" actions in the Manual still work, but the 
"negatives" for getting rid of the Toolbox are now short and sweet 
-- a quick click on the Brush Rep while it's joined to the Toolbox 
removes both of them from the screen at once. Double-clicking on 
nothing still restores the Rep out of nowhere or breaks it loose 
from the Toolbox. Dragging works as before. 
 
Really nice is a single quick click on nothing; this momentarily 
flashes the Brush Rep at the cursor position, whether it was 
anywhere on the screen or not. Good for doing lots of "note 
pickup" adjustments with the Toolbox off. Note that a successful 
pickup blinks the paintbrush cursor off for a moment, but does not 
flash the Rep -- a Rep flash means you hit nothing. 
 
 
REALLY MISCELLANEOUS: 
 
Ties now carry accidentals over barlines, as in written sheet 
music. Delete this from the manual's "Known Bugs" section. 
 
MIDI "running status" reduces the data rate to your synths, by not 
repeating the "note on" command when turning on or off more than 



one note on the same channel. To get the most benefit (and make 
your scores more readable), assign parts with the same instrument 
(like three-part chords) to the same MIDI channel. 
 
Umuse3 now warns you at startup if GrfDrv is not in memory or on 
your current CMDS directory. Unlike 4.4.1 you can keep it in your 
Umuse3 CMDS directory and not have to pre-LOAD it. 
 
The left and right arrows in the bottom corners, which move the 
view a full screen's worth, are now duplicated at the top also. 
 
Button icons in pushbutton menus have different shapes to reflect 
their functions. Rounded at both ends is a button that does an 
immediate action.Square ends imply a dialog box will pop up. A 
right-pointing arrow shape leads to a full-blown submenu. 
Hexagonal ends simply put a different tool on the cursor, as in 
the Setup/Layout Menu. 
 
 
HINTS AND SUGGESTIONS 
 
The middle number of any Umuse version is its Score Level, so 
Version 4.6.0 makes Level 6 scores, which include a Percussion 
Table, Percussion Synth Name, and MIDI Clock usage switch, all 
lacking in Level 5 scores. Level 5's only difference from Level 4 
is General Volumes.  Level 5 scores will display and play fine on 
earlier Umuse versions except of course the general dynamic 
expressions won't be seen or heard. Early shareware versions may 
blank out the screen on genvols, but will play. 
 
The supplied Score Disk files may include Level 4 or 5 that will 
give a warning box when first loaded. Just Save each one back out 
(to your BACKUP disk) to end this nuisance. 
 
If a old piece plays at "warp speed," make sure there is a Time 
Signature at the beginning. If not, get a Note on the brush and 
click just to the right of the leftmost Barline to get the Barline 
Menu; hit '/' to enter the two numbers. The old ShareWare Umuses 
let you enter pieces without time signatures; the new Setup Menu 
tries not to let you make this mistake. 
 
You can play from inside the top MIDI Menu to check modes, levels, 
values, and channel assignments. But remember, channel assignments 
don't actually change unless you hit "Update" or exit clear back 
to the score screen. This is for your own safety if you mess up 
channels, but it's had me tearing out synth cables more than once! 
 



If you run out of memory in a large score, none of your other OS9 
windows will work -- even "unlink whatever" to free up space gets 
a #207 error. You've run out of office forms to order more forms 
with. Save your score, or Write to a new file; then read a small 
one or create a new one with nothing but a 4/4 Time Signature 
(easy). Now you use windows or our '9' Shell menu to UNLINK 
modules from memory. Then reread your big piece and go back to 
work. DO NOT try to Change Directory in Umuse3 until memory has 
been freed, or the failed PWD command that Umuse3 first runs may 
lock up Umuse3 so you must BREAK and Quit, losing your work. 
 
<END of ReadMe.Zer> 



Readme.One   Installation and Versions 4.4.1 thru 4.7.2 
 
SETUP/INSTALLATION for all version 4.6.2 and above: 
--------------------- 
What you need from our Umuse3 (UltiMusE-III) System Disk: 
 
SYS Directory: 
This replaces and eliminates the old IMAGES directory. Now there 
are only two files. If you have an earlier version of Umuse3, you 
can delete the IMAGES directory, but first copy your Um3.Init file 
(if any) to SYS on your working-copy disks. 
 
CMDS Directory: 
You need all the files in the CMDS directory to run Umuse3, except 
for UBox3 (the "JukeBox") and MIDI.dddr (used only to run a non-
standard hardware MIDI interface). 
 
You must have GrfDrv and PWD available when running Umuse3 or 
UBox3.  Either LOAD them into memory right after booting OS9, or 
copy them to the CMDs of your Umuse3 working disk from your OS9 
boot disk's CMDS directory and then forget about them. 
 
UBox3 is the latest "Juke Box" program. It is "freeware" that you 
may give away. Run it in an 80x24 Text OS9-Level-2 Window, *not* 
the 32x16 VDG screen used for UltiMusE-III. 
 
To get such a window, type: 
 shell i=/w7& 
 
Now hit CLEAR to get into that window.  There type: 
 ubox3 
 
No mouse is used with UBox3. 
 
 
BOOT: 
Besides TERM and VDGInt, your OS9 Boot must also have GrfInt (or 
WindInt) plus at least one Window descriptor (/W1, etc.) beyond 
any that you have opened. Also GrfDrv must be LOADed or in your 
current CMDS directory when starting Umuse3. But DON'T put GrfDrv 
in your Boot! 
 
If you use a /MIDI driver and descriptor, install them in your 
Boot for best results. It's handy to always be able to say at any 
time 
 display xx xx ... xx >/MIDI 



to adjust a synth's parameters. The driver software should be 
written to transfer multiple bytes (up to 256) at a time for 
smoothest play. 
 
<end setup/install> 
 
 
------version.450------ 
 
Version 4.5.0  December 03, 1989 
 
The original Manual covers up to Version 4.4.1. 
This Update Addendum covers improvements made in 4.5.0. 
If you've been using any Version 3.x.x, here are the major changes 
at a glance: 
 
IMPROVEMENTS of 4.4.1 over 3.3.0 thru 3.4.1d: 

• 32,767 score objects (notes, etc.) 
• Menus mostly point and click 
• Score no longer creeps to the right when editing 
• Instrument (Patch) Changes can be disabled from the MIDI 

Menu, under "Midi ports."  Your Preferences Init file holds 
your desired startup value (on/off). 

 
Now for Version 4.5.0's improvements over 4.4.1, with instructions 
on using them: 
 
"General Volume Levels" make entering loud/soft expression 
dynamics much easier. See the separate section below for details. 
 
Ties now carry accidentals over barlines, as in written sheet 
music. Delete this from the manual's "Known Bugs" section. 
 
MIDI "running status" reduces the data rate to your synths, by not 
repeating the "note on" command when turning on or off more than 
one note on the same channel. To get the most benefit (and make 
your scores more readable), assign parts with the same instrument 
(like three-part chords) to the same MIDI channel. 
 
Umuse3 now warns you at startup if GrfDrv is not in memory or on 
your current CMDS directory.  You must keep it in your Umuse3 CMDS 
directory but need not pre-LOAD it. 
 
All Menus can be exited with a Mouse Click. 
Menus are much more convenient with some New Items: 

• Slide Selectors choose one of several alternatives; 
• Check-Boxes that toggle and indicate on/off modes; 



• Fill-in-the-Blanks for variable quantities like Transpose. 
 
Improved Menus: 
Startup and Files Menus -- Read-only is a Check-box. 
Options Menu: 

• Check Boxes for Compact display and Trace playing. 
• Printer Sub-menu uses Slide selectors. 
• Screen Colors Sub-menu 

o Slide selector for Fore & Background 
o Check-boxes for the RGB primary colors. Colors don't 

update if you "panic" out of this menu by hitting ENTER 
or clicking outside it; this saves you if you get 
foreground = background! You must hit the "OK, Keep" to 
make changes stick. 

MIDI Menu: 
• Modes now have their own Sub-menu 

o Check-boxes for on/off modes including /MIDI device 
output and MIDI "events." 

o Fill-ins for numeric quantities, including old Transpose 
and Seconds/Minute, plus new Volumaster. 

 
MIDI "Volumaster" velocity level offset (master volume) is like a 
Transpose but for loudness. Its value (-127 to 127) is added to 
whatever MIDI note-on velocity each note would naturally have, and 
the result limited to 1 thru 127. Use this to boost or cut the 
overall loudness of a piece. Note that setting 127 will make every 
note play at full volume regardless of expression, and -127 at 
minimum volume. Like the Transpose, Volumaster is NOT saved with a 
score file nor the Um3.Init options file. 
 
<end of improvements> 
 
GENERAL DYNAMICS -- VOLUME LEVELS 
Tired of entering an "mp" or "fff" in front of all eight parts' 
notes every place that you want a change in volume (MIDI 
velocity)?  This wastes memory and your time, and makes changes 
much harder. 
 
Now we have General Volumes (Genvols) to make this easy. Like 
Tempos, they apply to all voices at once. They also display at the 
top of the score like Tempos, showing the same ppp-fff as partwise 
volumes. Enter them the same way -- get the up-arrow cursor, click 
on a note or rest to bring up the Expression Menu, and type 'g' 
followed by a digit 0 thru 7 or by ENTER to get a refresher menu. 
If you click on a Genvol and enter a new one, it will replace the 
old. You can 'X' out a Genvol and 'u' (undo) it back. 
 



Genvols work off the same MIDI Volume Levels Table as the 
individual parts' dynamics. Each genvol raises or lowers the 
overall level by the difference between its table entry and the 
average of the "mp" and "mf" levels.  Example: using "even 
spacing" the mp and mf (slots 3 and 4) MIDI levels are 55 and 73. 
Their average is 64. Somewhere in the piece you put a general 
"ff". Its table entry is 109, so the MIDI velocity of every note 
following that "ff" is increased by 109-64 = 45. If a "pp" genvol 
is later encountered, it overrides the previous genvol and every 
note is softened by a difference of 19-64 = -45. And so on. All 
velocities are limited to 1 thru 127, after being further adjusted 
by the Master Volume, another new feature. 
 
You can also think of a genvol as shifting the reference point of 
all individual volumes. If you begin a piece with a genvol "p", 
then every individual "mf" means "a little louder than p" and 
every "mp" is "a little softer than p" and so on. 
 
Use the old individual part volumes to accent one voice over 
another and to set and change the balance between lead solo parts 
and 'comp backgrounds. But usually when the solo voices swell and 
fade, the background can go up and down with them, so Genvols are 
effective. 
 
<end of genvols> 
 
HINTS AND SUGGESTIONS: 
The middle number of any Umuse version is its Score Level, so this 
Version 4.5.0 makes Level 5 scores. Their only difference from 
Level 4 is they may contain General Volumes. Level 5 scores will 
display and play fine on earlier Umuse versions except of course 
the general dynamic expressions won't be seen or heard. Early 
shareware versions may blank out the screen on genvols. 
 
If a old piece plays at "warp speed," make sure there is a Time 
Signature at the beginning. If not, get a Note on the brush and 
click just to the right of the leftmost Barline to get the Barline 
Menu; hit '/' to enter the two numbers. The old ShareWare Umuses 
let you enter pieces without time signatures; the new Setup Menu 
tries not to let you make this mistake. 
 
You can play from inside the top MIDI Menu to check modes, levels, 
values, and channel assignments. But remember, channel assignments 
don't actually change unless you hit "Update" or exit clear back 
to the score screen. This is for your own safety if you mess up 
channels, but it's had me tearing out synth cables more than once! 
 



<end version 4.5.0> 
 
 
For Version 4.6.0's major additions, see ReadMe.Zer file. 
 
-----version.462----- 
 
Installation is simpler; disregard the IMAGES stuff in manual, and 
replace with instructions below. 
 
BUGS FIXED in 4.6.2 from 4.6.0: 

• Starting up by typing "umuse3 SCOREFILE" now works, where 
SCOREFILE is any real music file name. 4.6.0 broke this. 

• Saving the score when you quit now works again; 4.6.0 broke 
it. 

• Part-Copy sometimes copied only the first note. 
• Play didn't always handle "triplet" time signatures (6/8 

etc.) properly. This was an old bug, not a new 4.6.0 special! 
 
 
IMPROVEMENTS in 4.6.2 over 4.6.0: 
 

• More Printer types supported: Gemini 10X and Epson 
compatibles can print either narrow (much like the screen) or 
wide, on the same printer. 

• No more IMAGES directory with its dozen .img files. Only two 
files are needed now -- chars.img and allUm3.img, and these 
must be put in the SYS directory of any disk from which 
you'll start UltiMusE. Most OS9 working disks already have 
SYS. This makes for easier installation, less clutter, and 
MUCH FASTER STARTUP of UltiMusE-III. If you already have an 
older Umuse3 working disk, copy its 

• IMAGES/Um3.Init file to SYS/Um3.Init, since this 
"preferences" file now goes under SYS too. 

• You may now plug your mouse or joystick directly into either 
the Left or Right port, or the Hi-Res Adapter into either 
port. (Used to be that Hi-Res went in the Right port, direct 
to the Left.) The Options Menu now lets you choose both port 
and resolution.  You may need to use the keyboard when making 
changes. If you have no mouse control when you start up, hit 
ENTER to get the blank Score Screen, then 'o' for the Options 
Menu, where you hit the 'h' and 'l' keys as needed to toggle 
the mouse modes. Then use 'f' to save 

• the new options. 
• You can now use 'c' or 'h' in the Files Menu to change to 

another directory without waiting for the present dir to be 



looked up. To get the PWD (and a chance to change it), type 
'p' or click on "Present dir". 

• If you're running another task from another window and not 
playing music with UltiMusE for a while, you can speed up the 
other task by putting Umuse to sleep. Just flip to another 
window. Umuse will consume no machine cycles until you wake 
it up by returning to its window. 

• When you quick-click over nothing in the Score Screen, the 
Brush Rep flashes to show you what's on the Brush -- but now 
only if you have a Note/Rest or the Chisel Smasher on the 
brush. 

• Please remember to use the new Percussion Clef for all new 
percussion parts. And upload your masterpieces. Thanks. 

 
 
-----version 4.7.0------ 
 
BUGS FIXED in 4.7.X from 4.6.0: 
 

• Starting up by typing "umuse3 SCOREFILE" now works, where 
SCOREFILE is any real music file name. 4.6.0 broke this. 

• Saving the score when you quit now works again; 4.6.0 broke 
it. 

• Part-Copy sometimes copied only the first note. 
• Play didn't always handle "triplet" time signatures (6/8 

etc.) properly. An old bug. 
• Tied note before a Tacetized or Cleared measure no longer 

keeps on sounding (old bug). 
• "FD" command gave funny report for "No such files found." 

 
 
IMPROVEMENTS in 4.7.0 over 4.6.0: 

• Note Articulations -- Stuccato, Marcato, Legato for crisper 
playing. 

• Continous Printing of Full Score 
• Automatic Crecendo and Diminuendo 
• MIDI Clock can be turned on and off within score anywhere 
• Improved Search Goto commands 
• Setup Prompts are back! 
• Transpose Value is saved and read with score, and the UBox3 

Jukebox uses it. 
 
 
NOTE ARTICULATIONS 
Stuccato, Marcato, Legato for crisper, more expressive playing. 
You can pick up the Tools in the lower cetner of the Toolbox and 
click them over notes to turn the "Artic" on or off for that note. 



The curved item (like a Tie) is Legato -- smooth, full-length note 
play as in earlier versions; the default. The dash is Marcato, 
meaning leave a little breath space after the note. Good for 
marches, rock, and the end of any musical phrase. Dot is Staccato, 
meaning half the note value. The little circle means to cancel 
whatever Artic is showing on a note. It will also cancel Ties. It 
doesn't show on the note afterwards. 
 
Clicking any Artic tool on a note that already has that Artic set 
will toggle it Off.  Next click turns it back On, etc. 
 
Any note with no Artic keeps the same Artic as the most recently 
played note of that part, except for Ties. The "squawker" ? tool 
shows what Artic any note will play. 
 
 
CRESCENDO/DIMINUENDO 
These give you a smooth transition from loud to soft or the 
reverse. They are part of the "general volume" expression and 
affect all parts equally. 
A cresc/dim item has two values -- the target volume level, given 
0-7 but showing as ppp-fff just like a GenVol -- and the number of 
beats it will take to get to that level, where a beat is the 2nd 
number of the current Time Signature, unless it's a "triplet" type 
like 6/8 or 9/16, where a beat is 3 such note times. 
 
Insert a cresc/dim just like a Genvol with the up-arrow tool, with 
the level number 0-7.  You'll be asked for the number of beats, 
which will be limited to 1-99 no matter what you type. 
 
Whether you type '<' or '>' is up to you, but both work exactly 
the same when playing. A cresc/dim always starts from the current 
general volume playing when it was hit, and figures whether to go 
up or down to reach the given target level. If the target is 4 
(mf), the music may get louder (if it was mp or less) or softer 
(if it was f-fff). 
 
If another cresc/dim is hit while one was still working, the new 
one takes over at whatever volume the old had reached, and the old 
one is terminated. Hitting a regular GenVol also ends the 
cresc/dim and instantly goes to the new volume. 
 
Cresc/dims are best for making volume dynamics smooth and less 
jerky, so your music sounds less like a machine. Also handy for 
fade-outs at the end of pop songs, where a couple bars just keep 
repeating but fade away. See "California Girls" score. Drum rolls 
are great with fast cresc/dims of 4 beats or less. 



 
Accelerando/Ritard does for Tempo what Cresc/Dim does for 
loudness. 
 
 
NEW SEARCH COMMANDS and FEATURES 
New "whats" added to find new items, and some old ones we 
overlooked: 

• a   any Articulated note (other than Tied) 
• _   any Tied note 
• p#  any note or rest of part # 0-9, a-g 
• P#  like p# but must be a Note, not Rest 
• <   any Crescendo or Diminuendo 
• >   ditto 
• r   any Accelerando or Ritard 
• c   any Clock on or off (Was any MIDI Channel Hop) 
• m   any MIDI Channel Hop (was 'c') 
• :   any Repeat 
• d   any DC, DS, with or without repeats 

 
The p and P are for finding where a voice plays, when it plays 
only in a few places in a large score. P ignores the Rests. 
 
You can now add a number after many search characters to limit the 
search to only those items with the same value. Example: "g+i" 
finds the next Instrument change to the right of the screen, but 
"g+i4" finds the next I4 or change to instrument #4. You can add 
numbers to i, g, v, m, <, r, and t -- and of course p and P, which 
aren't worth much without a number. 
 
For any expression item applied to a particular part (voice), 
namely i, v, and m, you can also add on 'p' or 'P' followed by a 
part number or letter.  To find where part 14 gets switched to 
instrument 12, type "gi12p14" or "gi12pe".  
To find the 3rd place from the screen where that happens, 
"g+3i12p14". 
 
 
CONTINUOUS SCORE PRINTING 
Print your entire score while you duck out for pizza. 
Hit 'h' or Hard Copy under the Random Menu. 
This will print the entire score, or the portion between [ and ] 
(the brackets themselves are not printed). 
You can abort at any time by hitting 'q', but the program will 
finish printing the present screen, so be patient. 
 



If you answer "N" to "Really want to Print?", it will just display 
each line of music on the screen as it would be printed, to 
"preview" the breakdown into lines. It's fun to watch the 
stretching and compression. 
 
The first page includes the file name and 4-line Title block. All 
pages are numbered, and the folds between sheets are skipped. Be 
sure to position the paper with a fold crease just below the print 
head before starting. 
 
Umuse3 tries not to split any measures, or split them in the 
middle if possible. 
 
<end 4.7.0> 
 
 
-----version 4.7.1---- 
 
Extra Notes for 4.7.1 
 
SLICING NOTES PERMITTED 
Markers cannot be inserted where they would slice into the time 
duration of a note or rest. This can be a pain when trying to set 
up a [block] for Part Copy. 
 
It's now legal to insert a Barline (the || tool in Toolbox) 
anywhere. If it would slice, you're asked whether you want to 
insert it anyway; if you answer Y, the barline is inserted and 
notes/rests are automatically split up and tied over the new 
barline.  Now you can insert markers or other items onto the 
barline, and delete the barline if no longer needed. 
 
NO MORE OIL SPILLS 
A bug duet in the C Library and OS-9's memory management sometimes 
caused graphic junk to smear the top of the screen when large 
menus popped up. I wrote my own memory allocater and bypassed the 
bug for sure this time. 
 
SAFE PRINTER ABORTS 
Another OS-9 "feature" broke Umuse3 when you used BREAK to abort a 
score printing run, even a Preview. You now may hit 'q' to stop 
the printing after the current screen. Previews are controlled by 
a Yes/No box. 
 
<end 4.7.1> 
 
 



-----version 4.7.2---- 
 
IMPROVEMENTS for Version 4.7.2 
 
ARROW KEYS ADJUST NOTE SIZES: 
To speed up inputting and editing of scores, you may now change 
the type of note/rest on your "brush" without going down to the 
Toolbox palette every time. 
 
Often you just want the next larger or smaller note than what's on 
the brush. For this just use the arrow keys. Left and right arrows 
change the size of the note/rest by one step in the palette. If 
you run off either end of the range, it wraps around to the other 
extreme. 
 
Likewise the up and down-arrow keys move you thru the "dur-mod" 
options of dotted, double-dotted, triplet, and straight. These 
also wrap around. Remember that with extreme note sizes (double, 
32nd, and 64th) you aren't allowed all the options, and may be 
able to reach allowed ones from only one "direction" up or down. 
 
Both ENTER and the numeral '0' toggle between Note and Rest of the 
current size and durmod.  So, with your non-mouse hand positioned 
over the arrow keys, you can now enter and edit music without 
taking your eyes off the flow of the music voice you're 
concentrating on. 
 
OTHER KEYS SET NOTE SIZES: 
Sometimes it may be quicker to hit one key for the size note you 
want. 
Owners of numeric keypads will like these new key actions: 
 
1 -- Whole note 
2 -- Half note 
3 -- adds Triplet to existing note 
4 -- Quarter note 
5 -- 32nd note (think 2^5) 
6 -- 16th note (say "SIXteenth") 
7 -- 64th note (might as well use the key) 
8 -- 8th note 
9 -- (escape to OS-9 Shell as before) 
0 -- flip between Note and Rest of same size 
ENTER -- same as 0. 
. -- add Dotted to existing note. (No quick way for rare Double-
dotted). 
SPACE -- cancels Dotted or Triplet, makes straight note 
 



All the above and the Arrow keys will briefly flash the Brush Rep 
over the mouse cursor to show what you got. Also these keys work 
no matter what your current Cursor or Brush is; Umuse3 remembers 
your last note size. They work only in the main score screen, not 
inside menus. And they don't affect your score, just your Brush. 
 
<end 4.7.2> 
 
<end Readme.One> 
 
 
 



Readme.Two   Version 4.7.5 thru 4.9.0 
 
 ----version 4.7.5----- 
 
Improvements to Version 4.7.5      91/09/29 

1. Transpose scores to new keys 
2. Individual enable/disable of each Part and each MIDI Channel 
3. User-set upper & lower limits on MIDI Note Numbers 
4. Automatic "Sleep" when you view another Window 
5. Playing more accurate, never loses time 

 
BUGS FIXED IN 4.7.5 

1. Tempos greater than 127 no longer show as Zero 
2. Bell "beep" sounds correctly 
3. No more Tied notes from nowhere 

 
BUGS FIXED IN 4.7.5B: 

1. Play no longer crashes 1-Meg systems. 
2. Umuse3 now works with unmodified Shell+ 2.1. 
3. File writes should be a little faster. 
4. Right edge of screen should be easier to click on with mouse 

to move a full screen to right, even  without the Hi-Res 
mouse adapter. 

 
 
NEW FEATURES and How to Use: 
 
Individual enable/disable of each Part, and each MIDI Channel 
-------------------------------------------------------------
Individual Parts (or Voices) can now be turned off, to make it 
easier to check the other parts, for multi-track recording, or 
play-alongs. 
 
Likewise each MIDI Channel can also be turned off, meaning any 
part currently assigned to it will not sound. This is handy for 
shutting up a given synthesizer in a multi-synth setup, or 
silencing all the percussion parts (usually all on channel 10 or 
16), or hearing nothing but percussion. 
 
To use these new features, go to the MIDI Menu to see the new plus 
'+' and minus '-' signs before the Part and Channel numbers. Plus 
means that part or channel is turned on. 
 
To turn a Part on or off, type the Part's number or letter just as 
if assigning it to a new MIDI channel, but after the --> prompt 
type '+' or '-' instead of a channel number.  To turn a Channel on 
or off, type the '+' or '-' first and then the Channel number. 



 
Typing 't' for Tutti ("all") lets you turn on all the parts and/or 
channels, and 'q' for Quiet lets you turn all off. 
 
When you first read a score or create a new one, all Parts used 
are initialized on, as is each Channel with at least one Part 
assigned to it.  Since Part and Channel enabling is just how 
you're currently playing, it is *not* saved or restored along with 
the score file.  It does not affect the score displays. 
 
Transpose scores to new keys 
You can now transpose all or part of a score to any new key. 
Unlike the MIDI playing transpose that just shifts the played 
pitches up or down, this new feature really rewrites the score in 
the new key, moving the notes up or down on their staves and 
changing the key signatures. 
 
To transpose the entire score, first use the "g[" and "g]" search 
commands to make sure you have no Left or Right Markers. Then from 
the BLock Menu click on Transpose or hit 't'. You'll be asked "How 
many Semitones" up or down to move the notes; type a minus sign 
before the number to move down. Semitones count both white and 
black piano keys between the old and new keynotes, so to go from 
key of C to E-flat is 3 semitones, from C to E is 4, from C to G 
is 7 (or down -5). 
 
Umuse3 will figure the new key signature and adjust all the 
accidentals (sharps, flats) correctly.  Any key signatures already 
in the piece will be corrected; if your piece started in E-flat (3 
flats) and went to A-flat (4 flats) halfway through, and you 
transpose it up 4 semitones, then it will now start in G (one 
sharp) and change later to C (nothing). You'll be asked whether to 
use 6 flats (Gb) or 6 sharps (F#) if either of these equivalent 
keys turns up. 
 
If you use a marked block with [ and/or ], only the inside portion 
of the score gets transposed.  A new key signature is inserted at 
the [, and the original signature is re-inserted after the ]. 
 
CAUTION: If transposing would move any note more than 15 lines and 
spaces from the centerline of its staff, that note gets pulled 
back an octave to keep it in range, so its part might play the way 
most people sing "And the rockets' red glare..." Use the Layout 
Menu's Range command to check for possible problems before 
transposing by large amounts. 
 



To test whether any notes got pulled back in a Tranpose, without 
listening to the whole piece, try this: After transposing, 
transpose the piece right back to the original key, using the 
negative of the number of semitones you first used. Now save the 
restored piece under a new name. Then use the OS9 shell escape 
(type '9') window to run cmp original.ume original.transp.ume or 
whatever you called the scores, to check for any changed bytes.  
(Make sure the original has already been upgraded to current score 
level 7, or you'll get lots of false differences.) If "cmp" shows 
no differences, then you know you can re-do the transpose and keep 
it. 
 
Upper & Lower Limits on MIDI Note Numbers 
The MIDI Modes submenu now lets you type 'n' or 'x' to adjust the 
minimum and maximum note numbers that will be sent to any synth 
during MIDI play. Note numbers out of this range will be "folded" 
(pulled back) into range by an offset of 12, or one chromatic 
octave, or more octaves if needed. 
 
Do you need this? Most synthesizers receive and recognize all MIDI 
note numbers in the range 1 thru 127, and do the folding 
themselves to get notes they can actually play. However, some 
synths (like the excellent Yamaha PSS-480) simply ignore notes 
below 25 or 12 and just drop deep bass notes. Check your synth's 
MIDI Implementation Chart under "Note On: RECOGNIZED" and set the 
new Min and Max Limits to be at least inside those numbers. 
Actually you could set them to equal the PLAYED limits listed in 
the Chart without affecting the sound.  Normally you shouldn't 
even touch the limits unless you suspect notes are being dropped. 
 
But even if your synth works fine with all notes, you may want to 
restrict the deep bass or extreme treble just because your 
cassette recorder or speakers can't handle the extremes. Also you 
can turn a block-chord chorale piece like "O Canada" into 
accompaniment chords by setting ridiculous limits of one octave 
(min and max only 12 apart) around Middle C, or about 55 thru 68. 
 
These limits are not part of a score, but are part of your system 
setup, so they are saved and restored with your default 
preferences in the SYS/Um3.Init file. If your Init file does not 
yet exist or is a previous version, the built-in default values 
are 13 and 108. 
 
 
Automatic "Sleep" when you view another Window 
Umuse3 automatically puts itself to sleep (unless playing or 
reading or writing files) whenever a different window is showing 



on your monitor. This keeps it from hogging processor power while 
not interacting with you. The earlier "Zzzzzz" command and its 
Dune quote are gone. 
 
 
Playing Timing Doesn't Lose Time 
Pieces with many voice parts used to gradually lose time and fall 
farther and farther behind a strict time accounting such as 
maintained by a commercial MIDI recording sequencer. A 
professional recording studio noticed this. Umuse3 now peeks at 
the OS9 system timer to detect whenever it's slipped a clock tick 
or two, and compensates for it.  Even without a MIDI sequencer, 
your ears may notice better playing of percussion patterns. 
 
 
BUGS FIXED 
Tempos greater than 127 no longer show as Zero. We apologize to 
any users who got the idea from this bug that Umuse3 only takes 
tempos up to 127, when the real top limit is about 240. Tempos 
above 127 played and saved perfectly, but displayed as 0. 
 
Bell "beep" now sounds whenever it's supposed to. 
 
Notes freshly created over rests no longer start out Tied. This 
same problem with Smashed rests and notes is also fixed. 
 
 
-----version 4.8.0---- 
 
Changes to upgraded UltiMusE-III version 4.8.0:  (92/02/11) 
 
Alto and Tenor Clefs added, for Viola and some Cello and some 
Trombone parts in classical scores. Check out the Clefs palette in 
the Layout Menu. They look like "Betas" centered on the middle 
staff line (Alto) or the 2nd line from the top (Tenor). The line 
each is centered on is the position of Middle C in its staff. 
 
In pitch, these new clefs are just one note above and below our 
"Guitenor" or "Ottava" clef (the Treble clef with '8' under). You 
shouldn't use them unless they're in sheet music you're copying, 
or you're scoring for Viola or a trombone part that was well above 
the Bass-clef staff. 
 
Our Tenor clef includes a line beneath for you to align with the 
bottom line of any existing staff that you're trying to convert to 
Tenor clef. 
The Alto clef is centered just as it looks. 



 
WARNING: -- any Level 8 score (.ume) file using these clefs will 
not play properly on any earlier version of UltiMusE. 
 
YOU MUST UPDATE your SYS/AllUm3.img file to use version 4.8.0! 
 
 
-----version 4.9.0---- 
93/4/29, from 9/92 
 
MAJOR FEATURES New to UmuseK 10.9.0 and Umuse3 4.9.0 

1. MIDI Events -- send any desired byte sequence to your synths 
--pedals, volumes, SysEx, big CASIO Sound Bank switches. 

2. Hard Copy Printing, both single screen dump (Ctrl-C) and full 
scores, now provided in the MM/1 version. 

3. All Menus now under Mouse Control -- less typing required. 
Especially the MIDI, INSTRS, and Expression (^) menus! New 
sub-menus for Expression volume levels, Instrs, etc. 

 
Miscellaneous small improvements: 

1. Can QUIT from Files menu. 
2. Hit the < and > keys (Shifted) to scroll Left & Right. 
3. "Brush" note cursor calls up Barline or Expression menus when 

clicked on a barline or expression item. 
4. next Play is always at normal default 'd' speed. MM/1) 
5. OSK Shell Escape window (hit '9') is true KWin overlay.(MM/1) 

 
 
MIDI EVENTS -- Details of New Feature 
The MIDI Standard allows many kinds of commands and data to be 
sent to a synthesizer. An UltiMusE "Event" is any such command 
that is not already covered by some more convenient or natural 
method. (You don't need events to play notes or change instruments 
in Umuse, but you *can* do these with Events just to see how they 
work.) 
 
Any MIDI command or event starts with a command or "Status" byte 
whose MSB (most significant bit) is set to 1, that is, a byte 
ranging from Hex 80 up to FF, or decimal 128 thru 255. 
 
This may be followed by a few "Data" bytes whose MSB must not be 
set, thus ranging from Hex 00 to 7F or decimal 0 to 127. 
 
HEX NOTATION: 
All synthesizer manuals and MIDI books use Hex notation, and so 
does Umuse, so we'll stick to it here. A Byte represents 8 binary 
bits of data, each bit being 1 or 0. The right-hand, least 



significant 4 bits are the "low nybble" and the left-hand most 
significant 4 bits are the "high nybble." In Hex notation a byte 
is written as two characters, one for each nybble. Each character 
is from 0-9 or A-F, where A-F mean 10 thru 15. 
 
MIDI conveniently divides the functions of a byte between the two 
nybbles. 
 
EVENTS: 
MIDI Events are of two types: Partwise ("Channel"), and System. 
System events start with a Status byte of F0 thru FF, and affect 
all channels on all synthesizers connected. The low nybble tells 
what the command means to do. 
 
Partwise events' status bytes range from 80 thru EF. A Partwise 
high nybble tells what the command is to do, and the low nybble is 
the MIDI Channel to be affected. Note that this nybble goes from 0 
to F or decimal 0 to 15, so mentally add 1 to get human channel 
numbers 1 thru 16. 
 
Normally Umuse automatically fills in the channel number belonging 
to the Part you assigned the event to. 
 
Here's what the commands do, where 'n' means Channel Number. Keep 
in mind the neat high-low nybble split. (Commands in (parentheses) 
were already available in Umuse by easier means.) 
 
Status    Data1     Data2 
------    -----     ----- 
(8n)      note      velo      (Turn a note off) 
(9n)      note      velo      (Turn a note on) 
An        keypressure         Polyphonic key pressure (after-
touch) 
Bn        ctrl_no   value     Change a given control to new value 
(Cn)      instr               (Change instr. patch on channel n) 
Dn        pressure            Channel pressure "Monophonic 
aftertouch" 
En        HiVal     LoVal     Pitch-Bend wheel or joystick 
F0        MfgrID    lots more.System Exclusive message begins 
F1        message             Quarter-Frame message 
F2        HiPos     LoPos     Song-Position Pointer for sequencer 
F3        SongNo              Song Select for sequencer 
F4   not used 
F5   not used 
F6                            Please Tune Yourself 
F7                            End of System Exclusive message 
(F8)                          (Timing CLock tick) 



F9   not used 
(FA)                          (Start sequencer, drum machine, 
etc.) 
FB                            Continue sequencer, drum machine 
FC                            Stop the sequencer 
FD   not used 
FE                            Active Sensing ("I'm alive") 
FF                            System Reset (not advised) 
 
 
HOW TO ENTER EVENTS IN SCORES: 
Use the up-arrow cursor from the Toolbox, the same as for 
Instruments, Volumes, and other Expression items. Click it on any 
score item you want to insert an Event ahead of; this pops up the 
Expression Menu as usual.  Mouse the black bar over either of the 
Event entries (they work the same) and click, or type 'e'. 
 
You'll be prompted to type in the bytes, in Hex. Do that and hit 
ENTER. Separate the bytes with spaces.  You may omit leading 0 
high nybbles. 
 
If you entered a single command, of no more than 4 bytes, Umuse 
will check your entry for some errors -- the first nybble must be 
8 thru F, and the number of data bytes must agree with the table 
above. Umuse will fix these errors for you, except where you gave 
too few data bytes; then Umuse warns you to come back and re-enter 
the event. 
 
You should enter only one command per event-item at first, till 
you get some experience. But you may type any number of Hex bytes, 
up to 255, into one Event item in the score. If so, you are 
responsible for getting the numbers of data bytes right. Synths 
are supposed to recover quickly from mismatches, fortunately. 
 
Long events are handy for combining several related Partwise 
events, but are absolutely necessary for "System Exclusive" 
messages. For example, the notorious command to make a Casio CT-
650 (did I get that right?) switch between tone banks of 
instruments is: 
 
F0 44 3 0 7n 51 21 F7    to switch to the "Other" bank 
F0 44 3 0 7n 51 20 F7    to switch back to the usual bank 
 
where the 'n' in "7n" is the "Basic Channel No." and is probably 0 
unless you set it to something else from the control panel. So use 
"70" above. 
 



Partwise Events (that don't start with F) can be entered only if 
you clicked on a Note/Rest or an Expression item belonging to a 
note/rest and so belonging to a Part or voice. This includes 
Instrument changes, Levels (ppp-fff), Channel Hops, and other 
partwise Events -- anything hanging out in front of a note/rest.  
If you clicked on a Barline or other non-Part item, you may enter 
only System (start with 'F') events. 
 
PLAYING EVENTS 
When you enter a Partwise event, Umuse remembers the Part Number 
of whatever you clicked on and stores that in the event. When the 
event is played, Umuse finds the Status bytes 80 thru EF in your 
event string and slips that Part's current Channel number into 
their low nybbles on the way out to the synth. 
 
So you needn't worry about channels -- just always type 0 for the 
low nybble on any Status bytes.  Remember, a Part's channel is set 
up in the MIDI Menu and can be changed on the fly by Hops. 
 
(We built in a loophole in case you want to "hard code" an event 
to a particular channel. If you type a Status byte's low nybble as 
non-zero, then that byte is sent exactly as you typed it and its 
low nybble plus 1 determines its channel. This loophole won't work 
on Channel 1, since its low nybble is 0 and Umuse will patch in 
the part's channel.) 
 
Any System (F) bytes in a long Partwise event will be sent as-is. 
What about Partwise status bytes in a System event string? They 
are all sent as-is, even if the low nybble is 0, since the score 
has no Part and Channel associated with the System event item. 
 
You can disable Events from playing at all in the MIDI Modes Menu, 
right next to the Instruments and Clock controls. 
 
 
VIEWING EVENTS -- WHAT THE HECK DID I PUT IN THERE? 
If you clicked on an Event to enter another, you'll get an extra 
dialogue box before entering your bytes. This box prints out the 
existing event (very handy) and then you may enter your new one 
ahead of, after, or over the old one -- or just look and leave. 
 
Events display as capital E's in the score. Partwise events 
display in front of their note/rests, and System events are up top 
with other general expressions like Tempos. 
 
To see what you have in an Event, have either the note/rest Brush 
or up-arrow Expression cursor on the mouse, click on the 'E', and 



click on the Event entry in the menu.  Read the Event's contents 
in the dialogue box, then click anywhere or ENTER to exit. 
 
 
SUMMARY -- RAH-RAH-RAH 
MIDI Events open up new worlds.  You can get inside your synths 
and change sounds and modes not accessible from the front panel 
controls, and automate drum machines, sequencers, mixers, tape 
decks, and other professional studio gear. 
 
Talk to other MIDI users and read books and magazines to learn 
what you can do with events. Be aware, though, that many actions 
are specific to each make and model of synth, so scores arranged 
for your setup may do nothing (or worse) on someone else's 
equipment. Be sure to describe the events you've used when 
uploading a score to a bulletin board service. 
 
 
PRACTICE 
Just to try out Events, take a score that has some Instrument 
changes in it. Play it. Go to MIDI Modes menu and disable 
Instruments. Play it again, notice no sound changes. 
 
Now click on a note or rest and enter an Event: 
 
C0 nn 
 
where nn is the Hex for some Instrument number valid for your 
synth. (If your synth numbers sounds from 1 instead of 0, subtract 
1 before converting to Hex). 
 
Play it again, Sam, and you should hear the sound change. Add some 
more, have fun.  Then go to MIDI Modes and disable Events. Play 
again, no sound changes.  Re-enable Instruments to get your old 
piece back. 
 
Some things to play with that Umuse couldn't do before include the 
invisible Volume control (B0 7 vv) and Sustain Pedal (B0 40 oo, 
where oo = 7F on, == 00 off). To release the Sustain Pedal when 
harmonies change and instantly apply it again, enter one Event as 
b0 40 00 b0 40 7f. 
 
 
TECHNICAL NOTE 
Event items of 4 bytes or less are stored right in the score 
objects. Longer event strings are stored in a separate memory 
array, with a pointer to each one in each score object. These data 



are written at the end of disk files, following a 16-bit count and 
an "EA" byte. This is all automatic and invisible and you needn't 
worry about it. 
 
<end of 4.9.0> 
 
<end of Readme.Two> 
 
 
 
 
 



Readme.Tre (Three)  versions 4.10.0 thru 4.10.0a and 10.10.1 
plus general info on Options and Printers. 
 
----version 4.10---- 
 
IF YOU HAVE 4.9.0, TRASH IT and REPLACE WITH 5.10.0! 
 
Features Added to Version 4.10.0 from 4.9.0 

1. Append (Splice) two scores together -- at last! 
2. Accents and Layoffs for easier volume expression 
3. Letter Labels in Scores 
4. Score Printing vertical squeezing can be turned off 
5. Score Printing supports CGP-200 printer 
6. Barline Menu gives mouse separate choices of Begin and End 

Repeats. 
7. Cursor Snap (MM/1 only) 

 
 
BUGS FIXED from 4.9.0 to 4.10.0 (and 10.9.0 to 10.10.0) 

1. After one Block Play, you got a freebie block play (and maybe 
a crash!) with any Goto_Search, Transpose, or adding bars at 
end. This bug was born when we moved some more operations out 
of Umuse-3's main body and into the Um3TranGo subroutine 
module. 

2. Barline Menu wouldn't respond to typed Keyboard characters 
(Coco) 

3. Barline Menu's inverted-video "cursor" misaligned with text 
by one vertical pixel, looked sloppy (also in 10.9.0). 

4. In 10.9.0, keyboard selection of repeats allowed unshifted 
'8' and '9' for '(' and ')'.  These matched the Coco keyboard 
but not the MM/1's PC keys, so these are now '9' and '0'. 

 
 
---------------DETAILS OF NEW FEATURES------------- 
 
APPEND TWO SCORES 
You can now splice a .UME score file to the end of the score 
currently in memory. This lets you edit a large piece in smaller 
sections. To append, simpy type F-A or mouse Append on the Files 
Menu, and select the file to be added on. 
 
You can't splice just any two random scores together. The Append 
function first checks the file score for compatibility with the 
current score, and cancels out if any of the tests fail. 
 
First, the file score cannot have more Parts than the current 
score in memory. Fewer parts is OK but you'll be warned anyway so 



you can Refill the empty parts from the Layout Menu later if 
desired. 
 
Second, remember Parts are numbered from 1 up to 16.  Each part in 
the file score must have the same Clef type as that same number's 
part has in the current score. They don't have to be on the same 
staff, but the clefs must match. 
 
Also, either both or none of the same-number Part must be the old-
fashioned Percussion type, shown as "hollow" half notes in the 
Layout Menu's lower right-hand corner palette. Notes in such a 
Part are not affected by either form of Transposing. (These old 
hollow percussion types are not recommended for new scores; 
instead, use the Percussion Clef.) 
 
Any mismatches or warnings show in a large window while Append is 
working. If the window appears and disappears, that's good. Now 
the actual reading and splicing of the file score takes place. 
 
Append inserts a Double Barline and either a 2nd such barline or a 
Time Signature to mark the "joint" between the scores. You can X 
these out afterwards if not needed. It's wise to begin the file 
score with a time signature, and also key signature if different. 
 
Warning -- almost all non-score info in the file score is thrown 
away.  
This includes instrument table, MIDI Channel assignments, volume 
levels, sec/min, MIDI Transpose, and Title Banner. So make sure 
that any Instrument changes in the file score agree with the 
current score's instrument numbers. Likewise the MIDI channels and 
other items. 
 
The file name stays the same as the first score, so be careful 
about saving with F-S; maybe use F-W instread. 
 
 
ACCENTS and LAYOFFS 
New to the Expression Menu is the Accent. You can insert one on a 
Note/Rest, a Barline, or before just about anything. It's a 
"general volume" expressor that displays as caret or up-arrow '^' 
at the top of the screen. In printed sheet music accents are 
notated the same, or sometimes the 'V' symbol is lying sideways. 
 
On Play, all notes that begin at the same time as the Accent 
(shown just after it on the screen) will be struck with a MIDI 
volume level N points higher than each note would have played 
without the accent. The value of N is the "Accent Weight" that you 



have set in the MIDI Modes Menu. Default is 12, but your own 
setting is saved to your Preferences Init file if you Save in the 
Options Menu. 
 
A Layoff is a "negative" accent that reduces the volume of 
affected notes by the same Accent Weight value. It displays as a 
minus sign '-', but is usually printed in sheet music as a 
horizontal parenthesis hugging its note body. 
 
The MM/1 lets you set Layoff Weight separately from Accent. 
 
Accents and layoffs can work wonders in making your scores sound 
more "live" and less mechanical. Usually the first note in a 
musical phrase is accented, and the last note laid off. A more 
subtle accent can be faked by laying off the preceding note -- 
never fails. If it's a vocal piece, speak the lyrics as normal 
English and hear which syllables are accented or laid back. Two-
syllable words like "table" and "lover" always benfit from laying 
off the second syllable. Amazing things can be done to percussion 
parts -- for example, given 4 4/4/ beats worth of 16th note snare 
drum hits, try accenting every 3rd one. The measure of 16 dull 
notes takes on a whole new rhythm. 
 
 
LABELS IN SCORES 
You can now insert Labels of one or two characters on any Barline, 
using the Barline Menu that you get by clicking the regular Note 
Brush on a barline. Displayed at the top of the score, these 
labels are handy rehearsal markers in hardcopies, and can be 
Goto'ed while editing. 
Future versions may let the music player jump to or call these 
labels. Your ear and the sheet music will suggest where to stick 
labels for help in finding sections later. 
 
Use any characters except star '*' and question '?', since these 
have special meanings in Goto search expressions. 
 
You search for any label by typing "gl", or the next label 
offscreen with "g+l", previous label with "g-l", etc. You can 
limit the search to a given lable by typing its character(s) after 
the "gl", as in "glA1" to find A1. 
 
You can do even better with wildcard symbols. Question means "any 
one character" and Star means "any zero, one, or two characters." 
So "glA?" will find any two-character label beginning with capital 
A, but "glA*" will match a lone A or A followed by any character.  
But "glA" finds only lone capital A. 



 
 
SCORE PRINTING SQUEEZING NOW OPTIONAL 
To save paper and improve readability, hardcopy has always 
compressed each score screen vertically as much as possible.  
However, some users set up space between staves to handwrite 
lyrics or guitar chords, and didn't want it squeezed out.  
Hardcopy now asks if you want the compression.  Normally you do. 
 
 
CGP220 PRINTER SUPPORT 
Hardcopy now makes a better attempt at spacing pages correctly on 
the Tandy CGP-220 color inkjet printer. Its nonstandard vertical 
graphics pitch made the pages too long before. 
 
Some new printers also use wider vertical pitches, and some do 
tricks like adding their own formfeeds when too close to the page 
bottom. The next version of UltiMusE will allow for these and 
other printer variations and user options. 
 
 
CURSOR SNAP (MM/1 only) 
Cursors "snap" to the center "hot spot" of whatever item would be 
selected if you pushed the mouse button. This works only on the 
main Score screen. The pull-in range is small, same as the 
original selection range, so the effect is pretty subtle. So 
there's no way to turn it off. 
 
<end 4.10.0> 
 
 
-----versions 4.10a (Coco) and 4.10.1 (MM/1)------ 
 
Time Signature now defaults to 4/4 on startup instead of 0/0, 
which had been confusing both musicians and the play routine for 
years! 
MM/1 version has a "hidden treat" -- any time the main score 
screen is showing, hit capital 'L' or 'R'.  'L' draws lines to 
connect all the notes of each part separately, skipping over 
rests. 'R' does same but includes rests.  These lines help you 
sort out parts in chords faster than plugging away with the '?' 
tool. This is really a warmup for "beaming" groups of notes 
together, and uses real K-Windows system calls. 
 
 
Versions 5.10.0 (Coco) and 11.10.0 (MM/1)  [Note: new leading 
digit!] 



 
FEATURES ADDED: 

1. New Vendor, replaces Kala Soft 
2. "Play" creates a Standard MIDI File 
3. Files Menu improvements 
4. Part-Sort cleans up "chord" parts on a staff 

 
DETAILS OF 5.10.0 Improvements 
 
NEW VENDOR will provide better service and support than 
previously. Pricing will stay about the same.  Upgrades will now 
cost a nominal fee (from $5 to $15) except for a major bug fix. A 
3rd edition of the Manual will be published later this year. We 
incremented the Version number's leading digit to mark this event. 
 
 
STANDARD MIDI FORMAT FILES 
These .MID files have become the standard interchange format 
between PCs, AMigas, Ataris, and Macs.  Now the Coco and MM/1 join 
the club with UltiMusE, so you can write out your work in .MID 
format and export it to users of these other machines. 
 
Creating a .MID file from a score is as easy as Playing it.  Just 
use the MIDI MODES Menu to select the new output option (hit 'f' 
or click on "std midi File"). This also turns off normal synth 
playing, and turns on the "Debug play" option so you can follow 
the action. 
 
Then exit that menu and Play as usual. You'll be prompted for a 
file name; hit ENTER to cancel. Otherwise Umuse appends ".mid" to 
the name you gave, and Play writes the encoded bytes into the new 
file in your current working directory (PWD). It will silently 
overwrite an old file by the same name. 
 
The name you type can include a leading device and/or path, as in 
"/d2/export/yankee_doodle" (is OS-9 great or what?). 
 
There are no other modes or options involved.  But -- all of your 
MIDI MODES options do control what goes into the file! If you want 
Instrument changes and Events in the file but not Clocks, be sure 
to set those modes accordingly. Likewise the quantities like 
Accent weight, Transpose, etc. 
The .MID file will get exactly what your synth would have gotten 
in a normal direct Play. 
 
Please take this new opportunity to share your work with the rest 
of the MIDI world. 



 
 
FILES MENU IMPROVEMENTS 
You can now Kill (delete) files from the same form of menu that 
you read or write from. Like Write and unlike Read, Kill requires 
you to click on the KILL word after clicking the file name into 
the box. Now you can easily clean up after a session that leaves a 
lot of slightly different backup versions of a score, without 
typing long names. 
 
To fit more files (up to 78), three columns are now used.  MM/1 
will use 2 columns if there aren't many files. Both versions clean 
up the screen better afterwards. 
 
File names are now sorted alphabetically, reading horizontally 
across the columns. Note that capital letters come before their 
small mates. 
 
We stomped a bug that started off the list of files with a blank 
item, and probably threw in filenames that didn't belong. 
 
NOTE-SORT OF "CHORDS" 
A new function lets you clean up the appearance of a staff that 
has 2 or more parts that are just different notes of chords, as in 
a rhythm guitar or left-hand piano part, where the different 
parts' notes have the same rhythm timing and duration, just 
different pitches. 
 
To make these readable, the Umuse tradition is to use the Layout 
Menu to make only the top part in such a group show the "flags" on 
its 8th notes and smaller notes -- the lower voices are made stem-
only (Yes, that's what the 2nd of the 4 note styles in Layout 
Palette is for. And see ReadMe.For for their new Clone function). 
 
But many Ultimousers weren't careful to put the highest-pitched 
notes in the uppermost part on the staff, so when you do the 
above, sometimes the flags belong to a note in the middle or on 
the bottom, making a strange, hard to read score. 
 
Note-sort fixes all the notes on one staff so the lowest-numbered 
part on that staff has the highest-pitch note, and so on. 
Afterwards, make sure only the lowest-numbered part shows note 
flags (but if all stems are downwards, put the flags on the 
highest-numbered part). 
 
NOTE: Rules have changed in versions 6.10.3, 12.10.3 and above! 
 



To sort a staff, set end markers [ and ] if desired, then get the 
Block Menu and click "Sort notes" or hit 's'. You can use the 
hidden capital-L command to connect the parts with lines before 
and after using the command, just to see if it was needed. 
 
Note-sort is smart enough not to adjust notes whose timing doesn't 
match the other parts on the staff. However, if you have any such 
parts on a staff along with the chord parts you want to sort, you 
shouold temporarily move them off onto another staff (easy in 
Layout Menu) before applying Note-sort. 
 
 
<end of 5.10.0 and 11.10.0 updates> 
 
 
----all versions ---------- 
 
SETTING UP YOUR OPTIONS PREFERENCES 
 
Some customiziing you will need to do yourself, to create an 
options file, hidden in the SYS directory. We didn't make one for 
you since we don't know your exact setup.  Here's how: 
 
After starting up Umuse3, you'll be asked two questions about your 
mouse. 
Answer these, and then your mouse cursor should work smoothly. 
Now go to the Options Menu and hit "File the options" to save the 
mouse settings. If you mess up the mouse questions, you can still 
go to Options and fix them from the keyboard. 
 
If you don't like the screen, re-enter Options Menu and go to 
Screen Colors. Set the slider to Background, and turn on RED. If 
this is too bright, turn off GREEN. Once you like the colors, be 
sure to hit the "OK--Keep" button; then click outside the menu or 
hit ENTER to get back to Options. Hit "File" to save the colors 
along with the mouse and MIDI settings. 
 
Many other options from the MIDI Modes Menu can be saved too, but 
the save must be done from the Options Menu. 
 
From now on, each startup of Umuse3 will know about your mouse and 
start up in your chosen colors, etc. 
You need never do this again unless you change some option(s) and 
want to update the options file. 
 
 
 



Last revised at Version 4.7.1 90/11/06: 
 
PRINTERS and FREE LINEFEEDS 
When using the new Score Print function ('h' key on Random Menu) 
to print a full score, remember that Umuse3 assumes that all Tandy 
(Radio Shack) printers add a free Linefeed (LF) for every Carriage 
Return (CR), and sets them up that way. Some Tandy printers, like 
the CGP-220, have no way to turn off the free LF, so it's simplest 
to make sure all Tandy printers add the LF. Umuse3 turns ON the 
free-LF mode of all Tandy printers. 
 
Also Umuse3 assumes that any non-Tandy printers (beyond the first 
three on the Options Printer Menu) _will_not_ add a freebie LF to 
any CR. Umuse3 turns off the LF mode on IBM compatibles, but for 
Epson types you must make sure it is off yourself. 
 
So -- if you select a NON-Tandy printer (beyond the first three), 
make sure its Auto-LineFeed Mode is OFF. 
 
The XMODE /P LF or -LF mode in OS9 has no effect on Umuse3's score 
printing, but if you have -LF set then you're depending on your 
printer's free LF. Good if it's a Tandy model; otherwise you'll 
have to twiddle your printer switches to turn off the LF. 
 
In the future we'll provide an LF mode within Umuse; meanwhile 
remember that some Tandys can't turn it off, and you must turn on 
Epsons by hand. 
 
TROUBLESOME TANDY PRINTERS 
Some users report vertical page slippage on Tandy DMP-105 series 
printers. Our own DMP-105 works fine. If yours is not feeding 
enough paper per page, make sure the paper feed is not slipping.  
If the problem really is in Umuse3, please check the printed music 
carefully to see whether anything has been left off the bottom of 
any line of music -- this clue will help us find the bug when you 
call us. 
 
Some DMP-130 thru 133 printers try to add a left margin, even 
though we send no margin code. If this happens, abort the print, 
turn printer off and back on again, and try again. Don't buy on of 
these printers for any grafix use! 
 
The CGP-220 shifts to an increased vertical pitch when in Grafix 
mode, so its scores always run down into the next page. When we 
figure out just what the grafix pitch is, we may allow for this.  
Chalk up another win for Tandy's manual, which says nothing about 
this. 



 
ABORTING PRINTS in 4.7.1 
Due to problems with OS-9's Pipes, Versions 4.7.1 and up no longer 
uses BREAK or CTRL-C to abort prints in progress. Instead, type a 
small 'q' at any time. You won't see any echo of it, but printing 
should stop neatly after printing the current screen. Preview 
printing now uses a "yes/no" dialogue to allow early quitting. 
 
<end readme.tre> 
 
 



Version 6.10.0      95/9/18 
 
VDG Screen not needed anymore, even in Boot! 
 
Version 6.10.3 and 12.10.3      96/3/30 

1. NEW VENDOR -- Glenside Coco Club 
2. "Clone part" Chord Features 

a. + cursor pulls new notes out of old 
b. Flagless notes now mean something in Layout Menu 
c. MIDI channel assign by clone groups 
d. part reorder 
e. "Sort Parts" now "Sort Notes", respects stems, clones 

3. Note pitch carryover option 
4. Part-copy transposes to fit target clef 
5. L and R cmds to connect notes of same part 
6. Smaller Toolbox with simpler mouse control 
7. Finder-Filter for sorting out note/rest pileups 
8. Cursor-snap optionDialogue boxes pop where cursor is 
9. Less drift of notes on redisplayFast Rep-flash on note pickup 
10. Bug fix re chip/bombing of notes 

 
NO MORE VDG SCREEN 
Coco3 users need no longer keep VDGInt in their boot or use a 
separate "games" boot disk to run UltiMusE-III. Umuse3 creates its 
own official L2 window to run in, and can be started in any window 
type (including VDG). If you type Umuse3& and two ENTERs, you can 
keep using the parent window too. 
 
CLONE-PARTS MAKE CHORD WRITING EASIER 
It's a nuisance writing chord-accompaniment tracks like rhythm 
guitar or left-hand piano chords. If you've been writing 3-part 
chords and need a 4th voice, you have to go to Layout Menu to add 
it. Maybe you remember to put its stem the right direction and use 
a non-flag note. And now this 4th part lays a smudgey Rest over 
all your 3-part chords. 
 
It's lots easier now. Start off a rhythm/chord track in Layout by 
creating only ONE Part, with flags and stem Up or Down but not 
Middle. Put in the first note of the first chord, or one note of 
several chords. Now change the usual Brush cursor to a '+' by 
clicking the new + icon in the Toolbox or typing '+' or '='. See 
that the + icon in the Toolbox changes to the old Brush. Put the + 
cursor over the first note and press and hold the button. A 
dialogue box asks whether to add another "Clone" part -- say yes. 
 
Again press and hold the mouse button over the note, then drag up 



or down. The original note won't change, but you'll pull a new 
note out of it!  Set its staff line and sharp/flat as usual. 
 
You can now do this on some of the other one-note chords, or 
repeat on the first chord (either note) to add another Clone part 
(3rd voice), then 4th, etc. Best to set up all the voices first on 
the first chord. 
 
Better yet, turn on the new Note Carryover mode in Options Menu. 
Now go to a chord that's still just a Rest, with the + cursor, and 
give a long click over the Rest without moving the mouse. It will 
turn into the first note of the previous chord. Still without 
moving the mouse, give another long click, and the 2nd note of the 
previous chord is duplicated! Keep clicking till you've cloned the 
whole chord. You can change each note by moving the mouse while 
you're still holding that note. 
 
Once you've let go of a "plus" or "cloned" note, you can't adjust 
any note at all with the + cursor (but you can lay a Note over a 
Rest). Get back to the good old Brush by punching it in the 
Toolbox or typing '+' or '=' again. 
 
Go check the Layout Menu, and you'll see the extra Clone parts (no 
flags) added. You could also pre-define clone parts there before 
writing chords; they will not add more Rests to the score screen. 
You can still convert between "Flagship" parts and clone parts by 
picking up the new type of "note" from the palette and dropping it 
on the part in its column, same as before.  However, you'll be 
asked whether to remove all Rests, or restore Rests back in. This 
is a handy way to clean up useless Rests from old scores. 
Restoring rests really fills them in every nook and cranny between 
notes, unlike the existing Refill. 
 
Those flagless parts now really mean something. You can delete 
clone parts with the 'X' cursor. They don't leave Rests anywhere. 
But don't use clones with Middle-stem notes (stem both up and down 
in Layout) -- that would end up making a mess later. 
 
The new auto-cloning from the Plus cursor means you don't have to 
plan ahead how many voices per chord staff or track. But after 
working on a piece, your parts will look pretty messed up in the 
Layout, and confusing when you use the '?' cursor to check Part 
numbers. To sort things out, use the new ReOrder Parts in the 
Layout Menu to renumber the parts in a logical order. You can 
regroup all parts, or just those on one staff. If you choose all, 
there's a choice of keeping all clones with their flagship leaders 
(usually best), or segregating the clones to the right-hand 



columns (makes it easier to see how many Flagship tracks you 
have). All MIDI Channel and part-enable tables are automatically 
updated for the new part numbers. 
 
The old Block Menu's "Sort Notes" (formerly Sort Parts) now works 
really well with cloned-up chord voices. It sorts groups 
separately by stem up or down, and ignores middle-stem notes.  As 
before it keeps note flags from appearing at "half mast." 
 
The MIDI Menu has a new "Klone chans" that will assign each Clone 
part the same MIDI Channel as its flag leader. You want this for 
most synths. To get best use of low channel numbers, do this: 
 

a. Layout Menu: ReOrder all staves' parts, segregated. This puts 
the flag leaders for each track up front. 

b. MIDI Menu: 'I' for Individual Parts. 
c. Layout Menu: Optionally ReOrder all again, say No to 

segregation. 
d. MIDI Menu: 'K' to clone the channels.  The highest channel 

used will equal the number of flag parts. 
 
All the above features are great for cleaning up old scores and 
making sure that new ones don't get messed up, and of course 
you'll write them much faster.  If there's a "Frances_Rag.ume" on 
your new disk, check out the Clone usage in there. 
 
STAFF SORT 
If you add more staves or drag the old ones up and down, they 
might no longer be numbered in order from the top down. This 
causes confusion on commands like Sort Parts that prompt for a 
staff number -- you count down from the top but are wrong. Left 
edge of Layout Menu shows you their numbers. To fix this, in 
Layout Menu punch "Staves" or type 's'; you'll have a chance to 
renumber the staves, followed by a chance to spread them evenly as 
in older versions. 
 
FINDER-FILTER 
Tired of trying to pick a particular Note or Rest out of a pile of 
them on the same screen location?  The good old Pick Depth (SHIFT 
and/or CONTROL on Coco, ALT-1,2,3 on MM/1) still doesn't guarantee 
what you'll get.  Now you can tell the mouse to find certain 
note/rests and ignore others.  Click on the Toolbox's new Filter 
icon (looks like a piece of screen door) or type 'F' or '#' to 
bring up the Finder Filter Menu. 
 
Here you can turn on or off recognition of notes versus rests, 
stem directions, and Flagships versus Clones, and/or restrict the 



picking to a single Part.  If you hit "One part" a slider submenu 
lets you choose the part. 
 
Sometimes you'll be unable to pick a certain note or rest -- be 
sure to check the Filter Menu to make sure you haven't turned that 
item off.  Hit 'e' for "Everything" to enable all selections. 
 
CURSOR SNAP 
Options Menu can turn on a mode whereby the cursor is "magnetic" 
and snaps over to the nearest item that you could click on. You 
may find the mouse or joystick easier to use this way, especially 
if not using the little Hi-Res Interface box. This mode does eat 
extra processing power, so you may want it off when running a 
terminal program or other time-critical job in another window.  
The MM/1 version has had this feature for a while, but until now 
no way to turn it off. 
 
TOOLBOX and "REP" CHANGES 
The Toolbox is now not as wide, even though offering more icons 
(the Plus/Brush and Filter Screen). The "Rep" at its right side 
still shows your current active cursor and note/rest size. But 
the rules of operation are simpler and better now: 
 
The Rep can no longer be detached from the Toolbox, and shows if 
and only if the Toolbox is showing. It can still be flashed with a 
quick click over nothing to show the current note/rest size, and 
flashes on for about 1/2 second. 
 
The Rep also flashes when you "pick up" a note/rest with a quick 
click as before, but now for a VERY SHORT TIME so you can tell the 
pickup was successful. 
 
You still dismiss the Toolbox with a quick click to its Rep, but 
bring it back with a double-click over nothing (MM/1 users please 
see below). The double-click will also move the Toolbox to the 
cursor if it's already showing. Drag it up and down by the Rep as 
before. The top Menu Bar still turns Tools on/off, but with the 
new double-click you can bring it up and dismiss it so easily that 
you needn't keep the Toolbox on the screen all the time. 
 
A long click or drag over nothing still has no effect, unless you 
slide into something -- same as before. Future versions may have 
"stroke commands." 
 
MM1 users can't double-click yet, but instead use a "medium click" 
over nothing to bring up the Toolbox.  This is a bit longer than 



the staccato click used to pick up a note/rest or flash the Rep. 
Windio 54 should allow the double click in the next version. 
 
SMALL STUFF 
To draw lines connecting all the notes of each Part together on 
the screen, type 'L'. To include Rests, type 'R' instead. Great to 
use before and after a Sort Notes on the Block Menu. 
 
Yes/No and Alert dialogs now pop up where your mouse cursor is at 
the time, helping keep your eyes focussed on the job at hand. 
 
BUGS & MIS-FEATURES FIXED 
Part-Copy (with the black square cursor) now transposes the notes 
to match their new staff. 
 
Score display doesn't drift sideways as much when you chip/bomb 
rests near the side edges. 
 
Alto and Tenor Clefs were mixed up in the Layout Menu. 
 
A rare bug with large "bomb outs" is fixed. 
 
 
Version 7.11.1 96/2/25  (same number 7 now used for MM/1 OSK) 
 

a. SHAREWARE or maybe Freeware -- no Vendor 
b. New "Basic" Manual doc, with "Advanced" planned 
c. Instruments (Patches) greatly improved: 

a. 64 instruments, vs old 16 
b. Names up to 15 characters, vs old 9 
c. Menu tools to move and swap instrs around for quick 

changes 
d. option for "sticky" tool cursors 
e. Menus show which instrs are currently used in score 
f. Menus scroll to show all 64 instruments 

d. Titles Comment Box now up to 9 lines from old 4 
e. Squawker "?" Tool shows Part affected by Partwise Expressors 
f. MIDI Events don't waste memory on duplicate byte sequences 
g. No mouse-dirt on MM/1 startup screen 

 
SHAREWARE/FREEWARE 
Enough fooling around with vendors! UltiMusE-3 and -K are now to 
be freely distributed by anyone, on BBS, Internet, or copying 
disks. It's still copyrighted, and one restriction applies -- you 
must pass on the ENTIRE package, meaning all 9 executables, 
Images, and the Docs (so new users don't get frustrated). Details 
are in the Basic Manual. 



 
INSTRUMENTS 
MORE and BIGGER: You can now use up to 64 instrument names and 
numbers. The Menu can't show them all, so you can scroll forward 
and backwards with the mouse, the arrow keys, and PgUp and PgDn on 
the MM/1. Likewise on the submenu that pops up if you choose 
Instrument in the Expression Menu. Names can have up to 15 
characters. Your score files will be longer, but will contain only 
instruments that are defined in the table. 
 
COMPATIBILITY: Old scores will read in just fine. Scores written 
under Level 11 will read OK on older Umuse versions, but only the 
first 16 instruments will show and play, truncated to 9 
characters. If the score contains I16 or higher, random 
instruments will get selected on the synthesizer. If you want 
others with older versions to play your work, please restrict 
yourself to I0 - I15 in the score; the new in-use tag and new 
Tools will help. 
 
IN-USE TAGS: Both menus tag, with a '>', those instruments 
currently in use in the score. This is helpful with the new tools 
and lets you clean out unused instruments and check for usage 
above I15 for compatibility with old versions. 
 
NEW TOOLS let you copy, move, swap, or delete instruments from the 
Menu table (not the score). When you select Kopy, Move, or Swap, 
the cursor turns to a hollow square. Click this on the "source" 
instrument to move, and the cursor turns solid as it "picks up" 
that instrument. 
Now click it on the "destination" or "victim" instrument, which 
gets replaced by the source. The source also gets clear (if Move) 
or changed to the destination (if Swap) or left alone (if Kopy).  
X-out (delete) gives an X cursor.  
 
After each use the cursors revert to the usual arrow and must be 
selected again for more instrument moving -- unless you've gone to 
the Options Menu and turned on "Sticky Instrument Tools". Then 
your chosen tool stays active so you can keep moving or deleting 
instruments. Clear it back to the normal arrow by clicking once or 
twice on nothing (or hitting ENTERs); then one more nothing or 
ENTER will exit the menu as usual, or you can select another Tool. 
 
A lot of time gets spent trying out different instrument 
combinations to get the best effect for a piece. But now, instead 
of going thru the score chaning I-expressions, you can just once 
set up I0 as the solo voice, I1 as the rhythm accompaniment, I2 as 
the bass, etc. -- and then just swap different instruments on the 



Instrument Menu in and out of those active slots. No need to 
tinker with the score during "auditions". You can load up dozens 
of your favorite sounds in the higher slots and try them out in 
I0, I1, etc. 
 
TITLE BOX 
You can now have up to 9, versus old 4, title lines to describe 
your piece (still 51 characters long). Only the first 4 lines will 
show up in older Umuse versions. Hardly any bytes are added to 
your file unless you use lines above 4. 
 
MISC. 
When you click the Squawker '?' cursor on a score item like an 
Instrument, partwise volume leve (mp, ff, etc.), MIDI Channel Hop, 
or partwise Event, the pop-up box now tells what Part it applies 
to.  On all objects the word "Environment" separates info about 
the item itself from that about its surroundings. 
 
MIDI Events longer than 3 or 4 bytes are now stored such that if 
you use identical byte sequences in many places, only one copy of 
each sequence is stored in memory and your disk file. This in no 
way affects backwards compatibility (whew!). 
 
The MM/1's text and mouse cursors no longer leave holes in the 
startup screen. 
 
Lots of little buglets have been fixed that you may not have 
noticed yet (I'll never tell :-). 
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a. Note Beaming 
b. Halftone Staves option 
c. More Printer Options, bug fixed 
d. Faster OS-9 Pipes 
e. Visual Beep Bell 

 
NOTE BEAMING 
At last, UltiMusE closes the last big gap between it and published 
sheet music. Groups of 8th, 16th, or smaller notes now can have 
their stems connected by horizontal or sloping "beams" in place of 
their individual flags; this is much easier to read and more 
professional, and rates a new version number from 7. to 8. 
 
Note groups are beamed within each Part. Stems still face up or 
down according to your Layout Menu steup as before, except 



"middle" parts are now smarter about which way their stems face -- 
the decision is made not individually by note, but "voted on" by 
each beam group -- again, easier to read. "Clone" parts have no 
flags and so are never beamed. 
 
Beams do not cross Barlines, Rests, Quarter notes or larger, nor 
time-zone "beat" boundaries -- meaning, for example, that if the 
time signature is 2/4, 3/4, or anything/4, beams will not connect 
more than two 8th notes, four 16ths, or any combination that 
crosses one of the "down beats" within the measure. 
 
Beam drawing does take more time to refresh the screen, and may 
hide some details in complex scores, so beaming can be turned off 
and on in the Options Menu. Also you can select "Thin Beams" for 
temporary viewing, although "Thick" looks more standard. These 
options are saved in your Preferences Init (SYS/um3.init) file, as 
is Halftone Staves. 
 
To support beaming an 8th subroutine module Um3B has been added. 
 
HALFTONE STAVES 
Another new option is to draw the 5 lines of each staff in 
halftone gray instead of solid black. This usually makes the notes 
and other objects more readable, and is definitely recommended for 
hard copy. But on some monitors the staves may look fuzzy, so try 
it both ways. 
 
NEW PRINTER OPTIONS 
In the Options/Printers Menu you can now specify whether your 
printer executes FormFeeds (Control-L or Hex C) by seeking to the 
top of the next page. Most printers do, and if yours does you 
should always use this option to avoid "drift" of paper getting 
out of line with the score pages. You can check your printer from 
any OS9 window with 
 
display c >/p 
 
and seeing whether it ejects a page. 
 
Another option handles printers that insist on adding their own 
top margin to a new page, and spitting out a page when about three 
lines are left at the bottom, as if you'd sent a FormFeed. This is 
common on new printers using separate sheets of paper instead of 
fanfold connected pages. Be sure to set this option if your 
printer does this. 
 



UltiMusE "knows" about the printer choices on the menu and may 
turn these two options and or off as you change printers. You can 
always change the options AFTER selecting a printer if you 
disagree. Both options are saved and restored with your 
Preferences Init file. 
 
BETTER OS-9 PIPES (CoCo3 Only) 
In the CMDS directory you'll find a new PipeMan module. 
If you replace the PipeMan in your OS9 boot with this new one, it 
will speed up screen redraws noticeably. This is because Umuse3 
feeds the drawing commands to Fran thru a pipeline. 
 
This module is part of Alan DeKok's "TuneUp" package, available 
from Farna Systems, and by gracious permission of Alan we are 
including it with the UltiMusE-III shareware package. 
 
VISUAL "BEEP" (MM/1 Only) 
Most MM/1s don't make an audible "BEEP" when the software says to, 
due to lack of audio hookup either on the motherboard or to the 
monitor. Thus you may not know that you have hit an illegal key 
for the current menu, or the program needs you to answer a 
question. To make up for this, UltiMusE-K now flashes (inverts) 
the screen for 1/5 second whenever it tries to ring the bell.  If 
this really bothers you, we'll make it an option on the next 
release. 
 
<end of 8.11.0> 
 
 


